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Chapter 1 Introduction

1.1 Overview

This manual describes how to use the Renesas Flexible Software Package (FSP) for writing
applications for the RA microcontroller series.

1.2 Using this Manual

This manual provides a wide variety of information, so it can be helpful to know where to start. Here
is a short description of each main section and how they can be used.

Starting Development - Provides a step by step guide on how to use e2 studio and FSP to develop a
project for RA MCUs. This is a good place to start to get up to speed quickly and efficiently.

FSP Architecture - Provides useful background material on key FSP concepts such as Modules,
Stacks, and API standards. Reference this section to extend or refresh your knowledge of FSP
concepts.

API Reference - Provides detailed information on each module and interface including features, API
functions, configuration settings, usage notes, function prototypes and code examples. Board
Support Package (BSP) related API functions are also included.

Note
Much of the information in the API Reference section is available from within the e2 studio tool via the Devel oper
Assistance feature. The information here can be referenced for additional details on API features.

1.3 Documentation Standard

Each Modules section user guide outlines the following:

» Features: A bullet list of high level features provided by the module.

e Configuration: A description of module specific configurations available in the RA
Configuration editor.

e Usage Notes: Module specific documentation and limitations.

e Examples: Example code provided to help the user get started.

¢ APl Reference: Usage notes for each APl in the module, including the function prototype and
hyperlinks to the interface documentation for parameter definitions.

Each Interfaces section user guide outlines the following:

e Detailed Description: A short description and summary of the interface functionality.

e Data Structures: A list and definition of each data structure used by the interface including
the structure of the pointers that define the API and are shared by all modules that
implement the interface.

e Typedefs: A list and description of the typedefs used by the interface.

e Enumerations: A list and description of the enumerations used by the interface.
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1.4 Introduction to FSP

1.4.1 Purpose
The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide

easy to use, scalable, high quality software for embedded system design. The primary goal is to
provide lightweight, efficient drivers that meet common use cases in embedded systems.

1.4.2 Quality

FSP code quality is enforced by peer reviews, automated requirements-based testing, and
automated static analysis.

1.4.3 Ease of Use

FSP provides uniform and intuitive APIs that are well documented. Each module is supported with
detailed user documentation including example code.

1.4.4 Scalability

FSP modules can be used on any MCU in the RA family, provided the MCU has any peripherals
required by the module.

1.4.5 Build Time Configurations

FSP modules also have build time configurations that can be used to optimize the size of the module
for the feature set required by the application.

1.4.6 e2 studio IDE

FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RA
series of MCU devices. The e2 studio IDE provides a familiar development cockpit from which the key
steps of project creation, module selection and configuration, code development, code generation,
and debugging are all managed.
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Chapter 2 Starting Development

2.1 Starting Development Introduction

The wealth of resources available to learn about and use e2 studio and FSP can be overwhelming on
first inspection, so this section provides a Starting Development Guide with a list of the most
important initial steps. Following these highly recommended first 11 steps will bring you up to speed
on the development environment in record time. Even experienced developers can benefit from the
use of this guide, to learn the terminology that might be unfamiliar or different from previous
environments.

1. Read the section What is e2 studio?, up to but not including e2 studio Prerequisites. This
will provide a description of the various windows and views to use e2 studio to create a
project, add modules and threads, configure module properties, add code, and debug a
project. It also describes how to use key coding 'accelerators' like Developer Assist (to drag
and drop parameter populated API function calls right into your code), a context aware
Autocomplete (to easily find and select from suggested enumerations, functions, types, and
many other coding elements), and many other similar productivity enhancers.

2. Read the FSP Architecture, FSP Modules and FSP Stacks sections. These provide the basic
background on how FSP modules and stacks are used to construct your application.
Understanding their definitions and the theory behind how they combine will make it easier
to develop with FSP.

3. Read a few Modules sections to see how to use API function calls, structures, enumerations,
types and callbacks. These module guides provide the information you will use to
implement your project code.

4. After you have a Kit and you have downloaded and installed e2 studio and FSP, you can
build and debug a simple project to test your installation, tool flow, and the kit. (If you do
not have a Kit or have not yet installed the development software, use the links included in
the e2 studio Prerequisites for more information.) The simple Tutorial: Your First RA MCU
Project - Blinky will Blink an LED on and off. Follow the instructions for importing and
running this project in section Create a New Project for Blinky. It will use some of the key
steps for managing projects within e2 studio and is a good way to learn the basics.

5. Once you have successfully run Blinky you have a good starting point for using FSP for more
complex projects. The Using HAL Drivers Tutorial, available at Tutorial: Using HAL Drivers -
Programming the WDT, shows how to create a project from scratch, using FSP API functions.
Do this next.

6. Several Hands-on Quick FSP Labs are available that cover key development topics with
short 15-minute Do it Yourself (DiY) activities targeting the EK-RA6M3. Topics covered
include code development accelerators like Developer Assistance, Autocomplete, Help,
Visual Expressions and using Example Projects. The complete list of available Quick FSP
Labs can be found here: https://en-
support.renesas.com/knowledgeBase/category/31087/subcategory/31090. Doing a couple
of these labs provides further details on using FSP, and is also good practice. Running these
labs is highly recommended.

7. The balance of the FSP Architecture sections (that is, those not called out in step 2 above)
contain additional reference material that may be helpful in the future. Scan them so you
know what they contain, in case you need them.

8. The balance of the e2 studio User Guide, starting with the What is a Project? section up to,
but not including, Writing the Application section, provides a detailed description of each of
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the key steps, windows, and entries used to create, manage, configure, build and debug a
project. Much of this may be familiar after running through the tutorials and Quick Labs.
However, it is important to have a good grasp of what each of the configuration tabs are
used for as that is where the bulk of the project preparation work takes place prior to
writing code. Skim over this section as it may help with any questions in the future.

9. Read the Writing the Application section to get a short introduction to the steps used when
creating application code with FSP. It covers both RTOS-independent and RTOS-dependent
applications. It also includes a short description for several of the code accelerators you
should be familiar with by now. Using additional Quick FSP Labs is a good way to become
familiar with the application development process and links to them are included in the
appropriate places in this section. You can find the complete list of available Quick FSP Labs
here: https://en-support.renesas.com/knowledgeBase/19308277.

10. Scan the Debugging the Project section to see the steps required to download and start a
debug session.

11. Explore the additional material available on the following web pages and bookmark the
resources that look most valuable to you:

. RA Landing Page: https://www.renesas.com/ra

. FSP Landing Page: https://www.renesas.com/fsp

. Example Projects on GitHub: https://github.com/renesas/ra-fsp-examples

. Quick FSP Labs Listing: https://en-support.renesas.com/knowledgeBase/19308277

. RA and FSP Knowledge Base (with articles of interest on RA and FSP): https://en-

support.renesas.com/knowledgeBase/category/31087
f. RA and FSP Renesas Rulz site (Community posted and answered questions):
https://renesasrulz.com/ra/
g. FSP Releases: https://github.com/renesas/fsp/releases
h. FSP Documentation: https://renesas.github.io/fsp
i. Online Technical Support: https://www.renesas.com/us/en/support/contact.html

2.2 e2 studio User Guide

2.2.1 What is e2 studio?

™ QN T QD

Renesas e2 studio is a development tool encompassing code development, build, and debug. e2
studio is based on the open-source Eclipse IDE and the associated C/C++ Development Tooling
(CDT).

When developing for RA MCUs, e2 studio hosts the Renesas Flexible Software Package (FSP). FSP
provides a wide range of time saving tools to simplify the selection, configuration, and management
of modules and threads, to easily implement complex applications. The time saving tools available in
e2 studio and FSP include the following:

* A Graphical User Interface (GUI) (see Adding Threads and Drivers) with numerous wizards
for configuring and auto-generating code

* A context sensitive Autocomplete (see Tutorial: Using HAL Drivers - Programming the WDT)
feature that provides intelligent options for completing a programming element

e A Developer Assistance tool for selection of and drag and drop placement of API functions
directly in application code

¢ A Welcome Window with links to example projects, application notes and a variety of other
self-help support resources

¢ An Information Icon from each module is provided in the graphic configuration viewer that
links to specific design resources, including code 'cheat sheets' that provide useful starting
points for common application implementations.
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RENESAS

e’ studio

( BUILT ON

Figure 1: e2 studio Splash Screen

e2 studio organizes project work based on Perspectives, Views, Windows, Panes, and Pages
(sometimes called Tabs). A window is a section of the e2 studio GUI that presents information on a
key topic. Windows often use tabs to select sub-topics. For example, an editor window might have a
tab available for each open file, so it is easy to switch back and forth between them. A window Pane
is a section of a window. Within a window, multiple Panes can be opened and viewed simultaneously,
as opposed to a tabbed window, where only individual content is displayed. A memory-display
Window, for example, might have multiple Panes that allow the data to be displayed in different
formats, simultaneously. A Perspective is a collection of Views and Windows typical for a specific
stage of development. The default perspectives are a C/C++ Perspective, an FSP Configuration
Perspective and a Debug Perspective. These provide specific Views, Windows, Tabs, and Panes
tailored for the common tasks needed during the specific development stage.
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@ Includes Summary Generate Project Content
@Bra .
5 ra_gen Project Summary Rene A
2 src
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Figure 2: Default Perspective
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In addition to managing project development, selecting modules, configuring them and simplifying
code development, e2 studio also hosts the engine for automatically generating code based on
module selections and configurations. The engine continually checks for dependencies and
automatically adds any needed lower level modules to the module stack. It also identifies any lower
level modules that require configuration (for example, an interrupt that needs to have a priority
assigned). It also provides a guide for selecting between multiple choices or options to make it easy
to complete a fully functional module stack.

The Generate Project Content function takes the selected and configured modules and automatically
generates the complete and correct configuration code. The code is added to the folders visible in
the Project Explorer window in e2 studio. The configuration.xml file in the project folder holds all
the generated configuration settings. This file can be opened in the GUI-based RA Configuration
editor to make further edits and changes. Once a project has been generated, you can go back and
reconfigure any of the modules and settings if required using this editor.

&5 Project Explorer & = 8

L

~ 125 Blinky [Debug]

=Y Includes

Bra

= ra_gen

2 src

= ra_cfg

= script
= Blinky Debug_Flat.launch

i configurationxml
= R7TFABMTAD3CFP.pincfg
= RA6M1-EK pincfg

(@ Developer Assistance

Figure 3: Project Explorer Window showing generated folders and configuration.xml file

2.2.2 e2 studio Prerequisites

2.2.2.1 Obtaining an RA MCU Kit

To develop applications with FSP, start with one of the Renesas RA MCU Evaluation Kits. The Renesas
RA MCU Evaluation Kits are designed to seamlessly integrate with the e2 studio.

Ordering information, Quick Start Guides, User Manuals, and other related documents for all RA MCU
Evaluation Kits are available at https://www.renesas.com/ra.

2.2.2.2 PC Requirements
The following are the minimum PC requirements to use e2 studio:

¢ Windows 10 with Intel i5 or i7, or AMD A10-7850K or FX
e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)
e Minimum 250-GB hard disk

2.2.2.3 Installing e2 studio, platform installer and the FSP package

Detailed installation instructions for the e2 studio and the FSP are available on the Renesas website
https://www.renesas.com/fsp. Review the release notes for e2 studio to ensure that the e2 studio
version supports the selected FSP version. The starting version of the installer includes all features of
the RA MCUs.
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2.2.2.4 Choosing a Toolchain

e2 studio can work with several toolchains and toolchain versions such as the GNU Arm compiler and
Arm ACG6. A version of the GNU Arm compiler is included in the e2 studio installer and has been
verified to run with the FSP version.

2.2.2.5 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.
2.2.3 What is a Project?

In e2 studio, all FSP applications are organized in RA MCU projects. Setting up an RA MCU project
involves:

1. Creating a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects
already, after you launch e2 studio and select a workspace, all projects previously saved in the
selected workspace are loaded and displayed in the Project Explorer window. Each project has an
associated configuration file named configuration.xml, which is located in the project's root directory.

5 Project Explorer 2 ]

1
{L(\.I

~ =% Blinky [Debug]

= Includes

Era

 ra_gen

& src

= ra_cfg

= script
= Blinky Debug_Flat.launch

i configurationxml
= RTFABM1TAD3CFP.pincfg
=/ RA6M1-EK pincfg

(@ Developer Assistance

Figure 4: e2 studio Project Configuration file

Double-click on the configuration.xml file to open the RA MCU Project Editor. To edit the project
configuration, make sure that the FSP Configuration perspective is selected in the upper right
hand corner of the e2 studio window. Once selected, you can use the editor to view or modify the
configuration settings associated with this project.

= | BC/C++ | FSP Configuration
Figure 5: e2 studio FSP Configuration Perspective

Note
Whenever the RA project configuration (that is, the configuration.xml file) is saved, a verbose RA Project Report
file (ra_cfg.txt) with all the project settings is generated. The format allows differencesto be easily viewed using a
text comparison tool. The generated file islocated in the project root directory.
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part_number: R7FAGM1AD3CFP
rom_size_bytes: 524288

ram_size_bytes: 262144

data_flash_size bytes: 8192
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Figure 6: RA Project Report

>

The RA Project Editor has a number of tabs. The configuration steps and options for individual tabs
are discussed in the following sections.

Note

The tabs available in the RA Project Editor depend on the e2 studio version and the layout may vary dightly,
however the functionality should be easy to follow..

¢ [MyProject] FSP Configuration 2

Summary

Project Summary

Board: EK-RAGM3

Device: R7FA6M3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version:

FSP Version:

Selected software components

Arm CMSIS Version 5 - Core (M)

RAGM3-EK Board Suppoert Files

Board support package for R7TFASBM3AH3CFC
Board support package for RAGM3

Board support package for RAGM3 - FSP Data
Board Support Package Common Files

1/Q Port

|Summary BSP | Clocks | Pins| Interrupts | Event Links | Stacks Componentsl

= 0O
(V]

Generate Project Content

RENESAS

Figure 7: RA Project Editor tabs
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e Click on the YouTube icon to visit the Renesas FSP playlist on YouTube
e Click on the Support icon to visit RA support pages at Renesas.com

e Click on the user manual (owl) icon to open the RA software package User's Manual

2.2.4 Creating a Project

During project creation, you specify the type of project, give it a project name and location, and
configure the project settings for version, target board, whether an RTOS is included, the toolchain
version, and the beginning template. This section includes easy-to-follow step-by-step instructions
for all of the project creation tasks. Once you have created the project, you can move to configuring
the project hardware (clocks, pins, interrupts) and the parameters of all the modules that are part of

your application.

2.2.4.1 Creating a New Project

For RA MCU applications, generate a new project using the following steps:

1. Click on File > New > RA C/C++ Project.

8 workspace - & studio

File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

New Alt+Shift+N > [c
Open File...

ol

L2 Open Projects from File System...
Recent Files >

= [El

Close Ctrl+W

Close Al Ctrl+Shift+W
B

Ctrl+5S K

3 o

0w
p:

Figure 8: New

Makefile Project with Existing Code
C/C++ Project |
Project...

Create a new C or C++ project |
Convert to a C/C++ Project (Adds C/C++ Nature) |
Source Folder

(5 Folder

Source File
Header File

Filn fenon Tamalnis

RA MCU Project

Then click on the type of template for the type of project you are creating.

Q New C/C++ Project

Templates for New C/C++ Project

a X

All Renesas RA C/C+ + Project
CMake =N Create an executable or static library C/C++ project for Renesas RA.

Make
Renesas Debug

Renesas RA

L) < Back

NEext >

Cancel

Figure 9: New Project Templates
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2.

3.

Select a project name and location.

& Renesas RA C/C++ Project O X

Renesas RA C/C++ Project —

Project Name and Location

Project name
| MyProjecﬂ

Use default location
\MyProject Browse...

default

You can download more Renesas packs here

'/?3 < Back Finish Cancel
Figure 10: RA MCU Project Generator (Screen 1)

Click Next.

2.2.4.2 Selecting a Board and Toolchain

In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.

2. Select the Board for your application. You can select an existing RA MCU Evaluation Kit or
select Custom User Board for any of the RA MCU devices with your own BSP definition.

3. Select the Device. The Device is automatically populated based on the Board selection.
Only change the Device when using the Custom User Board (Any Device) board
selection.

4. To add threads, select RTOS, or No RTOS if an RTOS is not being used.

5. The Toolchain selection defaults to GCC Arm Embedded.

6. Select the Toolchain version. This should default to the installed toolchain version.

7. Select the Debugger. The J-Link Arm Debugger is preselected.

8. Click Next.

R11UMO0155EU0230 Revision 2.30 RLENESAS Page 18 /2,794

Sep.10.2021

User’s Manual



Flexible Software Package

Starting Development > e2 studio User Guide > Creating a Project > Selecting a Board and Toolchain

User’s Manual

Note

Click on the Help icon (?) for user guides, RA contents, and other documents.

Q Renesas RA C/C++ Project

O >
Renesas RA C/C++ Project —
|Device and Tools Selection
Device Selection
ESP Version: .| Board Description
Board: EK-RABM3 v
Device: R7FABM3AH3CFC
Language: @C OC++
Device Details
TrustZone No
Pins 176
Processor cortex-m4
Toolchains Debugger
GNU ARM Embedded J-Link ARM ~
v
[@]«= Help <Back Carcel

Figure 11: RA MCU Project Generator (Screen 2)

2.2.4.3 Selecting Flat or Arm® TrustZone® Project

If you selected a device or tool based on an Arm® Cortex®-M33, you next select whether to use

Arm® TrustZone® in your project. For normal, non-TrustZone projects, select "Flat".
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ﬁ Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Type Selection

Project Type Selection

@ Flat (Non-TrustZone) Project
* RA device project without TrustZone separation
* All code, data and peripheral settings will be configured in
this project

() Secure Project

* RA device project for TrustZone secure execution

+ All code, data and peripherals placed in this project will
be initialized as secure

* Secure project settings such as TrustZone partitions, linker
maps and a list of secure peripherals will be passed to a
selected non-secure project

= After initialization, a call to the non-secure startup handler
will be made

() Non-secure Project
* RA device project for TrustZone non-secure execution
+ All code, data and peripherals placed in this project will
be initialized as non-secure
* Must be associated with a secure project or secure bundle
+ Non-secure startup handler will be called after secure
code initialization

@ < Back

Figure 12: Flat, Secure, or Non-Secure Project

Cancel

For more information on Arm® TrustZone®, see Primer: ARM® TrustZone® Project Development.

2.2.4.4 Selecting a Project Template

In the next window, select the buiild artifact and RTOS.
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Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Build Artifact and RTOS Selection

Build Artifact Selection
@ Executable
* Project builds to an executable file
(O Static Library
+ Project builds to a static library file
() Executable Using an RA Static Library
* Project builds to an executable file
* Project uses an existing RA static library project

)
@

< Back

RTOS Selection
No RTOS

Cancel

Figure 13: RA MCU Project Generator (Screen 3)

In the next window, select a project template from the list of available templates. By default, this

screen shows the templates that are included in your current RA MCU pack. Once you have selected
the appropriate template, click Finish.

Note

If you want to devel op your own application, select the basic template for your board, Bare Metal - Minimal.
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Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Template Selection

Project Template Selection

O () Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks,
and the C runtime environment.

C) | Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

Code Generation Settings
Use Renesas Code Formatter

@ < Back Next = Cancel
Figure 14: RA MCU Project Generator (Screen 4)

When the project is created, e2 studio displays a summary of the current project configuration in the
RA MCU Project Editor.

& [MyProject] FSP Configuration 2

Summary Generate Project Content
Project Summary
RENESAS
Board: EK-RABM3
Device: R7FABM3AH3CFC
Tooelchain: GCC ARM Embedded
Tooelchain Version:
FSP Version:

Selected software components

Arm CMSIS Version 5 - Core (M)

RAGM3-EK Board Support Files

Board support package for RTFAGM3AH3CFC
Board support package for RAGM3

Board support package for RAGM3 - FSP Data

Board Support Package Common Files
1/O Port

|5ummary BSP| Clocks Pins| Interrupts Event Links| Stacks Componentsl

Figure 15: RA MCU Project Editor and available editor tabs
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On the bottom of the RA MCU Project Editor view, you can find the tabs for configuring multiple
aspects of your project:

e With the Summary tab, you can see all they key characteristics of the project: board,
device, toolchain, and more.

e With the BSP tab, you can change board specific parameters from the initial project
selection.

e With the Clocks tab, you can configure the MCU clock settings for your project.

e With the Pins tab, you can configure the electrical characteristics and functions of each
port pin.

e With the Interrupts tab, you can add new user events/interrupts.

* With the Event Links tab, you can configure events used by the Event Link Controller.

e With the Stacks tab, you can add and configure FSP modules. For each module selected in
this tab, the Properties window provides access to the configuration parameters, interrupt
priorities, and pin selections.

e The Components tab provides an overview of the selected modules. Although you can also
add drivers for specific FSP releases and application sample code here, this tab is normally
only used for reference.

The functions and use of each of these tabs is explained in detail in the next section.
2.2.5 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the
RA Configuration editor window. Importantly, the initial configuration of the MCU after reset and
before any user code is executed is set by the configuration settings in the BSP, Clocks and Pins
tabs. When you select a project template during project creation, e2 studio configures default values
that are appropriate for the associated board. You can change those default values as needed. The
following sections detail the process of configuring each of the project elements for each of the
associated tabs.

2.2.5.1 Summary Tab

5 [MyProject] FSP Configuration &2 = g
[¥]

Summary Generate Project Content

Project Summary

RENESAS
Board: EK-RAGBM3
Device: R7FAEM3AH3CFC
Toelchain: GCC ARM Embedded
Toelchain Version:
FSP Version:

Selected software components

Arm CMSIS Version 5 - Care (M)

RABM3-EK Board Support Files

Board support package for RTFAGM3AH3CFC
Board support package for RAGM3

Board support package for RAG6M3 - FSP Data
Board Support Package Common Files

1/0 Port

YoulT® @

Summary | BSP| Clocks| Pins | Interrupts | Event Links | Stacks| Components

Figure 16: Configuration Summary tab
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The Summary tab, seen in the above figure, identifies all the key elements and components of a
project. It shows the target board, the device, toolchain and FSP version. Additionally, it provides a
list of all the selected software components and modules used by the project. This is a more
convenient summary view when compared to the Components tab.

The summary tab also includes handy icons with links to the Renesas YouTube channel, the Renesas
support page and to the RA FSP User Manual that was downloaded during the installation process.

2.2.5.2 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in
the lower left of the Project Configurations view as shown below.

Note

If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.

Summa locks | Pins | Interrupts | Event Links | Stacks  Compeonents

[ Properties 52
EK-RAGM3

Settings Property

~ R7FABM3AH3CFC
part_number
rom_size_bytes
ram_size_bytes
data_flash_size_bytes
package_style
package_pins

~ RABM3
series

~ RABM3 Family
OFS0 register settings
OFS1 register settings
MPU

~ RA Common
Main stack size (bytes)
Heap size (bytes)
MCU Vee (mV)

Darametar rharlbinm

v e[

Value

R7FABM3AHICFC
2087152

655360

63536

LQFP

176

6

00
0
3300

Nicshled

Figure 17: Configuration BSP tab

The Properties view shows the configurable options available for the BSP. These can be changed
as required. The BSP is the FSP layer above the MCU hardware. e2 studio checks the entry fields to
flag invalid entries. For example, only valid numeric values can be entered for the stack size.

When you click the Generate Project Content button, the BSP configuration contents are written

to ra_cfg/fsp_cfg/bsp/bsp_cfg.h

This file is created if it does not already exist.

Warning

Do not edit this file as it is overwritten whenever the Generate Project Content button is

clicked.

2.2.5.3 Configuring Clocks

The Clocks tab presents a graphical view of the MCU's clock tree, allowing the various clock dividers
and sources to be modified. If a clock setting is invalid, the offending clock value is highlighted in

red. It is still possible to generate code with this setting, but correct operation cannot be guaranteed.
In the figure below, the USB clock UCLK has been changed so the resulting clock frequency is 60 MHz
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instead of the required 48 MHz. This parameter is colored red.

& *[MyProject] FSP Configuration &3 =8
(¥}

Clocks Conflguratlon Generate Project Content

EZ Restore Defaults

XTAL 24MHz }\L  ICLK Div /2 v —>| ICLK 120MHz \
PLL Src: XTAL v > PCLKA Div /2 || PCLKA 120MHz \
b
PLL Div /2 v > PCLKB Div /4 ~ || PCLKB 60MHz \
b
PLL Mul x20.0 v > PCLKC Div /4 v | PCLKC 60MHz \
b
| USBMCLK 24MHz | | [PLL240MHz |-/ Clock Src: PLL <> PCLKD Div /2 || PCLKD 120MHz \
HOCO 20MHz v SDCLKout On |/ SDCLKout 120MHz \
i
\ LOCO 32768Hz | > BCLK Div /2 v —>| BCLK 120MHz \
)
| MOCO 8MHz | BCLK/2 || BCLKout 60MHz \
| SUBCLK 32768Hz | " v ucceomz \
\> FCLK Div /4 v [ FCLK 60MHz \
CLKOUT Disabled > CLKOUT Div /1 || CLKOUT 0Hz \

Summary | BS ins Interrupts| Event Links | Stacks| Components

Figure 18: Configuration Clocks tab

When you click the Generate Project Content button, the clock configuration contents are written
to: ra_gen/bsp_clock_cfg.h

This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

2.2.5.4 Configuring Pins

The Pins tab provides flexible configuration of the MCU's pins. As many pins are able to provide
multiple functions, they can be configured on a peripheral basis. For example, selecting a serial
channel via the SCI peripheral offers multiple options for the location of the receive and transmit pins
for that module and channel. Once a pin is configured, it is shown as green in the Package view.

Note
If the Package view window is not open in e2 studio, select Window > Show View > Pin Configurator > Package
from the top menu bar to openit.

The Pins tab simplifies the configuration of large packages with highly multiplexed pins by
highlighting errors and presenting the options for each pin or for each peripheral. If you selected a
project template for a specific board such as the EK-RA6M3, some peripherals connected on the
board are preselected.

R11UMO0155EU0230 Revision 2.30 .QENESAS Page 25/2,794
Sep.10.2021



Flexible Software Package User’s Manual

Starting Development > e2 studio User Guide > Configuring a Project > Configuring Pins

& *[MyProject] FSP Configuration 2 =78

& Package 2 G v|@-M~y=08
. = B [+] i
Pins Cunflguratlun Generate Project Content
Select pin configuration s~ &)
RA6M3-EK pincfg 5 Generate data: | g_bsp_pin_cfg
Pin Selection Pin Configuration

type filter text

Analog:DAC12 ~ Module name: SCI7 fo
Connectivity:CAN Usage: ‘When using Simple 12C mode, ensure 5 _
v Connectivity:ETHERC type is n-ch open drain, RrF‘:i!:i:Fx:ch
~ Connectivity:lIC When switching between I12C and otf (Top View)
~ v Connectivity:SCI disable.
scio Pin Group Selection: _Conly ~
scn
sci2 Operation Mode: Asynchronous UART L
v 5CI3 Input/Output
sCi4 P612
scis oc
5Cl6 v |P614 o
i SGIy v < 5%

Summary |BSP| & Cloc iterrupts | Event Links| Stacks | Components

v
[% Pin Conflicts & es v &= O
€rrors, U warnings, 0 others

Figure 19: Pins Configuration

The pin configurator includes a built-in conflict checker, so if the same pin is allocated to another
peripheral or I/O function the pin will be shown as red in the package view and also with white cross
in a red square in the Pin Selection pane and Pin Configuration pane in the main Pins tab. The
Pin Conflicts view provides a list of conflicts, so conflicts can be quickly identified and fixed.

In the example shown below, port P611 is already used by the CAC, and the attempt to connect this
port to the Serial Communications Interface (SCI) results in a dangling connection error. To fix this

error, select another port from the pin drop-down list or disable the CAC in the Pin Selection pane
on the left side of the tab.

% *[MyProject] FSP Configuration 2 = 8
Pins Configuration e
9 Generate Project Content
Select pin configuration e v &l
RABM3-EK.pincfg e Generate data: | g_bsp_pin_cfg
Pin Selection Pin Configuration
AnalogL Hin Group Selection: _Conly v Py
Connecti Operation Mode: Simple SPI ~
~ Connecti Input/Output
nput/Outpu
v Connecti P P
~ B Connecti v [P613 e d
SClo v |P614 =
s
. =
sci2 v [P612
v SCi3 CTS RIS S5: o ECI =
SCl4 N
<Cl5 None
sc6 ., None %
< > < >
Summary |BSP | & Clocks| @ Pins| Interrupts| Event Links | Stacks| Components
Figure 20: e2 studio Pin configurator
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The pin configurator also shows a package view and the selected electrical or functional
characteristics of each pin.

& Package 3% ;}{vlg‘vv'ﬂg

Connection Status
Drive Capacity
~ Mode

Qutput Type
Pull Up

RTFABM3AxaFC
176LOFP

(Top View)

Figure 21: e2 studio Pin configurator package view

When you click the Generate Project Content button, the pin configuration contents are written
to: ra_gen\bsp_pin_cfg.h

This file will be created if it does not already exist.

Warning

Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

To make it easy to share pinning information for your project, e2 studio exports your pin
configuration settings to a csv format and copies the csv file to ra_gen/<MCU package>.csv.

2.2.5.5 Configuring Interrupts from the Stacks Tab

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt
priority. Select the driver in the Stacks pane to view and edit its properties.
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Creating Interrupts from the Interrupts Tab

% [MyProject] FSP Configuration &3

Stacks Configuration

Threads

~ &¢ HAL/Common

= HAL/Common Stacks

=0
(]

Generate Project Content

4] New Stack > == Extend Stack > %] Remove

ort I/0 Port
ron r_ioport

& g_elc ELC Driver on
r_elc

®

& g_uart0 UART Driver on r_sci_uart

®

4 g_ioport 10 Port Driver on r_ioport
4 g_elc ELC Driver on r_elc
@ g_uart0 UART Driver on r_sci_uart
Objects
<

Summary |BSP | & Clocks| @ Pins |Interrupts | Event Links | Stacks| Components

[ Properties % . Problems @& Smart Browser

g_uart0 UART Driver on r _sci_uart

Property
Common

Settings
APl Info

~ Module g_uart0 UART Driver on r_sci_uart
General

Baud

Flow Control

Extra

~ Interrupts
Callback

T

& g_transfer? Transfer
Driver on r_dtc SCI0
RXI (Receive data full)

& g_transferQ Transfer
Driver on r_dtc SCI0
TXI (Transmit data

® empty) ®

Value

user_uart_callback

Receive Interrupt Priority

Transmit Data Empty Interrupt Priority
Transmit End Interrupt Priority

Error Interrupt Priority

Priority 12
Priority 12
Priority 12
Priority 12

v Pins

Figure 22: Configuring Interrupts in the Stacks tab

On the Interrupts tab, the user can bypass a peripheral interrupt set by the FSP by setting a user-
defined ISR. This can be done by adding a new event via the New User Event button.

¢ [MyProject] FSP Configuration 2

User Events

Interrupts Configuration

(]

Generate Project Content

%] New User Event >

Event ISR
Allocations

Interrupt  Event ISR

0 SCI0 RXI (Receive data full) sci_uart_ri_isr

1 SCI0 TXI (Transmit data empty) sci_uart_txi_isr

2 SCI0 TEI (Transmit end) sci_uart_tei_isr

3 SCI0 ERI (Receive error) sci_uart_eri_isr

Summary |[BSP | & Clocks | @ Pinvent Links| Stacks | Components
Figure 23: Configuring interrupt in Interrupt Tab
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% [MyPraject] FSP Configuration &3

Interrupts Configuration

User Events

1. & New!

Event

ISR

Allocations

Interrupt
0

1
2
3

Event

SCI0 RXI (Receive data full)
SCI0 TXI (Transmit data empty)
SCI0 TEI (Transmit end)

SCI0 ERI (Receive error)

ISR

sci_uart_rxi_i
sci_uart_txi_i
sci_uart_tei_i
sci_uart_eri_i

Summary |BSP | & Clocks| @ Pins | Interrupts| Event Links | Stacks| Components

[ Properties & Problems Smart Browse

Properties are not available.

ADC
AGT
CAC
CAN
CGC
COMP
CTSU
DMAC
DoC
DRW
DTC
EDMAC
ELC
EPTPC
FCU
GLCDC
GPT
ICU

IiC
IOPORT
IWDT
JPEG
KEY
LPM
VD
0oPS
PDC
POEG
QsPI
RTC
SCE

>

>

> F & Package 2

R7FAGM3AxoxxFC
176LQFP

SCl

>|| 3. 5Ci0

> || 4 SCI0 RXI (Receive data full)
>

Enter the name of ISR for the new user event.

E MNew User Event

SDHIMMC
SPI

SRC

Sl

USBFS
USBHS

Enter the name of the ISR for the new user event:

> S
> SCI2
> SCI3
> SCl4
> SCI5
> SCle

SCIO TXT (Transmit data empty)

SCIO TEI (Transmit end)

SCI0 ERI (Receive error)

SCI0 AM (Address match event)

SCI0 RXI OR ERI (Receive data full/Receive)

Figure 24: Adding user-defined event

| user_defined__sci_uart_rd_i srl

Cancel

Figure 25: User-defined event ISR
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& *[MyProject] FSP Configuration 2 - =
2 ) [¥]
Interrupts Configuration Generate Project Content
User Events #] New User Event > &
Event ISR
SCI0 RXI (Receive data full) user_defined__sci_uart_rxi_isr
Allocations
Interrupt  Event ISR
0 SCI0 RXI (Receive data full) user_defined__sci_uart_rxi_isr
1 SCI0 TXI (Transmit data empty) sci_uart_txi_isr
2 SCIO TEI (Transmit end) sci_uart_tei_isr
3 SCIO ERI (Receive errar) sci_uart_eri_isr

Summary |[BSP | & Clocks @ Pins | Interrupts| Event Links Stacks| Components

Figure 26: Using a user-defined event

2.2.5.6 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by
peripheral to make it easy to find and verify them.

% *[MyProject] FSP Configuration 2 =8
. . . o
Event Links Configuration Generate Project Content
User Events Produced | New User Event > %1 Remove  User Events Consumed | New User Event
Event Peripheral Function Event
GPTO CAPTURE COMPARE A (Compare match A) PORT 1 GPTO CAPTURE COMPARE A (Compare match A)
Allocations /
Peripheral Function / Event (3
DAC12 Channel 0 No allocation
DAC12 Channel 1 No allocation
PORT 1 GPTO CAPTURE COMPARE A (Compare match A)
PORT O allocation v

Summary BSP | Clocks |Pins | Interrupts |Event Links | Stacks| Components

Figure 27: Viewing Event Links

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can
be defined by clicking the relevant New User Event button. Once a consumer is linked to a
producer the link will appear in the Allocations section at the bottom.

Note

When selecting an ELC event to receive for a module (or when manually defining an event link), only the events
that are made available by the modules configured in the project will be shown.

2.2.6 Adding Threads and Drivers

Every RTOS-based RA Project includes at least one RTOS Thread and a stack of FSP modules running
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in that thread. The Stacks tab is a graphical user interface which helps you to add the right modules
to a thread and configure the properties of both the threads and the modules associated with each
thread. Once you have configured the thread, e2 studio automatically generates the code reflecting
your configuration choices.

For any driver, or, more generally, any module that you add to a thread, e2 studio automatically
resolves all dependencies with other modules and creates the appropriate stack. This stack is
displayed in the Stacks pane, which e2 studio populates with the selected modules and module
options for the selected thread.

The default view of the Stacks tab includes a Common Thread called HAL/Common. This thread
includes the driver for 1/O control (IOPORT). The default stack is shown in the HAL/Common Stacks
pane. The default modules added to the HAL/Common driver are special in that the FSP only requires
a single instance of each, which e2 studio then includes in every user-defined thread by default.

In applications that do not use an RTOS or run outside of the RTOS, the HAL/Common thread
becomes the default location where you can add additional drivers to your application.

For a detailed description on how to add and configure modules and stacks, see the following
sections:

e Adding and Configuring HAL Drivers
e Adding Drivers to a Thread and Configuring the Drivers

Once you have added a module either to HAL/Common or to a new thread, you can access the
driver's configuration options in the Properties view. If you added thread objects, you can access
the objects configuration options in the Properties view in the same way.
You can find details about how to configure threads here: Configuring Threads
Note
Driver and module selections and configuration options are defined in the FSP pack and can therefore change
when the FSP version changes.

2.2.6.1 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your
application using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to
HAL/Common Stacks.
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& “[MyProject] FSP Configuration £

Stacks Configuration

Threads
~ £ HAL/Common
4 g_ioport 1/O Port Driver on r_ioport
& g_wdt0 Watchdog Driver on r_wdt
4 g_cgc0 CGC Driver on r_cgc

HAL/Common Stacks

Click here

new module

to add )

Generate Project Content

] New Stack > ] Remove

& g_ioport I/O Port
Driver on r_ioport

@

& g_wdt0 Watchdog
Driver on r_wdt

@

& g_cgc0 CGC Driver on
r_cgc

@

Objects

Summary | BSP | Clocks  Pins | Interrupts Ewvent Linblf Stacks domponents

Figure 28: e2 studio Project configurator - Adding drivers
2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.

3. Select a driver from the menu New Stack > Driver.

R TG ——
= O FlPackage

[¥] [SRCE v|
Generate Project Content
’ E R R

& *[MyProject] FSP Configuration 2

Stacks Configuration

Threads = HAL/Common Stacks ] New Stark ~
~ &% HAL/Commaon Ar,m > |
PR . . ¥ g_ioport I/0 Port Driver > Analog >
4 g_ioport I/0 Port Driver on r_iopol Driver on r_ioport FreeRTOS 5 Caplouch 5
FreeRTOS+ > Connectivity >
@ Middleware > Graphics > 1:
RTOS > Input > i:
SEGGER > Monitaring > 5:
4 Search.. Network N =1
< 3 Power > ;:
Storage > 3:
Objects System L :
% Port Qutput Enable for GPT on r_poeg Timers > 0;:
& RIC Driver on r_ric Transfer > pu
@ Three-Phase PWM Driver on r_gpt_three_phase
€ Timer Driver on r_agt
Summary |BSP | Clocks | Pins | Interrupts | Event Links | Stacks Componer. R <

Figure 29: Select a driver
4. Select the driver module in the HAL/Common Modules pane and configure the driver
properties in the Properties view.
e2 studio adds the following files when you click the Generate Project Content button:
e The selected driver module and its files to the ra/fsp directory

e The main() function and configuration structures and header files for your application as
shown in the table below.

File Contents Overwritten by Generate
Project Content?
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ra_gen/main.c Yes

Contains main() calling
generated and user code. When
called, the BSP already has

Initialized the MCU.

ra_gen/hal_data.c Configuration structures for HAL

Driver only modules.

Yes

ra_gen/hal_data.h Header file for HAL driver only

modules.

Yes

src/hal_entry.c User entry point for HAL Driver

only code. Add your code here.

No

The configuration header files for all included modules are created or overwritten in this folder:

ra_cfg/fsp_cfg

2.2.6.2 Adding Drivers to a Thread and Configuring the Drivers

For an application that uses the RTOS, you can add one or more threads,

and for each thread at least

one module that runs in the thread. You can select modules from the Driver dropdown menu. To add

modules to a thread, follow these steps:

1. In the Threads pane, click New Thread to add a Thread.

& *[MyProject] FSP Configuration &

Stacks Configuration

Threads 4] New Thread #| Remove = New Thread Stacks

v & HAL/Comman
A2 o jopart ]

& New Thread

[
Port Driver on r_ioport 4

pasting here from the clipboard.

Objects 4] New Object >

Summary | BSP | Clocks | Pins | Interrupts Event Links | Stacks| Components
D Properties 5 . Problems & Smart Browser

New Thread

Enter name of your
thread here. Example:

Property My Thread

Common
w Thread
Symbol

Settings Value

=T

(#]

Generate Project Content

| New Stack >

Add stacks to the selected thread by using the 'New Stack »" toolbar button (above), or by

\ Aewthe

Name New Thread

Stack size (bytes) T2

Priority 1
Thread Context NULL
Memaory Allocation Static

Figure 30: Adding a new RTOS Thread on the Stacks tab

2. In the Properties view, click on the Name and Symbol entries and enter a distinctive

name and symbol for the new thread.
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Note
e2 studio updates the name of the thread stacks pane to My Thread Stacks.

3. In the My Thread Stacks pane, click on New Stack to see a list of modules and drivers.
HAL-level drivers can be added here.

& “[MyProject] FSP Configuration 52 = H  5lPacka
. . o
Stacks Configuration Generate Project Content | oo
available
| New Thread New Thread Stacks | Ne Arm > active ed
Threads -
%] Remove 5 [ Add stacks to the selected thread by using the Azure RTOS ” ton (above), or
+ £ HAL/Common W' by pasting here from the clipboard. Bootloader 4
4 g_ioport 1/O Port Driver on Driver ’ Analog ’
New Thread Middleware > CapTouch >
& CANFD Driver on r_canfd Connectivity >
4 12C Master Driver on r_iic_master Crypto >
@ 12C Master Driver on r_sci_i2c Input 3
# 12C Slave Driver on r_iic_slave Monitoring 3>
& 125 Dr!ver onrssi Network 5
& SPI Driver on r_sci_spi Power 5
2 2 &  SPI Driver on r_spi : N
&£ New Object > 4 UART Driver on r_sci_uart ofads
Objects system ?
Timers >
Transfer >

Summary | BSP | Clocks | Pins |Interrupts | Event Links | Stacks Components

Figure 31: Adding Modules and Drivers to a thread

4. Select a module or driver from the list.

5. Click on the added driver and configure the driver as required by the application by
updating the configuration parameters in the Properties view. To see the selected module
or driver and be able to edit its properties, make sure the Thread containing the driver is
highlighted in the Threads pane.
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8 *[MyProject] FSP Configuration &
[V}

Stacks Configuration Generate Project Content

Threads 4] New Thread #| Remove = g_wdt0 Watchdog Driver on r_wdt Stacks 4| New Stack >

~ &t HAL/Commaon

& g_ioport I/O Port Driver on r_ioport
~ & New Thread

“# g_wdt0 Watchdog Driver on r_wdt ®

# g_wdt0 Watchdog
Driver on r_wdt

Objects #] New Object >

Summary BSP Clocks |Pins Interrupts Event Links | Stacks| Components
[ Properties 2 [T Problems @ Smart Browser

g_wdt0 Watchdog Driver on r_wdt

Settings Property Value
APl Info Common
v Module g_wdt0 Watchdog Driver on r_wdt
Name g_wdt0
Timeout 16,384 Cycles
Clock Division Ratio PCLK/8192
Window Start Position 100% (Window Position Not Specified)
‘Window End Position 0% (Window Position Not Specified)
Reset Control Reset Output
Stop Control WODT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 32: Configuring Module or Driver properties

6. If needed, add another thread by clicking New Thread in the Threads pane.

When you press the Generate Project Content button for the example above, e2 studio creates
the files as shown in the following table:

File Contents Overwritten by Generate
Project Content?

ra_gen/main.c Contains main() calling Yes
generated and user code. When
called the BSP will have
initialized the MCU.

ra_gen/my_thread.c Generated thread "my_thread" |Yes
and configuration structures for
modules added to this thread.

ra_gen/my_thread.h Header file for thread Yes
"my_thread"

ra_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.

ra_gen/hal_data.h Header file for HAL Driver only |Yes
modules.

src/hal_entry.c User entry point for HAL Driver | No

only code. Add your code here.
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src/my_thread_entry.c User entry point for thread No
"my_thread". Add your code
here.

The configuration header files for all included modules and drivers are created or overwritten in the
following folders: ra_cfg/fsp_cfg/<header files>

2.2.6.3 Configuring Threads

If the application uses an RTOS, the Stacks tab can be used to simplify the creation of RTOS
threads, semaphores, mutexes, and event flags.

The components of each thread can be configured from the Properties view as shown below.

1 Properties 2
New Thread

Settings Property Value
v Common
General
Hooks
Stats
Memory Allocation
Timers
Optional Functions

RA
Logging

w Thread
Symbol new_thread0
Name New Thread
Stack size (bytes) 1024
Priority 1
Thread Context NULL
Memaory Allocation Static

Figure 33: New Thread Properties

The Properties view contains settings common for all Threads (Common) and settings for this
particular thread (Thread).

For this thread instance, the thread's name and properties (such as priority level or stack size) can
be easily configured. e2 studio checks that the entries in the property field are valid. For example, it
will verify that the field Priority, which requires an integer value, only contains numeric values
between 0 and 9.

To add RTOS resources to a Thread, select a thread and click on New Object in the Thread Objects
pane. The pane takes on the name of the selected thread, in this case My Thread Objects.
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i *[MyProject] FSP Configuration &

Stacks Configuration

Threads 4] New Thread =]

~ & HAL/Common

L g_ioport I/O Port Driver on r_ioport
~ i New Thread

# g_wdt0 Watchdog Driver on r_wdt

Objects | ] New Obje’*e |

® g_new_event_group0 Event Group L]

® égfnew,queueU Queueé

Summary | BSP | Clocks | Pins |Interrupts | Eve

L N B SN B

[ Properties &

Remove = New Thread Stacks

4] New Stack =

@ g_wdt0 Watchdog
Driver on r_wdt

@

BLEU P

Binary Semaphore
Counting Semaphare
Event Group
Message Buffer
Mutex

Queue

Stream Buffer

Timer

g_new_queuel Queue

Settings Property Value
Symbol g_new_queuel |
Item Size (Bytes) 4
Queue Length (Items) 20
Memory Allocation Static

o

Generate Project Content

Figure 34: Configuring Thread Object Properties

Make sure to give each thread object a unique name and symbol by updating the Name and

Symbol entries in the Properties view.

2.2.7 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or
excluded. Modules common to all RA MCU projects are preselected (for example: BSP > BSP >
Board-specific BSP and HAL Drivers > all > r_cgc). All modules that are necessary for the
modules selected in the Stacks tab are included automatically. You can include or exclude

additional modules by ticking the box next to the required component.
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& *[MyProject] FSP Configuration 52 = 0
Components Configuration Generate ;?m Content
Filter | Al v
Component Version Description Variant 2
~ ¥ rabm3
device Board support package for R7TFABM3AH3CFC R7FAGM3AHS..
device Board support package for RAGM3
I device Board support package for RTFABM3AF2CBG R7FABM3AF2C...
O device Board support package for R7TFABM3AF2CLK R7FABM3AF2C...
O device Board support package for RTFAGM3AF3CFB R7FAGM3AF3C...
I device Board support package for RTFABM3AF3CFC R7FABM3AF3C...
O device Board support package for RTFABM3AF3CFP R7FAGM3AF3C...
O device Board support package for RTFAGM3AH2CBG R7FAGM3AH2..
I device Board support package for RTFABM3AH2CLK R7FA6M3AHZ...
O device Board support package for R7TFAGM3AH3CFB R7FAGM3AHS..
O device Board support package for RTFAGM3AH3CFP R7FAGM3AHS..
fsp Board support package for RA6M3 - FSP Data
¥ rabm4
¥ rabm5
¥ rabtl
% c_sdk
~ #% CMSIS
v # CMSIS5
CoreM 57.0 Arm CMSIS Version 5 - Core (M)
O coreM 5.6.0 Arm CMSIS Version 5 - Core (M)
[ psp 5.6.0 Arm DSP Library Source
O pse 5.7.0 Arm DSP Library Source
O NN 5.6.0 Arm NN Library Source v

Summary | BSP | Clocks | Pins |Interrupts | Event Links Stac

Figure 35: Components Tab

Clicking the Generate Project Content button copies the .c and .h files for each selected
component into the following folders:

* ra/fsp/inc/api

e ra/fsp/inc/instances

e ra/fsp/src/bsp

e ra/fsp/src/<Driver Name>

e2 studio also creates configuration files in the ra_cfg/fsp_cfg folder with configuration options set in
the Stacks tab.

2.2.8 Writing the Application

Once you have added Modules and drivers and set their configuration parameters in the Stacks tab,
you can add the application code that calls the Modules and drivers.

Note
To check your configuration, build the project once without errors before adding any of your own application code.

2.2.8.1 Coding Features

e2 studio provides several efficiency improving features that help write code. Review these features
prior to digging into the code development step-by-step sections that follow.

Autocomplete

Autocomplete is a context aware coding accelerator that suggests possible completions for partially
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typed-in code elements. If you can 'guess' the first part of a macro, for example, the Autocomplete
function can suggest options for completing the rest of the macro.

In the following example, a macro related to a BSP_IO setting needs to be found. After typing
BSP_IO_in a source code file, pressing Ctrl + Space opens the Autocomplete list. This list shows a
selection of context aware options for completing the macro. Scroll through the window to find the
desired macro (in this case BSP_IO_LEVEL_HIGH) and click on it to add it to your code.

Protect PFS registers

R_BSP_PinAccessDi;able( );

ogegle level for next rite

if (BSP_IO_LEVEL_LOW == pin_level)

{ pin_level = BSP_IO0_
i lse o BSP_IO_DIRECTION_INPUT ~
{ o BSP_IO_DIRECTION_OUTPUT
pin_level = BSP_ IO L o o
} o BSP_IO_LEVEL_LOW
vTaskDelay(configTICK_RA ° BSP_IO_PORT_00
} o BSP_IO_PORT_00_PIN_00
} o BSP_IO_PORT_00_PIN_01
. o BSP_IO_PORT_00_PIN_02 R v
o BSP_IO_PORT_00_PIN_03
E = r# o BSP_IO_PORT_00_PIN_04
o BSP_IO_PORT_00_PIN_05
o BSP 10 PORT 00 PIN 06 vi Moc

Press ‘Ctrl+Space’ to show Template Proposals

Figure 36: Autocomplete example

Other code elements can use autocomplete too. Some of the more common uses for Autocomplete
include Enumerations, Types, and API functions - but try it in any situation you think the tool may
have enough context to determine what you might be looking for.

For a hands-on experience using Autocomplete use the Quick FSP Labs for Creating Blinky from
Scratch and Creating an RTC Blinky from Scratch. These 15-minute Do it Yourself labs take you
through the step-by-step process of using Autocomplete, Developer Assistance, and the Help
system.

Welcome Window
The e2 studio Welcome window displays useful information and common links to assist in

development. Check out these resources to see what is available. They are updated with each
release, so check back to see what has been added after a new release.
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RA_Workspace - Blinky/sre/hal_entry.c - € studio

File Edit Source

& & m

Cheat Sheets

RENESAS

Refactor Mavigate Search Project RenesasViews Run

g% Welcome 33

Welcome to e2 studio

Create a new e2 studio C/C++ project

Import existing e studio projects from the
filesystem or archive

Review the IDE's most fiercely contested
preferences

Open a file from the filesystem

Window Help

Get an overview of the features

Go through tutorials

Try out the samples

Find out what is new

Wl Always show Welcome at start up

Figure 37: Welcome window

Cheat sheets are macro driven illustrations of some common tasks. They show, step-by-step, what
commands and menus are used. These will be populated with more examples on each release.
Cheat Sheets are available from the Help menu.

a fspWaorkspace - Blinky/src/hal_entry.c - &® studio

File Edit Source Refactor

¢ Debug

I3 Project Explorer &
ES TV
~ 122 Blinky
=Y Includes
Era
= ra_gen
(2 src
= ra_cfg
[= script
|= Blinky Debug_Flat.launch
¢ configurationxml
=l R7TFABM1AD3CFP.pincfg
= ra_cfgbat
= RABM1-EK.pincfg
(@ Developer Assistance
== MyProject

i

[% Pin Conflicts &2

0 items

Developer Assistance

m]

Navigate Search Project RenesasViews Run Window | Help

QS
=0 g
ate ~ Al

[ MyProject Debug_Flat Hnil & Welcome

[ hal_entry.c % (@ Help Contents
2 & * Copyright [2020 @ oM
Z; Pyrig Show Contextual Help
21 #include "hal_data Show-Aetivakaybinding Ctrl+Shift+L
22 Cheat Sheets..
23 void R_BSP_WarmS{a
24 RA Helpdesk
25 extern bsp_leds_t & RenesasRulz Community Forum
26 # Add Renesas Toolchains
28 ® ¥ @brief Blinky 42 perform Setup Tasks..
33 =void hal_entry (vo _
34 “& Check for Updates
35 - #if BSP_TZ SECURE_ [§-  Install New Software...
36 Renesas e2 studio feedback
37 /* Enter non-s @& IAR Embedded Workbench plugin manager...
38 R_BSP_NonSecur o .
19 - & About e? studio
40
41 /* Define the units to be used with the software delay function */
42 const bsp_delay units_t bsp_delay_units = BSP_DELAY UNITS_MILLISECON
43
44 /* Set the blink frequency (must be <= bsp delay units */
45 const uint32_t freg_in_hz = 2;
46
47 /* Calculate the delay in terms of bsp _delay units */

Figure 38: Cheat Sheets
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FSP Developer Assistance provides developers with module and Application Programming Interface
(API) reference documentation in e2 studio. After configuring the threads and software stacks for an
FSP project with the RA Configuration editor, Developer Assistance quickly helps you get started
writing C/C++ application code for the project using the configured stack modules.

1. Expand the project explorer to view Developer Assistance

2

5 Project Explorer £3 =

v 1S Blinky
mY Includes

JLy

2 ra

2 ra_gen

(2 src

(= ra_cfg

(= script

\=| Blinky Debug.launch

{54 configuration.xml
R7FABM3AH3CFC.pincfg

| ra_cfg.bdt

RAGM2-EK pincfg

v (2) Developer Assistance
v ¢ HAL/Common
4% g_ioport /O Port Driver on r_ioport
4 g_elc ELC Driver on r_elc
& g_adc0 ADC Driver on r_adc

Figure 39: Developer Assistance

2. Expand a stack module to show its APIs

v (7) Developer Assistance
v g HAL/Common
47 g ioport /0 Port Driver on r_joport
) g_elc ELC Driveronr_elc
~ @ g adch ADC Driver on r_adc

v @ fsp_err tR_ADC Open(adc_ctrl_t *p_ctrl, ade_cfg_t const *const p_cfg)
B2 Call R_ADC Open()

v @ fsp_err tR_ADC ScanCfglade_ctrl_t *p_ctrl, adc_channel_cfg_t const *const p_channel_cfg)
|2 CallR_ADC ScanCfg()

v @ fsp_err tR_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
i Call R_ADC InfoGet()

v @ fsp_err tR_ADC ScanStart(adc_ctrl_t *p_ctrl)
|5 Call R_ADC_ScanStart(}

v @ fsp_err tR_ADC ScanStop(adc_ctrl_t *p_ctrl)
B2 Call R_LADC ScanStop()

v @ fsp_err tR_ADC StatusGet(adc_ctrl t *p_ctrl, adc_status_t *p_status)
[ Call R_ADC StatusGet()

v @ fsp_err tR_ADC Read(adc_ctrl_t *p_ctrl, adc_channel_t const reg_id, uint16_t *const p_data)
f2 Call R_ADC Read()

w @ fon err t R ANC Read3?(ade ctrl t *n ctrl ade channel t const rea id nint3? + *const n datal nd
>

Figure 40: Developer Assistance APIs

3. Dragging and dropping an API from Develop Assistance to a source file helps to write source
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code quickly.
[ Project Explorer 2 2% %W 7 O & MyProject] FSP Configuration | [€ *hal_entry.c & =B
~ (@ Developer Assistance ~ ] #include "hal_data.h" ~

~ & HAL/Common
k3 g_ioport I/O Port Driver on r_ioport
~ # g_adc0 ADC Driver on r_adc
fspemtRAC T Opemta
2 Call R_ADC_Open()

z
3 FSP_CPP_HEADER
4 void R_BSP_WarmStart(bsp warm_start_event_t event);
5 FSP_CPP_FOOTER

-_ctrl_t *p_ctrl, adc_cfg_t

o
8 @ * main() is generated by the RA Configuration editor and is used to generate threads if an =

et RADC adc_ctrl_t *p_CtMrwaid co =void hal_entry(void) {
@ fsp_err_t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_infc = —add vour own code hers *
® fsp_err_t R_ADC_ScanStart(adc_ctrl_t *p_ctrl) g = R_ADC_Open(&g_adc@_ctrl, &g adc@®_cfg);
14

@ fsp_err_t R_ADC_ScanStop(adc_ctrl_t *p_ctrl)

@ fsp_err_t R_ADC_StatusGet(adc_ctrl_t *p_ctrl, adc_st ’: ° ?EPEKEEEEEEESS&Z code */

@ fsp_err_t R_ADC Read(adc_ctrl_t *p_ctrl, adc_chann :; R_BSP_NonSecureEnter();

@ fsp_err_t R_ADC_Read32(adc_ctrl_t #*p_ctrl, adc_cha 18 #endif

@ fsp_err t R_ADC SampleStateCountSet(adc_ctrl t* 19 ¥

® fsp_err_t R_ADC_Close(adc_ctrl_t *p_ctrl) 20

® fsp_err_t R_ADC_OffsetSet(adc_ctrl_t *const p_ctrl, | %E @ * lThis function is called at various points during the startup process. This implementatic
@ fsp_em_t R ADC Calibrate(adc_ctrl_t *const p_ctrl, 1, :; :W"J‘dii—?;;;w:/::f’t:;::é?szg’;;mitzczﬁ‘{e?t—t event) {

Figure 41: Dragging and Dropping an API in Developer Assistance

For a hands-on experience using Developer Assistance use the Quick FSP Labs for An Introduction to
Developer Assistance, Creating Blinky from Scratch and Creating an RTC Blinky from Scratch. These
15-minute Do it Yourself labs take you through the step-by-step process of using Autocomplete,
Developer Assistance, and the Help system.

Information Icon

Information icons are available on each module in the thread stack. Clicking on these icons opens a
module folder on GitHub that contains additional information on the module. An example information
Icon is shown below:

47 g_ioport 1/0 Port

\ Driver on r_ioport
D

Figure 42: Information icon

IDE Help

A good source of additional information for many FSP topics is the Help system. To get to the Help
system, click on Help and then select Help Contents as seen below.
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Window | Help
| Flat ) Welcome
i = g (@ Help Contents
ShoWw ConTextuar=elp
Show Active Keybindings... Ctrl+Shift+L
Cheat Sheets...
_cfg_t RA Helpdesk
& RenesasRulz Community Forum
oidco g7 Add Renesas Toolchains
dc_infc %§  Perform Setup Tasks...
% Check for Updates
@ Install New Software...
ade sl Renesas e2 studio feedback
chann i& AR Embedded Workbench plugin manager...
de.cha @ About e? studi
Lt out e® studio

Figure 43: Opening the Help System

Once the Help system is open, select the RA Contents entry in the left side Guide-bar. Expand it to

see the main RA Topics.

& Help - € studio

Search: Scope: All topics

Contents @- ¥- B

+ © Workbench User Guide

# € C/C++ Development User Guide

# € e2 studio User Guide

% € Eclipse Remote Developer's Guide

+ © EGit Documentation

of GNUARM-NONE/RZ(DS-5) Project Import
4 © Linker Script and Linker Script Editor

# € Oomph P2 Management Documentation
# € Oomph Setup Documentation

= E RA Contents

RA configuration editor

MCU Package View

RA user pack creator

RA Developer Assistance

How to create and use an RA static library

w

Preferences for the RA Configuration Editor
RA FAQ

% © Renesas Hardware Manuals

+ € Renesas QE for Capacitive Touch[RA]

# € Scripting User Guide

DEPDDD D@

RA Contents >

Creating an RA project

A new Renesas RA project is created using one of the RA C or C++ project wizards. The wizard selection page can be opened in one
of the following ways:

« The e2 studio [File->New->RA C/C+= Project] main menu
¢ The Project Explorer view [New->RA C/C++ Project] context menu
¢ The 2 studio [New->RA C/C++ Project] toolbar drop-down

‘Wizard selection page

The wizard selection page allows you to choose the type of RA wizard to open. Wizards are available for either C or C++ and for an
RA Executable or Static Library project.

How to create an application project which uses &

[ New RA C/C++ Project

Templates for New RA C/C++ Project

Renesas RA C Executable Project
UG+ FE===N~ A C Executable Project for Renesas RA

Figure 44: RA Content Help

You can also search for help topics by using the Search bar. Below is an example searching for
Visual Expressions, a helpful feature in the e2 studio debugger.
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&) Help - € studio - O X
Search: visual expressions Scope: All topics
Search Results = D g D O mwelle 0

e2 studio User Guide > Debugging Projects > Views

6 matches in All topics: Change scope

The Visual Expressions view can show a visual Vlsual EXpreSSlons Vlew
representation of expressions that are presented
in the program's code. It is similar to the
Expressions view but with graphic...

e2 studio Plug-in list

) Visual Expression 3 E-#E -0

e2 studio Plug-ins The table lists some of the

plug-ins available in e2 studio. The table also lists esauss
who were the most recent developers of the view .
or plugin: Plug-in Name... A 4

Tuning Error Parsers PN i
Error Parsers scan build output line by line 2

looking for errors and warnings (also for certain
informational messages). They generate Problem
Markers which visually indicat...

, Overview
B Error Parser Preferences

Use the Error Parsers Tab on Build preference The Visual Expressions view can show a visual representation of expressions that are presented in the program's code. It
panel to define global error parsing options. is similar to the Expressions view but with graphical representations. Each graphically represented expression in the
Error Parsers scan build output looking for Visual Expressions view is referred to as a “visual element”.

potential error or warning messages....

[ ER : TR S TR N PRI S R L

Figure 45: e2 studio Help from the Search Bar

For a hands-on experience using the Help system use the Quick FSP Labs for An Introduction to
Developer Assistance, Creating Blinky from Scratch and Creating an RTC Blinky from Scratch. These
15-minute Do it Yourself labs take you through the step-by-step process of using Autocomplete,
Developer Assistance, and the Help system.

2.2.8.2 HAL Modules in FSP: A Practical Description

The FSP Architecture section describes FSP stacks, modules and interfaces in significant detail,
providing an understanding of the theory behind them. The following sections provides a quick and
practical introduction on how to use API functions when writing code and where in the API reference
sections you can find useful API related information.

Introduction to HAL Modules

In FSP, HAL module drivers provide convenient API functions that access RA processor peripheral
features. Module properties are defined in the RA GUI configurator, eliminating the tedious and error
prone process of setting peripheral control registers. When configuration is complete, the generator
automatically creates the code needed to implement the associated API functions. API functions are
the main way a developer interacts with the target processor and peripherals.

HAL Driver API Function Call Formats

HAL driver API functions all have a similar format. They all start with "R_" to indicate they are HAL

related functions. Next comes the module name followed by the function and any parameters. This
format is illustrated below:

R _<nodul e>_<functi on>( <par anet er s>) ;

Here are some examples:
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status = R GPT_Qpen(&g tinmer0 _ctrl, &g timer0_cfq);
status = R GPT_Start (& tinmer0_ctrl);

status = R GPT_PeriodSet (&g tinmer0O_ctrl, period);
status = R ADC Open(&g_adcO_ctrl, &g adcO _cfg);
status = R ADC | nfoGet (&g adcO _ctrl, &adc_info);

HAL Driver API Call Reference Information

Each HAL module has a useful API Reference section that includes key details on each function. The
function prototype is presented first, showing the return type (usually fsp_status_t for HAL functions)
and the function parameters. A short description and any warnings or notes follow the function
definition. In some cases, a code snippet is included to illustrate use of the function. Finally, all
possible return values are provided to assist in debugging and error management.

& R_GPT PeriodSet()

t R_GPT_PeriodSet [ tim t *const p_ctrl,
uint32_t const period_counts

Sets period value provided. If the timer is running, the period will be updated after the next counter overflow. If
the timer is stopped, this function resets the counter and updates the period. Implements

Warning
If periodic output is used, the duty cycle buffer registers are updated after the period buffer register. If
this function is called while the timer is running and a GPT overflow occurs during processing, the duty

cycle will not be the desired 50% duty cycle until the counter overflow after processing completes.

Example:

* @Get the source clock frequency (in Hz). There are 3 ways to do this in FSP:
=

- If the PCLKD frequency has not changed since reset, the source clock
frequency is

x BSP_STARTUP_PCLKD_HZ >> timer_cfg_t::source_div

- Use the R_GPT_InfoGet function (it accounts for the divider).

* - Calculate the current PCLKD frequency using R_FSP_SystemClockHzGet
(FSP_PRIV_CLOCK_PCLKD) and right shift

>, by timer_cfg t::source_div.

~

#

* This example uses the 3rd option (R_FSP_SystemClockHzGet).
x4

uint32_t pclkd_freq_hz = R_FSP_SystemClockHzGet(FSP_PRIV_CLOCK_PCLKD) >>
g_timer® _cfg.source_div;

/* Calculate the desired period based on the current clock. Note that this
calculation could overflow if the

* desired period is larger than UINT32 _MAX / pclkd freq_hz. A cast to uinté4 t is
used to prevent this. */

uint32_t period_counts =
(uInt32 t) (((uint64_t) pclkd freq hz * GPT_EXAMPLE_DESTIRED PERTOD_MSEC) /
GPT_EXAMPLE_MSEC_PER_SEC);

/* Set the calculated period. */

err = R_GPT_PeriodSet(&g_timere_ctrl, period counts);

handle_error{err);

Return values
FSP_SUCCESS Period value written successfully.
FSP_ERR_ASSERTION p_ctrl was NULL.
FSP_ERR_NOT_OPEN The instance is not opened.

Figure 46: Module Api Reference Section Example

2.2.8.3 RTOS-Independent Applications

To write application code:
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1. Add all drivers and modules in the Stacks tab and resolve all dependencies flagged by e2
studio such as missing interrupts or drivers.

. Configure the drivers in the Properties view.
3. In the Project Configuration view, click the Generate Project Content button.

N

4. In the Project Explorer view, double-click on the src/hal_entry.c file to edit the source file.

|
o

i Project Explorer 332 = =
-
IS

125 Blinky
T FSP_project

v 15 MyProject [Debug]

#;;b Binaries

[ Includes
Era
(2 ra_gen
v @ src
l€| hal_entry.c
(= Debug
(= ra_cfg
= script
=| A2A1-TBB.pincfg

Note

All configuration structures necessary for the driver to be called in the application are initialized in
ra_gen/hal_data.c.
Warning

Do not modify the files in the directory ra_gen. These files are overwritten every
time you push the Generate Project Content button.

5. Add your application code here:

[€ hal_entry.c 52 | {55 [MyProject] RA Configuration
B 1 #include "hal Hata.h”
2 #include "bsp_pin_cfg.h"
#include "r_ioport.h”
void R_BSP_WarmStart(bsp_warm_start_ever

@ * The RA Configuration tool generates n

11 void hal_entry(void)
12 {

=13 £¥ : add your own code here */
14 17 \

Add your own code here

Figure 47: Adding user code to hal_entry.c

6. Build the project without errors by clicking on Project > Build Project.

The following tutorial shows how execute the steps above and add application code: Tutorial: Using
HAL Drivers - Programming the WDT.

The WDT example is a HAL level application which does not use an RTOS. The user guides for each
module also include basic application code that you can add to hal_entry.c.

2.2.8.4 RTOS Applications
To write RTOS-aware application code using RTOS, follow these steps:

1. Add a thread using the Stacks tab.
2. Provide a uniqgue name for the thread in the Properties view for this thread.
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3. Configure all drivers and resources for this thread and resolve all dependencies flagged by
e2 studio such as missing interrupts or drivers.

. Configure the thread objects.

. Provide unique names for each thread object in the Properties view for each object.

. Add more threads if needed and repeat steps 1 to 5.

. In the RA Project Editor, click the Generate Project Content button.

~N o U b~

8. In the Project Explorer view, double-click on the src/my_thread 1 _entry.c file to edit the
source file.

[y Project Explorer 3 = 8

E S ¥

&

v 15 RA_RTOS_Application [Debug]  ~
[ Includes
Era
v 5 ra_gen
[.g] blinky_thread.c
blinky_thread.h
bsp_clock_cfg.h
bsp_pin_cfg.h
[€] common_data.c
comrmon_data.h
lg] hal_data.c
hal_data.h
€] main.c
4g] my_thread_1.c
rmy_thread_1.h
€] pin_data.c
|.g] vector_data.c
vector_data.h
2] ABM3-PK.csv
v B src
lg] blinky_thread_entry.c
lg] hal_entry.c
l.g] my_thread_1_entry.c
(= ra_cfg
(= script
= ABM3-PK.pincfg
& configurationxml
= R7FABM3AH3CFC.pincfg

< >

Figure 48: Generated files for an RTOS application

Note
All configuration structures necessary for the driver to be called in the application are initialized in
ra_gen/my_thread 1.cand my thread 2.c

Warning
Do not modify the files in the directory ra_gen. These files are overwritten every
time you push the Generate Project Content button.

9. Add your application code here:

<_"—:_> [RA_RTOS_Application] RA Configuration S(s’l \€] my_thread_1_entry.c 3% |

A f{"‘,‘i“?:’;Z‘git[P.A_RTOs_i\pp|icatwf‘n_.'ccnﬁguratim.xnﬂ |

void my_thread_1_entry{void *pvParameters)

M
: add your own code here */
while (1)

{

1a wTaskDelay (1);

s);

Figure 49: Adding user code to my_thread_1.entry

10. Repeat steps 1 to 9 for the next thread.
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11. Build your project without errors by clicking on Project > Build Project.

2.2.8.5 Additional Resources for Application Development
Example Projects
A wide variety of Example Projects for FSP and RA MCUs is available on the GitHub site here:

https://github.com/renesas/ra-fsp-examples. Example projects are organized by target kit so it is
easy to find all the examples for your kit of choice.

ek_ra2a1l
ek_radm1
ek radw1
ek_rabm1
ek_rabm2
ek rabm3
ek_rabm3g

Figure 50: FSP Example Projects Organized by Kit

Projects are available as both downloadable zip files and as project source files. Typically, there is a
project for each module. New example projects are being added periodically, so check back if a
particular module isn't yet available.

m acmphs/acmphs_ek_raém3_ep
) adc/ade_ek_rabm3_ep
[Bm agt/agt_ek_rabm3_ep

[m cac/cac_ek_rabm3_ep

B crc/crc_ek_rabm3_ep

m dmac/dmac_ek_rabm3_ep
W clc/elc_ek_rabm3_ep

im flash_hp/flash_hp_ek_raém3_ep
) freertos/freertos_ek_raém3_ep
I gpt/gpt_ek_rabém3_ep

[Bm icuficu_ek _rabm3_ep

[ iic_master/iic_master_ek_rabm3_ep
m iic_slavefiic_slave ek _rabm3_ep

Bm kint/kint_ek_rabm3_ep

i vd/lvd_ek_rabm3_ep

Bm quickstart/quickstart_ek_rabm3

j rtc/rtc_ek_rabm3_ep

Figure 51: A Selection of Example Projects Available on GitHub

Quick Labs

A variety of Hands-on Do It Yourself labs are available on the Renesas RA and FSP Knowledge Base.
Quick FSP Labs target the EK-RA6M3 kit and typically require only 15 minutes to complete. Each lab
covers a couple related development tools and techniques like Autocomplete, Developer Assistance,
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console I/O over RTT, and Visual Expressions, that can speed up the development process. A list of
all available Quick Labs can be found here: https://en-
support.renesas.com/knowledgeBase/19450948

2.2.9 Debugging the Project

Once your project builds without errors, you can use the Debugger to download your application to
the board and execute it.

To debug an application follow these steps:

1. On the drop-down list next to the debug icon, select Debug Configurations.

R MY =

[E7] 1 FSP_project Debug
Debug As >
Debug Configurations...

Organize Favorites...

2. In the Debug Configurations view, click on your project listed as MyProject Debug.

Debug Cenfigurations *
Create, manage, and run configurations %'\
= Y
RS | e Name: | MyProject Debug |
type filter text [ Main %5 Debugger| = Startup| ] Common| K Source

[€] C/C++ Application

[©] C/C++ Remote Applicatic
EASE Script | MyProject Browse...

[£] GDB Hardware Debuggin; || ¢/Ce Application:

[£] GDB OpenOCD Debuggin

GDB Simulator Debuggin:
Java Applet Variables... Search Project... Browse...
Java Application

R Launch Group

= Launch Group (Deprecate Build Configuration: | Use Active i
Remote Java Application

Project:

[ Debug/MyProject.elf

Build (i required) before launching

[ Renesas GDE Hardware D () Enable auto build () Disable auto build
[£7] MyProject Debug (®) Use workspace settings Configure Workspace Settings...
Renesas Simulator Debug
< >
Revert Apply.
Filter matched 14 of 16 items
@

3. Connect the board to your PC via either a standalone Segger J-Link debugger, a Segger J-
Link On-Board (included on all RA EKs), or an E2 or E2 Lite and click Debug.

Note
For details on using J-Link and connecting the board to the PC, see the Quick Sart Guide included in the RA MCU
Kit.

2.2.10 Modifying Toolchain Settings
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There are instances where it may be necessary to make changes to the toolchain being used (for

example, to change optimization level of the compiler or add a library to the linker). Such

modifications can be made from within e2 studio through the menu Project > Properties >
Settings when the project is selected. The following screenshot shows the settings dialog for the
GNU Arm toolchain. This dialog will look slightly different depending upon the toolchain being used.

Properties for Blinky

Resource
Builders
~ C/C++ Build
Build Variables
Environment
Logging
Settings
Tool Chain Editor
C/C++ General
MCU
Project References
Renesas QF
Run/Debug Settings
Task Repository
Task Tags
Validation

Settings

Configuration: | Debug [ Active ]

5 Tool Settings i3 Toolchain

Build Steps

(& Target Processor
(& Optimization
(& Wamings
(£ Debugging
w &3 GNUARM Cross Assembler
(£ Preprocessor
(2 Includes
(& Warnings
(& Miscellaneous
w &3 GNU ARM Cross C Compiler
(£ Preprocessor
(2 Includes
(£ Optimization
(£ Warnings
(& Miscellaneous
w & GNU ARM Cross C Linker
(2 General
(2 Libraries
(& Miscellaneous

(2 General
5\ AR ADRA oo N T

]

w &) GNU ARM Cross Create Flash Image

~ | | Manage Cenfigurations...

ARM family cortex-m4
Architecture Toolchain default

Instruction set Thumb (-mthumb)

] Thumb interwork (-mthumb-interwaork)

Endianness Toolchain default
Float ABI FP instructions (hard)
FPU Type fpvd-sp-di16

Unaligned access | Toolchain default

Generic (-mcpu=generic)

Toolchain default
Toolchain default
Toolchain default

Enabled (+simd)

Small (-mecmodel=small)

P
‘x?/'

Apply and Close

Figure 52: e2 studio Project toolchain settings

Build Artifact Iu_f} Binary Parsers 3 Error Parsers

w

v

Cancel

The scope for the settings is project scope which means that the settings are valid only for the

project being modified.

The settings for the linker which control the location of the various memory sections are contained in
a script file specific for the device being used. This script file is included in the project when it is
created and is found in the script folder (for example, /script/aém3.Id).

2.2.11 Creating RA project with ARM Compiler 6 in e2 studio

e2 studio does not include the ARM Compiler 6 (AC6) toolchain by default. Follow the steps below to
integrate ACG6 into e2 studio and create an AC6 RA project.

Note

It is assumed that the user is already familiar with RA project creation in e2 studio. e2 studio does not include ARM
Compiler 6 (ACB6) toolchain by default.

Steps 1 through 8 describe the process for integrating ARM Compiler 6 into e2 studio.

1. Download, install, and configure license for the AC6 toolchain
(https://developer.arm.com/tools-and-software/embedded/arm-
compiler/downloads/version-6).

N

. Launch e2 studio.

3. Go to Window > Preferences > Toolchains.
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4. Click Add.

E Preferences

type filter text Toolchains

Library Hover Add/Remove toolchains

LinkerScript

MCU

Mylyn

Oomph

Remote Development
Renesas QF
Run/Debug

Scripting

Team

Terminal

Add...

Remove

Toolchains MName: Mo Toolchain Selected
Tracing Path:
Validation

XML v

®@® Apply and Close

Figure 53: Add Toolchain

Apply

Cancel

5. Browse to the path where AC6 toolchain is installed and select the \bin folder. Click Next.

Add a new Toolchain

Select Toolchain Path

Please enter the path to the toolchain's binaries directory.

O X

Path to toolchain binaries: | C:\Program Files\ARMCompiler6.14\bin

| IBrowse...I

Download toolchains from ds.arm.com

Figure 54: Browse to AC6 Compiler

6. Toolchain information in displayed. Click Finish.

Cancel
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E Add a new Toolchain

Discovered Toolchain Information

Toolchain ARM Compiler 6.14 was discovered from C:\Program Files\ARMCompiler6.14\bin

Compiler: armclang.exe
Assembler: armasm.exe
Linker: armlink.exe
Archiver: armar.exe

Image Converter: fromelf.exe

If this information is correct, click Finish to add the toolchain, otherwise click Next to edit/correct

this information.

Next >

Figure 55: Toolchain Information

7. Click Apply and Close.

8. Click Restart Eclipse when prompted.

E Preferences

type filter text

Library Hover
LinkerScript
MCU

Mylyn
Oomph
Remote Development
Renesas QF
Run/Debug
Scripting
Team
Terminal
Toolchains
Tracing
Validation
XML

@®

~

X
Toolchains =i
Add/Remove toolchains
Name Add...
Remove

Name: ARM Compiler 6.14

Path:

C\Program Files\ARMCompiler6.14\bin

Apply

Apply and Close Cancel

Figure 56: Apply and Close

R11UMO0155EU0230 Revision 2.30
Sep.10.2021

RLENESAS

Page 52 /2,794



Flexible Software Package

Starting Development > e2 studio User Guide > Creating RA project with ARM Compiler 6 in e2 studio

User’s Manual

E Confirm Restart Eclipse

I-e'-‘ Eclipse must be restarted in order for the changes to be visible.

Figure 57: Restart Eclipse

9. When creating a new RA C/C++ project, select ARM Compiler 6 included in the Toolchains
section.

E e2 studio - Project Configuration (RA C Executable Project)

e2 studio - Project Configuration (RA C Executable Project)
Specify the new project details.

Project Toolchains
Project name | ARM_Compiler_Test ‘ GNU ARM Embedded
Use default location

|ARM Compiler 6.14 |

Figure 58: Select Arm Compiler

2.2.12 Importing an Existing Project into e2 studio
1. Start by opening e2 studio.

2. Open an existing Workspace to import the project and skip to step d. If the workspace
doesn't exist, proceed with the following steps:

a. At the end of e2 studio startup, you will see the Workspace Launcher Dialog box as
shown in the following figure.

B8 Eclipse Launcher *
Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts.

RIS ETEWEC \Users\\ < user_namele2studio\workspace]

Browse...

[] Use this as the default and do not ask again
» Recent Workspaces

Cancel
Figure 59: Workspace Launcher dialog
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b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the
following figure. e2 studio creates a new workspace with this name.

E Eclipse Launcher

*
Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts,

IR ET N Users\ <username > \e2studiol\new workspace] Browse...

[] Use this as the default and de not ask again

b Recent Workspaces

Cancel
Figure 60: Workspace Launcher dialog - Select Workspace

c. Click Launch.

d. When the workspace is opened, you may see the Welcome Window. Click on the

Workbench arrow button to proceed past the Welcome Screen as seen in the
following figure.

RENESAS Welcome to e2 studio (=)

Workbench

Figure 61: Workbench arrow button

3. You are now in the workspace that you want to import the project into. Click the File menu
in the menu bar, as shown in the following figure.

Q fspWorkspace - FSPproject/confit

File Edit Navigate Search Proje €= Menu bar
4+ Debug <« Tool bar

—*

. | 4

Figure 62: Menu and tool bar

4. Click Import on the File menu or in the menu bar, as shown in the following figure.
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File Edit Mavigate Search Project Renesas Views Ru

New Alt+Shift+N >

Open File...
. Open Projects from File System...
Recent Files

Close Ctrl+W
Close All Ctrl+Shift+W

Save
Save As...

Save Al Ctrl+Shift+S

Revert

Move...

Rename...

Refresh

Convert Line Delimiters To

Print...

i Export...

E

Properties Alt+Enter

Switch Workspace
Restart
Bxit

>

Ctrl+5

Ctrl+P

>

Figure 63: File drop-down menu

5. In the Import dialog box, as shown in the following figure, choose the General option, then
Existing Projects into Workspace, to import the project into the current workspace.

Import

Select

Create new projects from an archive file or directory.

Select an import wizard:

type filter text

w [= General

JE Archive File

[} CMSIS Pack

[ CMSIS Pack

[ Existing Projects into Workspace

[ File System

[T Preferences

() Projects from Folder or Archive

= Rename & Import Existing C/C++ Project into Workspace

3
'_2/‘ < Back Next > Einish

Cancel

Figure 64: Project Import dialog with "Existing Projects into Workspace" option selected

6. Click Next.

7. To import the project, use either Select archive file or Select root directory.

a. Click Select archive file as shown in the following figure.
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Q Import

O X
Import Projects B
Select a directory to search for existing Eclipse projects. A
() Select root directory: Browse...
@ Select archive file: | | Browse...
Projects:
Select All
Deselect All
Refresh
Options
Search for nested projects
Copy projects into workspace
[] Close newly imported projects upon completion
[ 1Hide projects that already exist in the workspace
Working sets
] Add project to working sets New.
Select...
@ < Back Next > Finish Cancel

Figure 65: Import Existing Project dialog 1 - Select archive file

b. Click Select root directory as shown in the following figure.
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Q Import O X

Import Projects )_ 1

Select a directory to search for existing Eclipse projects.

(@ Select root directory: | | ~ Browse...
(O Select archive file: Browse...
Projects:
Select All
Deselect All
Refresh
Options
[]search for nested projects
[ICopy projects into workspace
[] Close newly imported projects upon completion
[ 1Hide projects that already exist in the workspace
Woarking sets
] Add project to working sets New...
Select...
'/?3‘ < Back Next > Finish Cancel

Figure 66: Import Existing Project dialog 1 - Select root directory

8. Click Browse.

9. For Select archive file, browse to the folder where the zip file for the project you want to
import is located. For Select root directory, browse to the project folder that you want to
import.

10. Select the file for import. In our example, it is CAN_HAL_MG_AP.zip or CAN_HAL_MG_AP.
11. Click Open.

12. Select the project to import from the list of Projects, as shown in the following figure.

Projects:

CAN HAL MG_AP (CAN_HAL_MG_AP/}
Figure 67: Import Existing Project dialog 2

13. Click Finish to import the project.

2.3 Tutorial: Your First RA MCU Project - Blinky

2.3.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the
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steps of creating a simple application using e2 studio and running that application on an RA MCU
board.

2.3.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded
development environment.

Blinky is the "Hello World" of microcontrollers. If the LED blinks you know that:

The toolchain is setup correctly and builds a working executable image for your chip.
The debugger has installed with working drivers and is properly connected to the board.
The board is powered up and its jumper and switch settings are probably correct.

The microcontroller is alive, the clocks are running, and the memory is initialized.

The Blinky example application used in this tutorial is designed to run the same way on all boards
offered by Renesas that hold the RA microcontroller. The code in Blinky is completely board
independent. It does the work by calling into the BSP (board support package) for the particular
board it is running on. This works because:

e Every board has at least one LED connected to a GPIO pin.

e That one LED is always labelled LED1 on the silk screen.

e Every BSP supports an API that returns a list of LEDs on a board, and their port and pin
assignments.

2.3.3 Prerequisites

To follow this tutorial, you need:
Windows based PC

e2 studio

Flexible Software Package
An RA MCU board kit

2.3.4 Create a New Project for Blinky
The creation and configuration of an RA MCU project is the first step in the creation of an application.
The base RA MCU pack includes a pre-written Blinky example application that is simple and works on
all Renesas RA MCU boards.
Follow these steps to create an RA MCU project:

1. In e2 studio, click File > New > C/C++ Project and select Renesas RA and Renesas RA

C/C++ Project.
2. Assign a name to this new project. Blinky is a good name to use for this tutorial.

3. Click Next. The Project Configuration window shows your selection.
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Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Name and Location

Project name

[ Blinig

Use default location

default

You can download more Renesas packs here

< Back

Finish

Browse...

Cancel

Figure 68: e2 studio Project Configuration window (part 1)

4. Select the board support package by selecting the name of your board from the Device

Selection drop-down list and click Next.
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Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Device and Tools Selection

Device Selection

FSP Version:
Board: EK-RABM3
Device: R7FABM3AH3CFC

Language: @C OC++

Toolchains

GNU ARM Embedded

< Back

Board Description

Device Details

TrustZone
Pins
Processor

No
176
cortex-m4

Debugger
J-Link ARM

Finish

Cancel

Figure 69: e2 studio Project Configuration window (part 2)

5. Select the build artifact and RTOS.

a Renesas RA C/C++ Project

Renesas RA C/C+ + Project

Build Artifact and RTOS Selection

Build Artifact Selection
@ Executable

* Project builds to an executable file
() static Library

¢ Project builds to a static library file
) Executable Using an RA Static Library

* Project builds to an executable file
s Project uses an existing RA static library project

< Back

RTOS Selection
No RTOS

Finish

Cancel

Figure 70: e2 studio Project Configuration window (part 3)
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6. Select the Blinky template for your board and click Finish.

& Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Template Selection

Project Template Selection

© — _ .
0} Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks,
and the C runtime environment.

o “¢ | Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

Code Generation Settings
Use Renesas Code Formatter

A
|‘3/.

< Back Next = Cancel

Figure 71: e2 studio Project Configuration window (part 4)

Once the project has been created, the name of the project will show up in the Project
Explorer window of e2 studio. Now click the Generate Project Content button in the top
right corner of the Project Configuration window to generate your board specific files.

{:Ei[Bhnky] FSP Conflguratloné =

s o
ummary Generate Project Content

Project Summary

LENESAS
Board: EK-RABM1

Device: R7FAEM1AD3CFP
Toelchain: GCC ARM Embedded
Toelchain Version:

FSP Version:

Selected software components

Figure 72: e2 studio Project Configuration tab

Your new project is now created, configured, and ready to build.

2.3.4.1 Details about the Blinky Configuration
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The Generate Project Content button creates configuration header files, copies source files from
templates, and generally configures the project based on the state of the Project Configuration
screen.

For example, if you check a box next to a module in the Components tab and click the Generate
Project Content button, all the files necessary for the inclusion of that module into the project will
be copied or created. If that same check box is then unchecked those files will be deleted.

2.3.4.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by e2 studio for the Blinky application.
The clock configuration tab (see Configuring Clocks) shows the Blinky clock configuration. The Blinky
clock configuration is stored in the BSP clock configuration file (see BSP Clock Configuration).
2.3.4.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e2 studio
for the Blinky application. The pin configuration tab shows the pin configuration for the Blinky
application (see Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file
(see BSP Pin Configuration).

2.3.4.4 Configuring the Parameters for Blinky Components

The Blinky project automatically selects the following HAL components in the Components tab:

e r_ioport

To see the configuration parameters for any of the components, check the Properties tab in the
HAL window for the respective driver (see Adding and Configuring HAL Drivers).

2.3.4.5 Where is main()?

The main function is located in < project >/ra_gen/main.c. It is one of the files that are generated
during the project creation stage and only contains a call to hal_entry(). For more information on
generated files, see Adding and Configuring HAL Drivers.

2.3.4.6 Blinky Example Code

The blinky application is stored in the hal_entry.c file. This file is generated by e2 studio when you
select the Blinky Project template and is located in the project's src/ folder.

The application performs the following steps:
1. Get the LED information for the selected board by bsp_leds_t structure.
2. Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board.
3. Get the selected system clock speed and scale down the clock, so the LED toggling can be
observed.
4. Toggle the LED by writing to the GPIO pin with R_BSP_PinWrite((bsp_io_port_pin_t) pin,
pin_level);
2.3.5 Build the Blinky Project

Highlight the new project in the Project Explorer window by clicking on it and build it.

There are three ways to build a project:
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1. Click on Project in the menu bar and select Build Project.
2. Click on the hammer icon.
3. Right-click on the project and select Build Project.

B workspace - & studio

File Edit Navigate Searc

OF B a

¢ &

a. Project->Build Project

R s Views Run Window

b. Click hammer icon

¢. Right click->Build Project

Figure 73: e2 studio Project Explorer window

Once the build is complete a message is displayed in the build Console window that displays the
final image file name and section sizes in that image.

7oy s = [l Console &2
CDT Build Censele [Blinky]

'Finished buil;ing: ‘I./ra/bcard/raﬁm}_ek/board_leds..:‘
"Finished building: ../ra/board/raém3_ek/board_init.c’

"Finished building: ../ra/board/raém3_ek/board_gspi.c’

'Building target: Blinky.elf'
"Invoking: GNU ARM Cross C Linker'
arm-none-eabi-gcc @"Blinky.elf.in"
"Finished building target: Blinky.elf'

"Invoking: GNU ARM Cross Create Flash Image'
arm-none-eabi-objcopy -0 srec "Blinky.elf™ "Blinky.srec™
"Invoking: GNU ARM Cross Print Size'
arm-none-eabi-size --format=berkeley "Blinky.elf"

text data bss dec hex filename

4249 8 1152 5488 1518 Blinky.elf
"Finished building: Blinky.srec'
"Finished building: Blinky.siz'

11:5@:45 Build Finished. @ errors, @ warnings. (took 19s5.208ms)

Figure 74: e2 studio Project Build console

2.3.6 Debug the Blinky Project

2.3.6.1 Debug prerequisites

To debug the project on a board, you need

* The board to be connected to e2 studio
* The debugger to be configured to talk to the board
e The application to be programmed to the microcontroller

Applications run from the internal flash of your microcontroller. To run or debug the application, the
application must first be programmed to the microcontroller's flash. There are two ways to do this:

e JTAG debugger

e Built-in boot-loader via UART or USB

Some boards have an on-board JTAG debugger and others require an external JTAG debugger

connected to a header on the board.
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Refer to your board's user manual to learn how to connect the JTAG debugger to e2 studio.
2.3.6.2 Debug steps
To debug the Blinky application, follow these steps:
1. Configure the debugger for your project by clicking Run > Debugger Configurations ...

Run Window Help

Renesas Device Partition Manager

@ TraceX >
Bl Tracealyzer >
@, Run Ctrl+F11
#, Debug F11
Run History >
O Runas >
Run Configurations...
Debug History >

Debug Configurations... |

% Debug As >

@ Fxternal Tools >

Figure 75: e2 studio Debug icon

or by selecting the drop-down menu next to the bug icon and selecting Debugger
Configurations ...

e Qo vig y -

Debug As >
Debug Configurations...
Organize Favorites.

Figure 76: e2 studio Debugger Configurations selection option

2. Select your debugger configuration in the window. If it is not visible then it must be created
by clicking the New icon in the top left corner of the window. Once selected, the Debug
Configuration window displays the Debug configuration for your Blinky project.
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E Debug Cenfigurations X

Create, manage, and run configurations

[ EBR|E 3 | Name: [ Blinky Debug |

type filter text 2 Main ﬁDahugge? i Startup | B Source| [} Common
[T] C/C++ Application
[E] C/C++ Remote Applicz
5[ EASE Script [ Blinky Browse...
[©] GDB Hardware Debugg
[£] GDB Open0CD Debuge
[c7] GDB Simulator Debugg
Java Applet Variables... Search Project... Browse...
Java Application
 Launch Group

Project:

C/C++ Application:
[ Debug/Blinky.elf

Build (if required) before launching

@ Launch Group (Deprec: Build Configuration: | Use Active bl
Remote Java Applicatio _ : .
« [E¥ Renesas GDB Hardware () Enable auto build () Disable auto build
Blinky Debug (®) Use workspace settings Configure Workspace Settings...

[c7] Renesas Simulator Debt

< >

Revert Appl
Filter matched 14 of 16 items -

l./'?\ Close
Figure 77: e2 studio Debugger Configurations window with Blinky project

3. Click Debug to begin debugging the application.

4. Extracting RA Debug.

Progress Information m] X

Extracting RA Debug

Configuring GDB

2.3.6.3 Details about the Debug Process
In debug mode, e2 studio executes the following tasks:

1. Downloading the application image to the microcontroller and programming the image to
the internal flash memory.

. Setting a breakpoint at main().

. Setting the stack pointer register to the stack.

. Loading the program counter register with the address of the reset vector.

. Displaying the startup code where the program counter points to.

ubhWwWwN
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Program Counter

{8% [Blinky] RA Configgfation L€l hal_entry.c Lg startup.c 2

@ * MCU starts executing here out of re

void Reset Handler (void)

L
/* Initialize system using BSP. */
SystemInit();

/* Call user application. */
main();

while (1)
1

Figure 78: e2 studio Debugger memory window

2.3.7 Run the Blinky Project

While in Debug mode, click Run > Resume or click on the Play icon twice.

L U

Figure 79: e2 studio Debugger Play icon

The LEDs on the board marked LED1, LED2, and LED3 should now be blinking.

2.4 Tutorial: Using HAL Drivers - Programming the WDT

2.4.1 Application WDT

This tutorial illustrates the creation of a simple application that uses the Watchdog Timer module to
monitor program operation. The tutorial shows each step in the development process and in
particular identifies the auto-generated files and project structure created when using FSP and its
GUI based configurator. The level of detail provided here is more than is normally needed during
development but can be helpful in explaining how FSP works behind the scenes to simplify your
work.

This application makes use of the following FSP modules:

e MCU Board Support Package
e Watchdog Timer (r_wdt)
e |/O Ports (r_ioport)

2.4.2 Creating a WDT Application Using the RA MCU FSP and e2 studio

2.4.2.1 Using the FSP and e2 studio

The Flexible Software Package (FSP) from Renesas provides a complete driver library for developing
RA MCU applications. The FSP provides Hardware Abstraction Layer (HAL) drivers, Board Support
Package (BSP) drivers for the developer to use to create applications. The FSP is integrated into
Renesas e2 studio based on eclipse providing build (editor, compiler and linker) and debug phases
with an extended GNU Debug (GDB) interface.

2.4.2.2 The WDT Application
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The flowchart for the WDT application is shown below.

Program start

BSP initializes
clocks, pins etc

Tum on red
LED for 125 ms
Feed WDT

Tum off red
LED for 125 ms

Feed WDT

==307
Yes

Tum on green
LED for 250 ms
‘WDT counts
without refresh
Tum off green
LED for 250 ms
Underflow

( WOT resets MCU )
Figure 80: WDT Application flow diagram

Initialize and
start WDT

2.4.2.3 WDT Application flow
The main sections of the WDT application are:

1. The BSP initializes the clocks, pins and other elements of the MCU readying the application
to run.

2. main() calls hal_entry(). The function hal_entry() is created by the FSP with a placeholder for
user code. The code for the WDT is added to this function.

3. Initialize the WDT, but do not start it.

4. Start the WDT by refreshing it.

5. In the first loop the red LED flashes 30 times and refreshes the watchdog each time the LED
state is changed.

6. In the second loop, the green LED flashes, but the program DOES NOT refresh the
watchdog. After the watchdog timeout period the device will reset which can be observed
by the red LED flashing again as the sequence repeats.

2.4.3 Creating the Project with e2 studio

Start e2 studio and choose a workspace folder in the Workspace Launcher. Configure a new RA MCU
project as follows.

1. Select File > New > RA C/C++ Project. Then select the template for the project.

File Edit Navigate Search Project RenesasViews Run Window Help

New Alt+ShiftsN > [¢] C/C++ Project | | &~
§ = ;
Open File.. - ijej Create a new C or C++ project h
2 Open Projects from File System... ™ Example.
Recent files > 79 Other.. culeN Jguration
Close crl+w |
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Q New C/C++ Project O X

Templates for New C/C++ Project

All Renesas RA C/C+ + Project

CMake =™ Create an executable or static library C/C++ project for Renesas RA.
Make

Renesas Debug
Renesas RA
Renesas RZ

Figure 81: Creating a new project

2. In the e2 studio Project Configuration (RA Project) window enter a project name, for
example, WDT_Application. In addition, select the toolchain. If you want to choose new
locations for the project unselect Use default location. Click Next.

e studio - Project Configuration (RA C Executable Project) O x
e2 studio - Project Configuration (RA C Executable Project) —
Specify the new project details,

Project Toolchains

Project name | WDT_Application GNU ARM Embedded

Use default location

C\Users\Austin.Hansen\e2_studio\workspace deme| | Browse...
default

@ < Back Next > Finish Cancel

Figure 82: Project configuration (part 1)

3. This application runs on the EK-RA6M3 board. So, for the Board select EK-RA6M3.
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This will automatically populate the Device drop-down with the correct device used on this

board. Select the Toolchain version. Select J-Link ARM as the Debugger. Click Next to
configure the project.

& Renesas RA C/C++ Project

O bt
Renesas RA C/C++ Project
Device and Tools Selection
Device Selection
FSP Version: Board Description
Board: EK-RAG6M3 ~
Device: RTFABM3AH3CFC
Language: @ C OC++
Device Details
TrustZone No
Pins 176
Processor cortex-m4
Toolchains Debugger
GNU ARM Embedded J-Link ARM »
» W
@ < Back Finish Cancel

Figure 83: Project configuration (part 2)

The project template is now selected. As no RTOS is required select Bare Metal - Blinky.
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Q Renesas RA C/C++ Project O X

Renesas RA C/C++ Project p—

Project Template Selection

Project Template Selection

@/ ¢ | Bare Metal - Blinky
Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks,
and the C runtime environment.

“’| /4 | Bare Metal - Minimal
Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

Code Generation Settings
Use Renesas Code Formatter

'/?3' < Back Next > Cancel

Figure 84: Project configuration (part 3)

4. Click Finish.

e2 studio creates the project and opens the Project Explorer and Project Configuration
Settings views with the Summary page showing a summary of the project configuration.

2.4.4 Configuring the Project with e2 studio

e2 studio simplifies and accelerates the project configuration process by providing a GUI interface for
selecting the options to configure the project.

e2 studio offers a selection of perspectives presenting different windows to the user depending on
the operation in progress. The default perspectives are C/C++, FSP Configuration and Debug. The
perspective can be changed by selecting a new one from the buttons at the top right.

| B C/C++ ¢ FSP Configuration % Debug

Figure 85: Selecting a perspective

The C/C++ perspective provides a layout selected for code editing. The FSP Configuration
perspective provides elements for configuring a RA MCU project, and the Debug perspective
provides a view suited for debugging.

1. In order to configure the project settings ensure the FSP Configuration perspective is
selected.
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2. Ensure the Project Configuration [WDT Application] is open. It is already open if the
Summary information is visible. To open the Project Configuration now or at any time make
sure the RA Configuration perspective is selected and double-click on the
configuration.xml file in the Project Explorer pane on the right side of e2 studio.

[y Project Explorer &3 E "'3‘,| » =~ = 0O
LI Blinky
~ L2 WDT_Application [Debug]
[ Includes
v (B
= arm
(z= board
& fsp
2 ra_gen
v [ sic
[ hal_entry.c
= ra_cfg
45t configurationam|
|Z] R7FABM3AHICFC pincfg
=| RABM3-EK.pincfg
=| WDT_Application Debug.launch
(7) Developer Assistance

Figure 86: RA MCU Project Configuration Settings

At the base of the Project Configuration view there are several tabs for configuring the project. A
project may require changes to some or all of these tabs. The tabs are shown below.

5 [WDT _Application] FSP Configuration 52 = B8
Summary ner -,0 nter
Generate Project Content
Project Summary ~
RENESAS

Board: EK-RABM3

Device: R7FABM3AH3CFC

Toolchain: GCC ARM Embedded

Toolchain Version:

FSP Version:

Selected software components

Arm CMSIS Version 5 - Care (M)

RABM3-EK Board Support Files

Simple application that blinks an LED. No RTOS included.
Board support package for RTFAGM3AH3CFC

Board support package for RABIM3

Board support package for RABM3 - FSP Data

Board Support Package Common Files

1/Q Port

=EO

Summary | BSP| Clocks| Pins| Interrupts | Event Links| Stacks| Components

Figure 87: Project Configuration Tabs

2.4.4.1 BSP Tab

The BSP tab allows the Board Support Package (BSP) options to be modified from their defaults. For
this particular WDT project no changes are required. However, if you want to use the WDT in auto-
start mode, you can configure the settings of the OFS0 (Option Function Select Register 0) register in
the BSP tab. See the RA Hardware User's Manual for details on the WDT autostart mode.

2.4.4.2 Clocks Tab
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The Clocks tab presents a graphical view of the clock tree of the device. The drop-down boxes in the
GUI enables configuration of the various clocks. The WDT uses PCLCKB. The default output frequency
for this clock is 60 MHz. Ensure this clock is outputting this value.

i [WDT_Application] FSP Configuration 2 =g
[¥)

Clocks Configuration Generate Project Content

EZ Restore Defaults

| XTAL 24MHz }\L > ICLK Div /2 ] ICLK 120MHz \
PLL Src: XTAL v | > PCLKA Div /2 v | PCLKA 120MHz \
|
PLL Div /2 v > PCLKB Div /4 || PCLKB 60MHz \
b
PLL Mul x20.0 v > PCLKC Div /4 | PCLKC 60MHz \
\ USBMCLK 24MHz | | PLL 240MHz }—> Clock Src: PLL « 45 pCLKD Div /2 v —>| PCLKD 120MHz \
HOCO 20MHz v SDCLKout On || sDCLKout 120MHz \
f
| LOCO 32768Hz | k> BCLK Div /2 ~ [/ BCLK 120MHz \
}
\ MOCO 8MHz | BCLK/2 v —>| BCLKout 60MHz \
| SUBCLK 32768Hz | = UCLK Div /5 || uCLK 48z \
‘> FCLK Div /4 w || FCLK 60MHz \
CLKOUT Disabled | CLKOUT Div /1 v ] CLKOUT 0Kz \

Summary |BSP | Clocks Pins| Interrupts | Event Links | Stacks| Components

Figure 88: Clock configuration

2.4.4.3 Interrupts Tab

The Interrupts tab is used to add new user events or interrupts. No new interrupts or events are
needed by the application, so no edits in this tab are required.

2.4.4.4 Event Links Tab

The Event Links tab is used to configure events used by the Event Link Controller (ELC). This
project doesn't use the ELC, so no edits in this tab are required.

2.4.4.5 Pins Tab

The Pins tab provides a graphical tool for configuring the functionality of the pins of the device. For
the WDT project no pin configuration is required. Although the project uses two LEDs connected to
pins on the device, these pins are pre-configured as output GPIO pins by the BSP.

2.4.4.6 Stacks Tab
You can add any driver to the project using the Stacks tab. The HAL driver 10 port pins are added

automatically by e2 studio when the project is configured. The WDT application uses no RTOS
Resources, so you only need to add the HAL WDT driver.
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i [WDT_Application] FSP Configuration 2

Stacks Configuration

Threads

~ £ HAL/Comman
+ g_lopo

Objects

ort Driver on r_ioport

Summary |BSP | Clocks | Pins |Interrupts | Event Links | Stacks| Components

Figure 89: Stacks tab

HAL/Common Stacks

& g_ioport I/0 Port
Driver on r_ioport

@

= =
o

Generate Project Content

| New Stack >

1. Click on the HAL/Common Panel in the Threads Window as indicated in the figure above.

The Stacks Panel becomes a HAL/Common Stacks panel and is populated with the
modules preselected by e2 studio.

N

i [WDT_Application] FSP Configuration &2

Stacks Configuration

Threads
~ & HAL/Common

4 g_ioport /O Port Driver on r_ioport

Objects

HAL/Common Stacks

. Click on New Stack to find a pop-up window with the available HAL level drivers.
3. Select WATCHDOG Driver on r_wdt.

= O 5lPackage EXCR A Ra7R4
[>)

Generate Project Content

&1 New Stack >
Arm

4 g_ioport I/0 Port
Driver on r_ioport

@

Driver
FreeRTOS
FreeRTOS +
Middleware

Summary |BSP | Clocks | Pins | Interrupts | Event Links | Stacks| Components

Figure 90: Module Selection

RTOS
SEGGER

A Search.

vov v v v e

I

Analog >
CapTouch >
Connectivity > | p400 1

i P401 2
Graphics > | paoz 5
Input > | P403 s
Monitoring > 4 CRCDriveronr_crc
Network > @ Clock Accuracy Circuit Driver on r_cac
Power » & Data Operation Circuit Driver on r_doc
Storage & Watchdog Driver onr iwdt

] 4 Watchdog Driver on r_wdt

System

PBO1
VBAT
VCL
XCIN

vranT

- TS C k=
Timers > | p70s o
Transfer > | P77 215

PBOO0 |16

The selected HAL WDT driver is added to the HAL/Common Stacks Panel and the Property
Window shows all configuration options for the selected module. The Property tab for the WDT

should be visible at the bottom left of the screen.

Configuration perspective is selected.

If it is not visible, check that the FSP
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& “[\WDT_Application] FSP Configuration = "
[¥]

Stacks Configuration Generate Project Content

Threads %] Remove = ] New Stack »
g_wdt0 Watchdog Driver on r_wdt Stacks

~ & HAL/Comman
4 g_ioport I/O Port Driver on r_ioport

& g_wdt0 Watchdog Driver on r_wdt @ g_wdtﬂ Watchdog
Driver on r_wdt

@
Objects
| Summary FSP Clocks |Pins | Interrupts | Event Links | Stacks| Components

[ Properties 2 Problems 5 Browse

g_wdt0 Watchdog Driver on r_wdt

Settings Property Value

APlinfo | | Common
Parameter Checking Default (BSP)
Register Start NMI Support Disabled

v Module g_wdt0 Watchdog Driver on r_wdt

Name g_wdt0
Timeout 16,384 Cycles
Clock Division Ratio PCLK/8192
‘Window Start Position 100% (Window Position Not Specified)
Window End Position 0% (Window Position Not Specified)
Reset Control Reset Output
Stop Control WDT Count Disabled in Low Power Mode
KIMAL Pl M

Figure 91: Module Properties

All parameters can be left with their default values.

[34 Pin Conflicts =# MCU Package [Z) Console | [T Properties 7 | 4% Debug

g wdt0 Watchdog Driver on r wdt

Settings Property Value

w Common
Parameter Checking Default (BSP)
Register Start NM| Support Disabled

v Module g_wdtd Watchdog Driver on r_wdt
Mame g_wdth
Timeout 16,384 Cycles
Clock Division Ratio PCLK/81532
Window Start Position 100% (Window Position Mot Specified)
Window End Position 0% (Window Position Mot Specified)
Reset Control Reset Qutput
Stop Control 'WOT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 92: g wdt WATCHDOG Driver on WDT properties

With PCLKB running at 60 MHz the WDT will reset the device 2.23 seconds after the last refresh.

WDT clock = 60 MHz / 8192 = 7.32 kHz
Cycle time =1/ 7.324 kHz = 136.53 us
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Timeout = 136.53 us x 16384 = 2.23 seconds

Save the Project Configuration file and click the Generate Project Content button in the top
right corner of the Project Configuration pane.

& [WDT_Application] FSP Canfiguration &£ =

m]
Stacks Configuration e
9 Generate Project Content
Threads = HAL/Common Stacks 4] New Stack >
i¥ HAL/Common = -
Ve e U_ [t 1/0 Port Dri . " L4 g_ioport I/O Port @ g_wdt0 Watchdog
g foport /O Po rlv-er onr_lopo Driver on r_ioport Driver on r_wdt
# g_wdt0 Watchdog Driver on r_wdt
©) ©)

Objects

Summary | BSP | Clocks | Pins |Interrupts | Event Links Stacks Components

Figure 93: Generate Project Content button

e2 studio generates the project files.

2.4.4.7 Components Tab

The components tab is included for reference to see which modules are included in the project.
Modules are selected automatically in the Components view after they are added in the Stacks Tab.

For the WDT project ensure that the following modules are selected:

1. HAL Drivers -> r_ioport
2. HAL_Drivers -> r_wdt
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Note

2.4.5 WDT Generated Project Files

& [WDT_Application] FSP Configuration 2

Components Configuration

Component Version
@ rcu
[ r_jic_master
[T riic_slave
r_ioport
O r_iwdt
v jpeg
[ r_kint
O ripm
T r vd
O r opamp
O r_ospi
O r_pde
O r_poeg
O r_gspi
[T rrte
[T r_sce_ra?
[ r_sce_rad
[T r sce rab
O r_sce9_rab_plaintext
[T r_sce9_ra6_wrapped
[T r_sci_i2c
O r_sci_spi
[T r_sci_uart
[T r_sdadc
[ r_sdhi
[T r_sledc
O r_spi
O r_ssi
[T r_usb_basic
[7] r_usb_hedc
[ r_usb_hhid
[T r_usb_hmsc
2 r_usb_pcde
O r_usb_phid
O r_usb_pmsc
r_wdt
O rm_psa_crypto
[T rm_wifi_onchip_silex
% Heaps
% Libraries

swummary | BSP |Clocks Pins | Interrupts Event Links |Stacks Components

[

Generate Project Contt

~ || Search.

Description Variant

Filter |All

External Interrupt

12C Master Interface

12C Slave Interface

1/0 Port

Independent Watchdog Timer

JPEG Codec

Key Input

Low Power Modes

Low Voltage Detection

Operational Amplifier

Octa Serial Peripheral Interface Flash

Parallel Data Capture

Port Output Enable for GPT

Quad Serial Peripheral Interface Flash

Real Time Clock

Secure Cryptography Engine on RA2

Secure Cryptography Engine on RA4

Secure Cryptography Engine on RAS

Secure Cryptography Engine9 on RAG6 Plaintext
Secure Cryptography Engine9 on RA6 Wrapped
SCII2C Master Interface

Serial Peripheral Interface on Serial Communications Interf...
SCI UART

Sigma Delta A/D Converter

SD/MMC Host Interface

Segment LCD Controller/Driver

Serial Peripheral Interface

Serial Sound Interface

USB Basic

USB Host Communications Device Class

USB Host Human Interface Device Class

USB Host Mass Storage Class

USB Peripheral Communications Device Class
USB Peripheral Human Interface Device Class
USB Peripheral Mass Storage Class
Watchdog Timer

MbedCrypto H/W Acceleration

WiFi Onchip Silex

Figure 94: Component Selection

Thelist of modules displayed in the Components tab depends on the installed FSP version.

Clicking the Generate Project Content button performs the following tasks.

e r_wdt folder and WDT driver contents created at:

ra/fsp/src
e r_wdt_api.h created in:

ra/fsp/inc/api
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e r_wdt.h created in:
ra/fsp/inc/instances
The above files are the standard files for the WDT HAL module. They contain no specific project
contents. They are the driver files for the WDT. Further information on the contents of these files can
be found in the documentation for the WDT HAL module.
Configuration information for the WDT HAL module in the WDT project is found in:

ra_cfg/fsp_cfg/r_wdt_cfg.h

The above file's contents are based upon the Common settings in the g_wdt WATCHDOG Driver
on WDT Properties pane.

[ Properties 54 | [2] Problems @ Smart Browser

g wdt0 Watchdog Driver on r_wdt

Settings  Froperty T {5} [WDT_Application] RA Configuration | [B] r_wdt_cfgh 52
APlinia | ~ Common . 1 |* generated configuration header file - de not edit */
Parameter Checking Default (BSP) kel BT Cre
Register Start NMI Suppart Disabled \ #define R_WDT_CFG_H_
~ Module g_wdtd Watchdog Driver on r_wdt #define WDT_CFG_PARAM CHECKING ENABLE (BSP_CFG_PARAM CHECKING ENABLE)
Name g_wdtD » #def?ne .\‘JDT_Cfg
Timeout 16,284 Cycles g endirlz sk DRIcke
Clock Division Ratie PCLK/8192
Window Start Pasition 100% (Window Position Not Specified]
Window End Pasition 0% (Window Position Not Specified)
Reset Control Reset Output
Stap Control WDT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 95: r_wdt cfg.h contents

Warning
Do not edit any of these files as they are recreated every time the Generate Project Content
button is clicked and so any changes will be overwritten.

The r_ioport folder is not created at ra/fsp/src as this module is required by the BSP and so already
exists. It is included in the WDT project in order to include the correct header file in
ra_gen/hal_data.c-see later in this document for further details. For the same reason the other
IOPORT header files- ra/fsp/inc/api/r_ioport_api.handra/fsp/inc/instances/r_ioport.h-are not created as
they already exist.

In addition to generating the HAL driver files for the WDT and IOPORT files e2 studio also generates
files containing configuration data for the WDT and a file where user code can safely be added.
These files are shown below.
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2.4.5.1 WDT hal_data.h

~

Figure 96: WDT project files

(=5 WDT Application [Debug]

5wl Includes
v B ra
> [z am
» [ board
> (= fsp
> 5 ra_gen
v [ src
» @ hal_entry.c
> (= Debug
v [= ra_cfg
v (= fsp_cfg
> = bsp
[€ riopert_cfg.h
(€ r_wdt_cfg.h
> [ script
45 configuration.xml
R7FABM3AH3CFC pincfg
ra_cfg.bet
RABM3-EK.pincfg
WDT_Application Debug.launch
5 (7) Developer Assistance

The contents of hal_data.h are shown below.
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hal_data.h contains the header files required by the generated project. In addition this file includes
external references to the g_wdtO0 instance structure which contains pointers to the configuration,
control, api structures used for WDT HAL driver.

Warning
This file is regenerated each time Generate Project Content is clicked and must not be
edited.

2.4.5.2 WDT hal_data.c

The contents of hal_data.c are shown below.
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hal_data.c contains g_wdtO_ctrl which is the control structure for this instance of the WDT HAL
driver. This structure should not be initialized as this is done by the driver when it is opened.

The contents of g wdt0_cfg are populated in this file using the Watchdog Driver on g wdt0 pane
in the Project Configuration Stacks tab. If the contents of this structure do not reflect the settings
made in the IDE, ensure the Project Configuration settings are saved before clicking the
Generate Project Content button.

Warning
This file is regenerated each time Generate Project Content is clicked and so should not be
edited.

2.4.5.3 WDT main.c

Contains main() called by the BSP start-up code. main() calls hal_entry() which contains user
developed code (see next file). Here are the contents of main.c.
/* generated nmain source file - do not edit*/
#i ncl ude "hal data. h"
int main (void)
{
hal entry();

return O;

Warning
This file is regenerated each time Generate Project Content is clicked and so should not be
edited.

2.4.5.4 WDT hal_entry.c

This file contains the function hal_entry() called from main(). User developed code should be placed
in this file and function.

For the WDT project edit the contents of this file to contain the code below. This code implements
the flowchart in overview section of this document.

#i ncl ude "hal data.h"

#i ncl ude "bsp_pin_cfg.h"

#i nclude "r_ioport.h"

#defi ne RED LED NO OF FLASHES 30

#define RED LED PIN BSP_| O PORT_01_PI N_00

#defi ne GREEN_LED PI N BSP_| O PORT_04_PI N_00

#def i ne RED_LED DELAY MS 125
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The WDT HAL driver API functions are defined in r_ wdt.h. The WDT HAL driver is opened through the
open API call using the instance structure defined in r_wdt_api.h:
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/* Open the WDT */
R WDT_Open(&g_wdtO_ctrl, & wdtO cfg);

The first passed parameter is the pointer to the control structure g wdtO_ctrl instantiated in
hal_data.c. The second parameter is the pointer to the configuration data g wdto_cfg instantiated in
the same hal_data.c file.

The WDT is started and refreshed through the API call:

/* Start the WDT by refreshing it */
R WDOT _Refresh(&g_wdtO_ctrl);

Again the first (and only in this case) parameter passed to this API is the pointer to the control
structure of this instance of the driver.

2.4.6 Building and Testing the Project

Build the project in e2 studio by clicking Build > Build Project or by clicking the build icon. The
project should build without errors.

To debug the project

1. Connect the USB cable between the target board debug port and host PC.
2. In the Project Explorer pane on the left side of e2 studio, right-click on the WDT project
WDT_Application and select Debug As > Debug Configurations.

3. Under Renesas GDB Hardware Debugging select WDT_Application Debug as shown
below.
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Debug Configurations

x
Create, manage, and run configurations . “%‘
IR Name: [ WDT_Application Debug |
type filter text [E] Main %% Debugger| = Startup| ] Common £ Source
=
[&] C/C++ Application Project:
[c] C/C++ Remote Application
EASE Script ‘ WOT_Application Browse...
[£] GDB Hardware Debugging C/C++ Application:
[t] GDB OpenOCD Debugging
Debug/WDT_Application.elf
[ GDB Simulator Debugging (RH850) | Debug/WET_Applicetion
Java Applet Variables... Search Project... Browse...
Java Application Build (if required) before launching
@ Launch Group
= Launch Group (Deprecated) Build Configuration: |Use Active e
Remote Java Application
i E Renesas GDB Hardware Debugging (O Enable auto build (C) Disable aute build
[ WDT_Application Debug (®) Use workspace settings Configure Workspace Settings...
[£7] Renesas Simulator Debugging (RX, RL72)
< >
Revert Apply
Filter matched 14 of 16 items -
@

Figure 97: Debug configuration

4. Click the Debug button. Click Yes to the debug perspective if asked.

Progress Information m] X

Extracting RA Debug

Configuring GDB

Details > >

Cancel

5. The code should run the Reset_Handler() function.

6. Resume execution via Run > Resume. Execution will stop in main() at the call to
hal_entry().
7. Resume execution again.

The red LED should start flashing. After 30 flashes the green LED will start flashing and the red LED
will stop flashing.

While the green LED is flashing the WDT will underflow and reset the device resulting in the red LED
to flash again as the sequence repeats.

1. Stop the debugger in e2 studio via Run > Terminate.
2. Click the reset button on the target board. The LEDs begin flashing.

2.5 Primer: ARM® TrustZone® Project Development

This section will introduce the user to the tools supporting ARM® TrustZone® configuration for the
RA Family of microcontrollers. It is intended to be read by development engineers implementing RA
ARM® TrustZone® projects for the first time. It will introduce basic concepts followed by workflow
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and tooling functions designed to simplify and accelerate their first ARM® TrustZone® development.
A background knowledge of e? studio and RA device hardware is expected.

Target Device

RA Cortex®-M33 or Cortex®-M23 devices with ARM® TrustZone® security extension.

2.5.1 Renesas Implementation of ARM® TrustZone® Technology
For brevity, ARM® TrustZone® will be abbreviated to TZ in this document.

The following section is supplied for reference only. For full details of TZ implementation, refer to
Arm documentation (https://developer.arm.com/ip-products/security-ip/trustzone) and the RA6M4
device manual.

Arm TZ technology divides the MCU and therefore the application into Secure and Non-Secure
partitions. Secure applications can access both Secure and Non-Secure memory and resources. Non-
Secure code can access Non-Secure memory and resources as well as Secure resources through a
set of so-called veneers located in the Non-Secure Callable (NSC) region. This ensures a single
access point for Secure code when called from the Non-Secure partition. The MCU starts up in the
Secure partition by default. The security state of the CPU can be either Secure or Non-Secure.

The MCU code flash, data flash, and SRAM are divided into Secure (S) and Non-Secure (NS) regions.
Code flash and SRAM include a further region known as Non-Secure Callable (NSC). These memory
security attributes are set into the non-volatile memory via SCI or USB boot mode commands when
the device lifecycle is Secure Software Debug (SSD) state. The memory security attributes are
loaded into the Implementation Defined Attribution Unit (IDAU) peripheral and the memory controller
before application execution and cannot be updated by application code.

Code Flash Data Flash

Non-Secure

Non-Secure

Non-Secure

Non-Secure callable Non-Secure callable

Secure

Secure Secure

0x0000_0000 0x0800_0000 0x2000_0000

Figure 98: Secure and Non-Secure Regions

Note: All external memory accesses are considered to be Non-Secure.

Code Flash and SRAM can be divided into Secure, Non-Secure, and Non-Secure Callable. All secure
memory accesses from the Non-Secure region MUST go through the Non-Secure Callable gateway
and target a specific Secure Gateway (SG) assembler instruction. This forces access to Secure APIs
at a fixed location and prevents calls to sub-functions and so on. Failing to target an SG instruction
will generate a TZ exception.
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TZ enabled compilers will manage generation of the NSC veneer automatically using CMSE
extensions.

2.5.1.1 Calling from Non-Secure to Secure

A new instruction SG (Secure Gateway) has been added to the Armv8-M architecture. This MUST be
the destination instruction for any branch within the Non-Secure Callable region. If an attempt is
made to branch to any other instruction from the Non-Secure partition, a TZ exception will be
thrown.

Non Secure Non Secure Callable Secure
NSC
Func_A_Entry
Func_A_Entry SG, Valid entry Func_A
I -’; BFUNC_A  cp ...; FUNCtiON
BXNS LR

Figure 99: Calling from Non-Secure to Secure Functions

2.5.1.2 Calling from Secure to Non-Secure

Secure code uses B(L)XNS instructions to make direct calls to Non-Secure functions. While this is
certainly possible, it can create a security vulnerability in the application. It is also challenging for
the Secure application to determine the address of the non-secure function during build phase. From
the RA Tools and FSP point view, calling directly from Secure to Non-Secure via FSP API is not
supported.

Preference is for the Secure code to initialise as necessary from reset, then pass control to the Non-

Secure partition. It will manage any data transfers and so forth via FSP call-backs as security checks.
For example, secure data can be copied to Non-Secure RAM.

Non Secure Secure

BLXNS RO

t

\_

Figure 100: Calling from Secure to Non-Secure Functions

2.5.2 Workflow

ARM® TrustZone® MCU development normally consists of two projects within a workspace, Secure
and Non-Secure. General project workflows are described in the following sections. The Renesas
project generator also supports development with "Flat project" model with no ARM® TrustZone®
awareness.

2.5.2.1 Secure Project

1. Start a new Secure project in e? studio.
2. Select and configure pins and drivers/stacks that need to be initialized and used in Secure
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mode. This should be kept to a minimum to reduce the security attack surface.

3. Expose top of stacks as Non-Secure Callable (NSC) if they need to be accessed from Non-
Secure partition. Again, this should be kept to a minimum.

4. Generate project content and write Secure code such as key handling and opening drives as

needed.

. Modify/remove any unnecessary "Guard" functions as needed to control access via NSC.

. Build project.

7. A Non-Secure project will be needed before debugging. If necessary, prepare a "dummy"
Non-Secure project or replace R_BSP_NonSecureEnter(); with while(1); in hal_entry.c.

o U

2.5.2.2 Non-Secure Project

=

. Start a new Non-Secure project.

2. If you have access to the Secure project, choose this option. However, if you only have
access to a device with pre-programmed Secure code (commonly referred to as provisioned
device) choose "Secure Bundle".

3. Select and configure pins and drivers/stacks that need to be initialized and used in Non-

Secure mode.

. Note that you can add NSC drivers and stacks as needed.

. Generate project content and write Non-Secure code as needed

. Access NSC drivers and Stacks via Guard functions.

. Build and debug project.

<o u b

2.5.2.3 Flat Project

A flat project does not technically use ARM® TrustZone® as the developer has made a decision to
place the entire application in Secure partition from restart.

Notes:

e Any code placed in external memory (such as OSPI or QSPI) will be Non-Secure.
e The Ethernet EDMAC is designed to be a Non-Secure bus master so associated Ethernet
RAM buffers will be placed in Non-Secure RAM. The tooling will automatically manage this.

The workflow is as follows:

1. Start a new Flat project.

2. Select and configure pins and drivers/stacks as needed.
3. Generate project content and write code as needed.

4. Build and debug project.

2.5.3 RA Project Generator (PG)

The RA project generators have been created to help users through setting up new TZ enabled
projects. User will be prompted for project settings such as Project Type (Secure, Non-Secure, or
Flat), compiler, RTOS and debugger. Care is needed when setting up a TZ project to ensure that the
connection between Secure and Non-Secure partitions are managed correctly.
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Figure 101: Secure Project (following Arm notation as green)

Figure 102: Non-Secure Project (following Arm notation as red)

ﬁ Renesas RA C/C++ Project

Renesas RA C/C++ Project
Project Type Selection

Project Type Selection

) Flat (Non-TrustZone) Project

* Renesas RA device project without TrustZone
separation

* All code, data and peripheral settings will be
configured in this project

* Renesas RA device will remain in secure mode

* EDMAC RAM buffers will automatically be placed
in non-secure RAM

(@) TrustZone Secure Project

® Renesas RA device project for TrustZone secure
execution

* All code, data and peripherals placed in this project
will be initialized as secure

® Secure project settings such as TrustZone
partitions, linker maps and a list of secure
peripherals will be passed to a selected non-secure
project

& After initialization, a call to the non-secure startup
handler will be made

(O TrustZone Non-secure Project

& Renesas RA device project for TrustZone non-
secure execution

& All code, data and peripherals placed in this project
will be initialized as non-secure

& Must be associated with a secure project or secure
bundle

& Mon-secure startup handler will be called after
secure code initialization

< Back

Finish

Cancel

9 Renesas RA C/C++ Project

Renesas RA C/C++ Project
Project Type Selection

Project Type Selection

() Flat (Non-TrustZone) Project

® Renesas RA device project without TrustZone
separation

® All code, data and peripheral settings will be
configured in this project

* Renesas RA device will remain in secure mode

® EDMAC RAM buffers will automatically be placed
in non-secure RAM

(O TrustZone Secure Project

* Renesas RA device project for TrustZone secure
execution

* All code, data and peripherals placed in this project
will be initialized as secure

* Secure project settings such as TrustZone
partitions, linker maps and a list of secure
peripherals will be passed to a selected non-secure
project

= After initialization, a call to the non-secure startup
handler will be made

(@ TrustZone Non-secure Project

* Renesas RA device project for TrustZone non-
secure execution

* All code, data and peripherals placed in this project
will be initialized as non-secure

* Must be associated with a secure project or secure
bundle

* Non-secure startup handler will be called after
secure code initialization

< Back

Finish

Cancel
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&) Renesas RA C/C++ Project u] X

Renesas RA C/C++ Project —
Project Type Selection

Project Type Selection

®) Flat (Non-TrustZone) Project

& Renesas RA device project without TrustZone
separation

& All code, data and peripheral settings will be
cenfigured in this project

® Renesas RA device will remain in secure mode

& EDMAC RAM buffers will automatically be placed
in non-secure RAM

(O TrustZone Secure Project

* Renesas RA device project for TrustZone secure
execution

* All code, data and peripherals placed in this project
will be initialized as secure

* Secure project settings such as TrustZone
partitions, linker maps and a list of secure
peripherals will be passed to a selected non-secure
project

® After initialization, a call to the non-secure startup
handler will be made

() TrustZone Non-secure Project

® Renesas RA device project for TrustZone non-
secure execution

* All code, data and peripherals placed in this project
will be initialized as non-secure

® Must be associated with a secure project or secure
bundle

® Mon-secure startup handler will be called after
secure code initialization

@ <Back |[ Nedt» izt Cancel

Figure 103: Flat Project

2.5.3.1 Secure Project Set Up

All code, data, and peripherals in this project will be configured as Secure using the device Peripheral
Security Attribution (PSA) registers. Although it is very application specific, we recommend keeping
the Secure project code as small as possible to reduce the attack surface. For example, secure key
handling may be the only application code in the secure project.

Necessary values to set up the TZ memory partition (IDAU registers) will be automatically calculated
after the project is built to ensure they match the code and data size, keeping the attack surface as
small as possible.

Typically, ANSI C start up code (clearing of RAM, variable initialisation, etc) , clock, and secure
peripheral initialisation will occur in this project.

At the end of the Secure code, a call will be made to R_BSP_NonSecureEnter(); to pass control to the
Non-Secure partition.

Non-Secure Callable (NSC) "Guard" functions are added to the project and expose selected modules
to Non-Secure projects. User can add application-specific access checks as needed in these
functions.

Output of this project type will be an elf file that must be either pre-programmed (provisioned) into a
device or referenced by a Non-Secure project (via Secure bundle *.SBD) to build a final image.

This project type will NOT typically be debugged in isolation and will normally require a Non-Secure
project such as a call to a R_BSP_NonSecureEnter() to be made. This can be replaced with while(1); if
needed.
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2.5.3.2 RTOS Support in TZ Project

Although the RTOS kernel and user tasks will reside in the Non-Secure partition, the Secure partition
needs to allocate stack space and so on. It is essential when starting a new RTOS project that the
TrustZone Secure RTOS-Minimal template is selected. This will add the Arm TrustZone Context RA
Port as below.

(B Renesas RA C/C++ Project m} x

Renesas RA C/C++ Project

Project Template Selection

Project Template Selection

Ol _i." Bare Metal - Blinky

Q Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins,
stacks, and the C runtime environment.

Of _.." Bare Metal - Minimal

Q Bare metal FSP project that includes BSP, This project will initialize clocks, pins, stacks, and the C runtime
envirenment.

®[" 2" TrustZone Secure RTOS - Minimal

C} Empty TrustZone Secure project with RTOS context functions. This will support any RTOS as long as the RTOS
uses the CMSIS TrustZone Context Management API. Only select this when creating an RA TrustZone Secure
Project. This project will initialize the MCU using the BSP.

Code Generation Settings
Use Renesas Code Formatter

)
(2]

HAL/Common Stacks %] New Stack >
4% g ioport /0 Port 4% ARM TrustZone
Driver on r_ioport Context RA Port
® ®

Figure 104: Secure RTOS-Minimal Template

2.5.3.3 Peripheral Security Attribution

Each peripheral can be configured to be Secure or Non-Secure. Peripherals are divided into two
types.

Type-1 peripherals have one security attribute. Access to all registers is controlled by one security
attribute. The Type-1 peripheral security attribute is set in the PSARX (x = B to E) register by the
secure application.

Type-2 peripherals have the security attribute for each register or for each bit. Access to each
register or bit field is controlled according to these security attributes. The Type-2 peripheral security
attribute is set in the Security Attribution register in each module by the Secure application. For
more information about the Security Attribution register, see sections in the Appropriate MCU’s
User’s Manual for each peripheral.
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Table 1. Secure and Non-Secure Peripherals

Type Peripheral

Type 1 SCI, SPI, USBFS, CAN, IIC, SCE9, DOC, SDHI,
SSIE, CTSU, CRC, CAC, TSN, ADC12, DAC12,
POEG, AGT, GPT, RTC, IWDT, WDT

Type 2 System control (Resets, LVD, Clock Generation
Circuit, Low Power Modes, Battery Backup
Function), FLASH CACHE, SRAM controller, CPU
CACHE, DMAC, DTC, ICU, MPU, BUS, Security
setting, ELC, I/O ports

Always Non-Secure CS Area Controller, QSPI, OSPI, ETHERC, EDMAC

FSP will initialise the arbitration registers during Secure project BSP start up. User code may also be
written to set or clear further arbitration. However care must be taken not to undermine FSP.

2.5.3.4 Non-Secure

All code, data, and peripherals in this project will be configured as Non-Secure. This project type
must be associated with a Secure project to enable access to secure code, peripherals, linker scripts
and others.

2.5.3.5 Flat Project Type

All code, data, and peripherals are configured in a Secure single partition except for the EDMAC RAM
buffers that will remain in the Non-Secure partition. Effectively, TZ is disabled.

2.5.3.6 Secure Connection to Non-Secure Project
When starting a new Non-Secure Project, the user will be prompted for either a Secure Project or
Secure Bundle. In each case, details of the linker settings, Non-Secure Callable functions, and Secure

peripherals will be read to enable the Non-Secure project setup.

Should the Secure project or bundle be rebuilt, the Non-Secure editor will detect this and prompt
user to regenerate the Non-Secure project configuration.

@ Renesas RA C/Co » Project o *

Renesas RA C/C- + Project —_—

Exsting Secure Progect of Bundie Selection

Secure Progect  New P
® Secure Bundle | CADev_work\RA_projecti\ TZ_video! Hew_PG_Secure\Debug\New_PG_Sec

Secure Project/Bundle Details

Z < Back Hext > Cancel

Figure 105: Secure Project or Bundle Selection

Secure Project (Combined)
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A Secure project must reside in the same Workspace as the Non-Secure project and will typically be
used when a design engineer has access to both the Secure and Non-Secure project sources. This is
sometimes known as "Combined model".

A Secure .elf file will be referenced and included in the debug configuration for download to the
target device. The development engineer will have visibility of Secure and Non-Secure project source
code and configuration.

Secure Bundle (Split)

A Secure Bundle will ONLY include linker memory ranges, symbol references, and details of locked
Secure peripheral configuration settings but no access to Secure source code (APl header files will be
included as necessary).

The Secure bundle file (*.SBD) must be supplied to the Non-Secure developer by the Secure project
developer.

The development engineer will typically not have access to the Secure project or .elf file which MUST
be pre-programmed or provisioned into the target MCU.

The DLM state of target device should then be switched to NSECSD (see section 6.2) before the
device is provided to the non-secure developer.

This is often referred to as "Split model" where a basic security set up is developed by a Secure team
and then passed to the Non-Secure team in the same facility or at a third party. The Non-Secure
team has no access to the Secure source code and cannot directly access Secure peripherals, data,
or APIs.

2.5.3.7 Debug Configurations

After each project type has been selected, a suitable debug configuration will be generated.
Non-Secure with Secure Project (Combined)

Both Secure and Non-Secure .elf files will be downloaded.

A debug configuration called <project name>_SSD will be generated.

Non-Secure with Secure Bundle (Split)

Only a Non-Secure elf will be downloaded. This configuration must be used with a pre-provisioned
device (Secure project pre-programmed into MCU Flash).

A debug configuration called <project name>_NSECSD will be generated.
Flat Debug

A single .elf file will be downloaded.

A debug configuration called <project name>_FLAT will be generated.
2.5.4 Secure Projects

As mentioned, Secure code will be called immediately after device reset and run ANSI C start up,
clock, interrupt vector table, and secure peripheral initialization before starting user code. All
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selected peripheral configuration settings will be automatically initialised as Secure.

2.5.4.1 Secure Clock

Device clock settings are the possible exception in that they will be initialised in the Secure project
(to enable faster start up from reset) but can be set as Secure or Non-Secure as user application may
need to change settings during execution (for low-power mode and so on). The Secure and Non-
Secure FSP BSPs can both change the clock settings.

However, clock settings can be locked as Secure should the developer choose to do so.

[m] X
=
V]
Generate Project Content
:=,' Restore Defaults
Div /1 Sets the clock circuit to be secure (override disabled)
KA Div /2 v — PCLKA 100MHz \

Figure 106: Secure Clock Setting

2.5.4.2 Setting Drivers as NSC

Some driver and middleware stacks in the Secure project may need to be accessed by the Non-
Secure partition. To enable generation of NSC veneers, set "Non-Secure Callable" from the right-click
context menu for the selected modules in the Configurator.

Note: It is only possible to "expose" top of stacks as NSC.

4% g_uartD UART Driver on r_sci_uart
G
@ Team >

G- Add DTC Driver for
Transmission

Resource Configurations >

=
al R: ] Validate

[Recommended but
optional]

re of  Cut Ctrl+X
5 Copy Ctrl+C

Paste Ctrl+V

3 Drtete Delete
+  Non-secure Callable

TpOIL...

Y Export.
(@) Module Resources...

Q@ PRunhs
45 DebugAs
Profile As
b 4 Compare With
aminated 21 May 2020, 13:38:46) Replace With

D

'{-ﬁ Secure_g_timer)
g
. |Timer Driver on r_gpt

—<l Mon-secure callable L—

Figure 107: Generate NSC Veneers

The top of the stack will be marked with a new icon and tool tip to signify NSC access.
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2.5.4.3 Guard Functions

Access to NSC drivers from a Non-Secure project is possible through the Guard APIls. FSP will
automatically generate Guard functions for all the top of stack/driver APls added to the project as
Non-Secure Callable.

User can choose to add further levels of access control or delete guard function if they wish to only
expose a limited range of APIs to a Non-Secure developer.
BSP_CVSE_NONSECURE_ENTRY fsp_err _t g _uart0_open_guar d(
uart _ctrl _t *const p_api _ctrl, uart _cfg t const *const p _cfg) {

/* TODO add your own security checks here */

FSP_PARAMVETER NOT_USED(p_api _ctrl);

FSP_PARAMVETER NOT_USED(p_cfQ);

return R SCl _UART Open(&g_uartO ctrl, & uart0_cfq);

For example, an SCI channel may be opened and configured for a desired baud rate by the Secure
developer, but only enable the Write API to the Non-Secure developer. In which case, all but
g_uart0_write_guard() could be deleted. CTRL structures are not required as they will be added on
the Secure side.

For example, the call from the Non-Secure partition would be as follows:

err = g_uart0_open_guard(0, 0);

2.5.5 Non-Secure projects

Configuration of the project can continue as for other RA devices, but certain resources will be locked
if they have been previously set up as Secure.

The Non-Secure project will be called from the Secure project via R_ BSP_NonSecureEnter();
2.5.5.1 Clock Set Up

You may recall that clocks can be set as Secure or Non-Secure. If they are set as Secure, settings will
only be available to view, and user will not be able to change them. The Override button will be
greyed. This is useful to preserve CGC sync with secure project by not overriding unless necessary. If
it is NOT set as Secure, user can choose to override the initial Secure settings
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=0
(V)

demerage Project Content

& Override i
] A
e

Figure 108: Clock Setting as Non-Secure

o

Generate Project Content

MHz | 2

00MHz

[OMHz |

Figure 109: Clock Setting as Secure

2.5.5.2 Selecting NSC Drivers

Drivers declared as NSC in a Secure project can be selected and added to Non-Secure project and
will be decorated as before.

%} g_uart) UART Driver
on r_sci_uart
)
2 5 a

& NewStack> =

Arm

Driver »

FreeRTOS

FreeRTOS+ »

Middleware »

RTOS >
»

Use Secure " g_uartd UART Driver on _sci_uart
¥ Search.. T T

»
>
H
.

Figure 110: Selecting NSC Drivers

2.5.5.3 Locked Resources

When a NSC Secure driver is added to a Non-Secure project, the configuration settings are locked
and are available for information only. A padlock is added for indication.
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(] Properties £
D_uano UART Driver on r_sci_uart
Settings  Property
~ Commen
Parameter Checking
FIFO Support
DIC Suppornt
RS232/R5485 Flow Control Support
~ Module g_uartd UART Driver on r_sci_uant
General
Baud
Flow Contral
Extra

Interrupts

Value

Defaule (BSP)
Disable
Disable
Disable

Figure 111: Locked Resources

2.5.5.4 Locked Channels

In a peripheral with multiple channels, for example, DMA, if a Non-Secure developer tries to select a
channel that has already been defined as Secure, the following error message type will be displayed.

& | New Stack > =

GENETaTE FTOJECT COMTEnT

rt g{v g_transfer) Transfer
ort Driver on r_dmac No
ELC Trigger |
A stack element with a bar of this color indicates 'g_tra
This instance may be referenced by one other module
k:rcr: Peripheral 'DMA_DMACD' is secure l

Figure 112: Error Message when Selecting a Secure Channel

2.5.6 IDAU registers

Renesas RA TZ-enabled devices include a set of registers known as Implementation Defined
Attribution Unit (IDAU) that are used to set up partitions between Secure, Non-Secure Callable, and
Non-Secure regions. The IDAU registers can only be programmed during MCU boot mode and NOT
through the debug interfaces. Because of this, special debugger firmware has been developed to
manage bringing the device up in SCI boot mode to set up the IDAU registers (automatically drives

MD pin) and then switch back to debug mode as needed.

Note: Please be aware of the extra signal connection (MD pin) needed on the debug interface

connector. The Renesas Evaluation Kit (EK) for your selected device is a good reference.
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Pin No. SWD JTAG Serial Programming using
SCI

1 vCce vCcC vcce

2 P108/SWDIO P108/TMS NC

4 P300/SWCLK P300/TCK P201/MD
Wired OR with MD Wired OR with MD

6 P109/SWO/TXD9 P109/TDO/TXDY P109/TXD9

8 P110/RXD9 P110/TDI/RXD9 P110/RXD9

9 GNDdetect GNDdetect GNDdetect

10 nRESET nRESET nRESET

12 P214/TRACECLK P214/TRACECLK NC

14 P211/TRACEDATA[0] P211/TRACEDATA[0] NC

16 P210/TRACEDATA[1] P210/TRACEDATA[1] NC

18 P209/TRACEDATAJ2] P209/TRACEDATA[2] NC

20 P208/TRACEDATA[3] P208/TRACEDATA[3] NC

3,5,15.17, GND GND GND

19

7 NC NC NC

11,13 NC NC NC

The e? studio build phase automatically extracts the IDAU partition register settings from the Secure
.elf file and programs them into the device during debug connection, which can be observed in the

console,.

This is an important phase of TZ development as the Secure partitions should be set as small as
possible to ensure that the security attack surface is as small as possible.

However, should the developer wish to make these partitions larger to accommodate, for example

during field firmware updates, const or data arrays should be placed in the Secure project as

needed.

@ Console 57 | [2] Problems [l Debugger Console (@ Smart Brows:
New_PC_Non_Secure Debug_SSD [Renesas GDB Hardware Debugging]

Starting server with the following options:

Raw options : C:\Users\b38ea28e\
Connecting to E2, ARM target

GDBServer endian : little

Target power : on

Starting target connection

Current status of the RA TrustZone device
DLM state : 55D
Debug level 1 2
IDAU memory regions

Code Flash Secure size (kB) : 8
Code Flash NSC size (kB) : 24
Data Flash Secure size (kB) -]
SRAM Secure size (kB) )
SRAM NSC size (kB) H -1

Figure 113: RA TrustZone Device Current Status

It is also possible to manually set up the partition registers through the Renesas Device Partition

Manager.
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2.5.6.1 SCI Boot Mode

Example of MD mode pin connection to debugger connector (from EK schematic).

ws  Run  Window Help

re d| Renesas Device Partition Manager n 0

= ] Tracex >
[E) Tracealyzer >

Device Family: :Reneus RA v:

Action

[JRead current device i [J Change device lifecycle management state

[ 5et TrustZene secure / non-secure beundaries | (] Intialize device back te factory default

Target MCU connection: | J-Link v
Serial Mot
Debugger supply voltage (V: 0

Baud rate:

DLM state to change to: SSD - Secure Software Development ~

Memery partitien sizes
Code Flash Secure (KB)
Code Flash NSC (KB):

Data Flash Secure (KB):

SRAM Secure (KB):

o [m][a][es] [
1

SRAM NSC (KB):

Command line tool

@ Import Export Close

Figure 114: Renesas Device Partition Manager

'Z|\_‘5
TTTTTAG T 1 ell TTAG'SWDIO
i ITAG i 3 E) TTAGSWCLE
| GNDDETECT | TACTED
! . TIAGTD)
E30,
| Tumper Trace Cut | . ®
_________________
]
1 bl
PSTDATAS  TDATAZ
POSTDATAY TOATA2
P2LOTDATAL TDATAL
PAUUTDATAD  TDATAD
PIUSTCLE TOLK
ne
PLIOTDI oI 1 2
3 )
PLOYTDO ToO(/SwWo) [ 5 [
] ]
PIOY/SWDIO ™S
NRPNOSIPAEN-RC
PIOSWCLE Tex
1
P2OLMD 1 2
I

Figure 115: Example of MD Mode Pin Connection to Debugger Connector (from EK schematic

2.5.6.2 DLM States

Device lifecycle defines the current phase of the device and controls the capabilities of the debug

interface, the serial programming interface and Renesas test mode. The following illustration shows
the lifecycle definitions and capability in each lifecycle.
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—

/ - - - - -
N Y N Ty
—>{ NsecsD —»  DPL
4 S N

LCK DBG

S

S

N
I »/ RMAREQ +—»

N N

— Transition without authentication
——p Transition with authentication

--— —p All erase

Figure 116: Lifecycle Stages

N
o/

Note: All authentication key exchange and transitioning to LCK_DBG, LCK_BOOT, RMA_REQ is only
managed by Renesas Flash Programmer (RFP) and NOT within e? studio.

Lifecycle Definition Debug level Serial programming Test mode
& “Chip Manufacturing” _— Available, cannot access Not available
The state when the customer received the device. code/data flash
Available
“Secure Software Development” .
SSD The secure part of application is being developad DBG2 can program/erase/read all |Not available
1 .
P PP e P code/data flash area
“Non-SECure Software Development” Available
NSECSD The non-secure part of application is being DBG1 can program/erase/read all |Not available
developed. code/data flash area
“DePLoyed” Available )
DPL T DBGO cannot access code/data flash | Not available
The device is in-field.
area
“LoCKed DeBuG” Available
LCK_DBG . ) . DBGO cannot access code/data flash | Not available
- The debug interface is permanently disabled. area
“LoCKed BOOT interface”
LCK_BOOT The debug interface and the serial DBGO Not available Not available
programming interface are permanently disabled.
“Return Material Authorization REQuest” Available
RMA_REQ| Requestfor RMA. The customer must send the DBGO cannot access code/data flash | Not available
device to Renesas in this state. area
. —_— Available
“Return Material Authorization ACKnowledged” N
RMA_ACK R L DBG2 cannot access code/data flash| Available
Failure analysis in Renesas area

Figure 117: Lifecycle Stages and Debug Levels

There are three debug access levels. The debug access level changes according to the lifecycle

state.

e DBG2: The debugger connection is allowed, and no restriction to access memories and

peripherals
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* DBG1: The debugger connection is allowed, and restricted to access only Non-Secure
memory regions and peripherals
e DBGO: The debugger connection is not allowed

Transitions for one state to another can be performed using the Renesas Flash Programmer (RFP,
see section below) or using the Renesas Device Partition Manager (limited number of states
possible). It is possible to secure transitions between states using authentication keys. For more
information on DLM states and transitions (device specific), please refer to device user manual.

2.5.7 Debug

By default, the device will be in SSD mode and so allow access to Secure and Non-Secure partitions.
In this mode both Secure and Non-Secure .elf files will be downloaded.

The current debugger status is displayed in the lower left corner and includes the DLM state (SSD or

NSECSD) and current partition (Secure, Non-Secure, or Non-Secure Callable) when the debugger is
stopped, for example.

Figure 118: Current Debugger Status

2.5.7.1 Non-Secure Debug

Once the device is transitioned to NSECSD mode, only Non-Secure Flash, RAM and Peripherals can
be accessed. In this mode, a Secure .elf must be pre-programmed (provisioned) into the device, and
only a Non-Secure .elf file will be downloaded.

In NSECSD mode, it is not possible to set breakpoints on Secure code or data.

It is not possible to step into Secure code; the debugger will perform a step-over of any Secure
function calls. Should the user press the Suspend button during execution, the debugger will stop at
the next Non-Secure code access.

Assuming Secure memory region finishes at 32K (0x8000) in NSECSD debug mode (colour coding
added for indication only), memory will be displayed as shown in the following figure.

0x8000 : 0xB000 <Hex Integer> &3 . g New Renderings...

Address e -3 4 -7 8-8 C-F
2220000020007 FER 22222272
B000000000007FFE 23 ?¢
[ULEEEREEEEEEEEEY 286002498
2002000020008010 o000898
Be00e0eRRRRoasR2e
QRA6AARARRGARAZA

Figure 119: Memory Display in NSECSD Debug Mode
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Disassembly will be displayed as shown in the following figure.

=" Disassembly &3 0x8000
Cannot access memory
eeee7ffd: Failed to execute
-data-disassemble -

rror

s memor
execute
embl. 5 32766 -e 32798 -- 3
ge from debugger back end:
Cannot access memor address ex7ffe
easa7fff: Failed to M

11 command:
s 32767 -e 32799 -- 3
Error message from debugger back end:
Cannot access memory at address @x7ffe

Tmovs 4, #152 ; ex9s

e (]

ldrh i, [r7, #12]
movs @, ro

ldrh  r5, [ra, #a]

Figure 120: Disassembly Display in NSECSD Debug Mode

2.5.8 Debugger support
Renesas E2, E2 Lite, and SEGGER J-Link are supported in e? studio for TZ projects.

Debugger Support for TZ Projects

Feature E2 Lite E2 J-Link J-Link OB ULINK IAR i-Jet
JTAG Yes Yes Yes No Yes Yes
SWD Yes Yes Yes Yes Yes Yes
ETB trace Yes Yes Yes Yes Yes Yes
ETM trace No Yes Yes No Yes Yes
TZ partition |Yes Yes Yes Yes No No
programmin
9
Non secure |Yes Yes Yes Yes Yes Yes
debug
e? studio Yes Yes Yes Yes No TBC
IAR EW Arm | Under Under Yes Yes No Yes

consideratio | consideratio
n n
Keil MDK Under Under Yes Yes Yes No
consideratio | consideratio
n n

2.5.9 Third-Party IDEs

Third-party IDEs such as IAR Systems EWARM and Keil MDK (uVision) are supported by the RA Smart
Configurator (RA SC).

In general, RA SC offers the same configurator functionality as e studio documented above. Project
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generators are available to initialise workspaces in the target IDEs as well as setting up debug
configurations and so forth. However, there are some limitations that need to be noted especially
with regards to IDAU TZ partition register programming. See the specific RA SC documentation for
usage details.

2.5.10 Renesas Flash Programmer (RFP)

Updated versions of Renesas Flash Programmer (RFP) are available to support setting of partitions,
DLM state and Authentication keys.

RFP can be downloaded free of charge on the Renesas web site.

A new mode has been added to Program Flash Options as shown in the following graphics.

1 Renesas Fiash Progeamenes ELOTAN-RA (Preliminaey Versiee) - x
File  Devicelnformation  Help
Opersion [pwranon Se0ngn | Bock Setngs Fash Ootiors  Cornedt Settngs Usaue Code User Kes
Command Erase Qptions
[ s Erase Selected Bocks

O oo Prograe & Verfy Options
fecy ] Erome o Program

TR
O Creckpam

) Cde Flash ¢ Uses Boct e Setrgn
[ Deta Fash [ e ssdeas check of program fhe

[EREE p—

Figure 121: RFP Program Flash Options

Options to set partition boundaries are shown in the following figure.

&
Eie  Devceinformation  Help
Opersticn  Dperation Setirga  Bck Setinga Flash ORons  Correct Setinga  Liicuss Code User Kaya

~ DIM
Set Option Do Nothng

Figure 122: RFP Partition Boundaries

Options to set DLM state, Authentication keys, and Security settings are shown in the following
figure.
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Opeatin_Opraion Setings_[Bock Setings R Optes_ Connecs Semngs Uue Code Use Hers

Do Nething

Figure 123: RFP DLM State, Authentication Keys, and Security Settings

Great care is needed here as some DLM states can **permanently** turn off debug and boot mode
on the devices. Equally programming a security access authentication key can lead to permanently
locked devices if the key is lost.

2.5.11 Glossary

IDAU

Implementation Defined Attribute Unit. Used to program TZ partitions in SCI book mode.
NSECSD

Non-Secure Software Development mode

SSD

Secure Software Development mode

NSC

Non-Secure Callable. Special Secure memory region used for Veneer to allow access to Secure APIs
from Non-Secure code.

Provisioned
Device with Secure code pre-programmed and DLM state set to NSECSD
Flat project

All code, data and peripherals are configured as secure with the exception of the EDMAC RAM buffer
which are placed in Non-Secure RAM due to the configuration of the internal bus masters.

Veneer

Code that resides in Non-Secure Callable region

Combined model

Development engineer has access to both Secure and Non-Secure project and source code

Split model
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Development Engineer has access to only the Non-Secure partition. No visibility of Secure source
code. Secure code will be provisioned into device.

2.5.11.1 Configurator Icon Glossary

— :
Non Secure % Secure_g_timerD
Callable 5 Timer Driver on r_gpt
1+t
Link to FSP
documentation

& g_adc0 ADC Driver on

Standard r adc

driver
®

Figure 124: Configurator Icons

2.6 RA SC User Guide for MDK and IAR

2.6.1 What is RA SC?

The Renesas RA Smart Configurator (RA SC) is a desktop application designed to configure device
hardware such as clock set up and pin assignment as well as initialization of FSP software
components for a Renesas RA microcontroller project when using a 3rd-party IDE and toolchain.

The RA Smart Configurator can currently be used with

1. Keil MDK and the Arm compiler toolchain.
2. IAR EWARM with IAR toolchain for Arm

Projects can be configured and the project content generated in the same way as in e2 studio.
Please refer to Configuring a Project section for more details.

2.6.2 Using RA Smart Configurator with Keil MDK

2.6.2.1 Prerequisites

e Keil MDK and Arm compiler are installed and licensed. Please refer to the RASC Release
notes for the version to be installed.

e Import the RA device pack. Download the RA device pack archive file (ex:
MDK_Device_Packs_2.x.x.zip) from the FSP GitHub release page. Extract the archive file to
locate the RA device pack. To import the RA device pack, launch the Packinstaller.exe from
<keil_mdk_install_dir>\UV4. Select the menu item File > Import... and browse to the
extracted .pack file.

e Verify that the latest updates for RA devices are included in Keil MDK. To verify, select the
menu "Packs" in Pack Installer and verify that the menu item Check for Updates on
Launch is selected. If not, select Check for Updates on Launch and relaunch Pack
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Installer.
e For flashing and debugging, the latest Segger J-Link DLL is installed into Keil MDK.

e Install RA SC and FSP using the Platform Installer from the GitHub release page.

2.6.2.2 Create new RA project

The following steps are required to create an RA project using Keil MDK, RA SC and FSP:

1. Start the RA Smart Configurator.

2. Enter a project folder and project name.

6 New Renesas RA FSP Project m] X

Mew Renesas RA F5P Project

Project Name and Location

Project name

Mew_MDK_Project

Lecation: | c:\MyProjectPath] Browse...

< Back Next = Finish Cancel

Figure 125: RA SC project settings

3. Select the target device and IDE.

S New Renesas RA FSP Project m] X
New Renesas RA FSP Project
Device and Tools Selection
Device Selection
FSP Version: ) Board Description
Evaluation kit for RAGMA MCU Group
Hoauk 2 HES ~| Visit https://www.renesas.com/ra/ek-ra6md to get kit user's
Device: RTFAEMAAFICFR mar.'|ual, quick start guide, errata, design package, example
projects, etc.
Languages @ C (OC++
Device Details
TrustZone Yes
Pins 144
Processor cortex-m33
IDE Project Type
IAR EWARM Version 8 ~
IAR EWARM Version 8
Keil MDK Version 5
~
< Back Mest » Finish Cancel

Figure 126: Target device and IDE selection

4. The rest of the project generator and FSP configuration is the same as e2 studio. Please
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refer to the previous sections for details.
5. On completion of the FSP configuration, press "Generate Project Content"

6. A new Keil MDK project file will be generated in the project path. Double click this file to
open MDK and continue development as usual.

Project 2 B
= “% Project: RTFABM3AH3CFC -
= % Target1
(d Source Group 1
-I-iF Renesas RA Smart Configurator:Common Sources
-] blinky_thread_entry.c
[ _1 hal_entry.c
5 4P Flex Software
@ ] event_groups.c (Components:ra)
+ _1 list.c (Components:ra)
+ j queue.c (Components:ra)

=] stream_buffer.c (Components:ra)

[+ _1 tasks.c (Components:ra)
4] timers.c (Components:ra)

-] board_init.c (Componentsira)
A, a4 e P

Figure 127: uVision project workspace with imported project data

2.6.2.3 Modify existing RA project

Once an initial project has been generated and configured, it is also possible to make changes using
RA SC as follows.

Note
This setup only needs to be done once per project.

Set up the following links to RA SC:

1. In Keil MDK uVision, select Tools > Customize Tools Menu....
2. Select the new icon and fill in the fields as follows for each tool:
a. RA Smart Configurator:
= Menu item name: Enter: RA Smart Configurator
= Command: Select "..." and navigate to rasc.exe
= |nitial Folder: Enter: $P
= Arguments: Enter: --device $D --compiler ARMv6 configuration.xml
b. Device Partition Manager:
= Menu item name: Enter: Device Partition Manager
= Command: Select "..." and navigate to rasc.exe
= |nitial Folder: Enter: $P
= Arguments: Enter: -application
com.renesas.cdt.ddsc.dpm.ui.dpmapplication configuration.xml "SL%L"

To reconfigure an existing project select Tools > RA Smart Configurator
To reconfigure the TrustZone partitions select Tools > Device Partition Manager

2.6.2.4 Build and Debug RA project
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The project can be built by selecting the menu item Project > Build Target or tool bar item

Rebuild or the keyboard shortcut F7.

Assembler, Compiler, Linker and Debugger settings can be changed in Options for Target dialog,
which can be launched using the menu item Project > Options for Target, the tool bar item
Options for Target or the keyboard shortcut Alt+F7.

KA Options for Target 'Target 1'

Device | Target | Output | Listing | User | C/C++(ACB) | Asm | Linker Debug ILlliIitiesl

" Use Simulator ~ with restrictions

[ Limit Speed to Real-Time

Settings

V¥ Load Application at Startup ¥ Run to main()

Initialization File:

| ol e |

Restore Debug Session Settings

[V Breakpoints ¥ Toolbox

¥ Watch Windows & Perfformance Analyzer
v System Viewer

[v Memory Display

@ Use: [J-LINK / J-TRACE Cortex

¥ Load Application at Startup
Initialization File:

™ Runto main()

Restore Debug Session Settings
[V Breakpoints ¥ Toolbox
v Watch Windows
[v Memory Display

[v System Viewer

Ll Settings

ol e |

CPU DLL: Parameter: Driver DLL: Parameter:
[SARMCM3.DLL | [SARMCM3.DLL |

Dialog DLL: Parameter: Dialog DLL: Parameter:
[pcm.DLL [pCM4 [TcM.DLL [oCM4

[~ Wam if outdated Executable is loaded

[~ Wam if outdated Executable is loaded

Manage Component Viewer Description Files ... |

| oK

Cancel

| | Defaurs |

Figure 128: Options for Target

RA SC will set up the uVision project to debug the selected device using J-Link or J-Link OB debugger

by default.

A Debug session can be started or stopped by selecting the menu item Debug > Start/Stop Debug
Session or keyboard shortcut CTRL+F5. When debugging for the first time, J-Link firmware update

may be needed if requested by the tool.

Refer to the documentation from Keil to get more information on the debug features in uVision. Note
that not all features supported by uVision debugger are implemented in the J-Link interface. Consult

SEGGER J-Link documentation for more information.

2.6.2.5 Notes and Restrictions

1. When debugging a TrustZone based project, the Secure project image MUST be
downloaded before the Non Secure project.

2. For TrustZone enabled devices, the user will need to manually set up the memory partitions
using the "Renesas Device Partition Manager" from inside RA SC before downloading.
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E RA Smart Configurator
Help  Run

8% [te Renesas Device Partition Manager

Board Support Package Configuration

Figure 129: Renesas Device partition Manager

3. RA FSP contains a full set of drivers and middleware and may not be compatible with other
CMSIS packs from Keil, Arm or third parties.
4. Flash programming is currently only supported through the debugger connection.

2.6.3 Using RA Smart Configurator with IAR EWARM

IAR Systems Embedded Workbench for Arm (EWARM) includes support for Renesas RA devices.
These can be set up as bare metal designs within EWARM. However, most RA developers will want to
integrate RA FSP drivers and middleware into their designs. RA SC will facilitate this.

RA SC generates a "Project Connection" file that can be loaded directly into EWARM to update
project files.

2.6.3.1 Prerequisites
* |AR EWARM installed and licensed. Pleae refer to the Release notes for the version to be
installed.
e RA SC and FSP Installed
2.6.3.2 Create new RA project
The following steps are required to create an RA project using IAR EWARM, RA SC and FSP:

1. Start the RA Smart Configurator.

2. Enter a project folder and project name.

FE Mew Renesas RA FSP Project O x

New Renesas RA FSP Project

Project Name and Location

Project name

Mew_IAR_Project

Location: | c:\MyProjectPath Browse...

< Bacl Next > Finish Cancel

Figure 130: RA SC project settings

3. Select the target device and IDE.
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G New Renesas RA FSP Project m] X

MNew Renesas RA FSP Project

Device and Tools Selection

Device Selection
Board Description
Evaluation kit for RAGMA MCU Group

Visit https://www.renesas.comj/ra/ek-rabmd4 to get kit user's
manual, quick start guide, errata, design package, example
projects, etc.

FSP Version: |2.1.0 ~

Board: EK-RAGNM4 v

Device: R7FABMAAF3CFB

Language: @ C (O C++
Device Details

TrustZone Yes
Pins 144
Processor cortex-m33
IDE Project Type
IAR EWARM Version 8 v
Toolchains
IAR Toolchain for ARM
<Back [ Neds Einish Cancel

Figure 131: Target device and IDE selection

4. The rest of the project generator and FSP configuration operates the same as e2 studio.
Refer to the previous sections for details.

5. On completion of the FSP configuration, press Generate Project Content.

6. A new IAR EWARM project file will be generated in the project path. Double click this file to
open IAR EWARM and continue development as usual.

7. To Use RA SC with EWARM, RA SC needs to configured as a tool in EWARM by selecting the
menu item Tools > Configure Tools.... Select New to create a new tool in the dialog
shown and add the following information:

o Menu Text: RA Smart Configurator
a. Command: Select Browse... and navigate to rasc.exe in the installed RA
SC
b. Argument: -compiler IAR configuration.xml
C. Initial Directory: $PROJ_DIR$
d. Tool Available: Always
o Menu Text: Device Partition Manager
a. Command: Select Browse... and navigate to rasc.exe in the installed RA
SC
b. Argument: -application com.renesas.cdt.ddsc.dpm.ui.dpmapplication
configuration.xml "$TARGET _PATH$"
C. Initial Directory: $PROJ_DIR$
d. Tool Available: Always

8. RA SC can now be re-launched from EWARM using the menu item Tools > RA Smart
Configurator.

9. A Project connection needs to be set up in EWARM to build the project. Select Project >
Add Project Connection in EWARM and select IAR Project Connection. Navigate to the
project folder and select buildinfo.ipcf and click Open. The project can now build in EWARM.

2.6.3.3 Notes and Restrictions
When starting a TrustZone enabled debug session Partition sizes are checked automatically.

e If partition sizes are set correctly, the debug session will launch as normal.
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* [f partition sizes need to be changed, IAR EWARM will prompt to run the Renesas Device
Partition Manager. Select Yes. The Device Partition Manager will start with the required
partition sizes prefilled.

e Select Set TrustZone secure / non-secure boundaries as the only action.

e Enter debugger details, if required.

e Select Run to program the partitions.

e Return to the IDE and relaunch the debug session
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Chapter 3 FSP Architecture

3.1 FSP Architecture Overview

This guide describes the Renesas Flexible Software Package (FSP) architecture and how to use the
FSP Application Programming Interface (API).

3.1.1 C99 Use
The FSP uses the ISO/IEC 9899:1999 (C99) C programming language standard. Specific features

introduced in C99 that are used include standard integer types (stdint.h), booleans (stdbool.h),
designated initializers, and the ability to intermingle declarations and code.

3.1.2 Doxygen

Doxygen is the default documentation tool used by FSP. You can find Doxygen comments throughout
the FSP source.

3.1.3 Weak Symbols

Weak symbols are used occasionally in the FSP. They are used to ensure that a project builds even
when the user has not defined an optional function.

3.1.4 Memory Allocation

Dynamic memory allocation through use of the malloc() and free() functions are not used in FSP
modules; all memory required by FSP modules is allocated in the application and passed to the
module in a pointer. Exceptions are considered only for ports of 3rd party code that require dynamic
memory.

3.1.5 FSP Terms

Term Description Reference

BSP Short for Board Support MCU Board Support Package
Package. In the FSP the BSP
provides just enough
foundation to allow other FSP
modules to work together
without issue.
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Module

Modules can be peripheral
drivers, purely software, or
anything in between. Each
module consists of a folder with
source code, documentation,
and anything else that the
customer needs to use the code
effectively. Modules are
independent units, but they
may depend on other modules.
Applications can be built by
combining multiple modules to
provide the user with the
features they need.

FSP Modules

Driver

A driver is a specific kind of
module that directly modifies
registers on the MCU.

Interface

An interface contains API
definitions that can be shared
by modules with similar
features. Interfaces are
definitions only and do not add
to code size.

FSP Interfaces

Stacks

The FSP architecture is
designed such that modules
work together to form a stack.
A stack consists of a top level
module and all its
dependencies.

FSP Stacks

Module Instance

Single and independent
instantiation of a module. An
application may require two
GPT timers. Each of these
timers is a module instance of
the r_gpt module.

Application

Code that is owned and
maintained by the user.
Application code may be based
on sample application code
provided by Renesas, but it is
the responsibility of the user to
maintain as necessary.
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Callback Function

This term refers to a function
that is called when an event
occurs. As an example, suppose
the user would like to be
notified every second based on
the RTC. As part of the RTC
configuration, a callback
function can be supplied that
will be jumped to during each
RTC interrupt. When a single
callback services multiple
events, the arguments contain
the triggering event. Callback
functions for interrupts should
be kept short and handled
carefully because when they
are called the MCU is still inside
of an interrupt, delaying any
pending interrupts.

3.2 FSP Modules

Modules are the core building block of FSP. Modules can do many different things, but all modules
share the basic concept of providing functionality upwards and requiring functionality from below.

*

Provides

Requires

Figure 132: Modules

The amount of functionality provided by a module is determined based on functional use cases.
Common functionality required by multiple modules is often placed into a self-contained submodule
so it can be reused. Code size, speed and complexity are also considered when defining a module.

The simplest FSP application consists of one module with the Board Support Package (BSP) and the

user application on top.
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Application

FSP Module

Figure 133: Module with application

The Board Support Package (BSP) is the foundation for FSP modules, providing functionality to
determine the MCU used as well as configuring clocks, interrupts and pins. For the sake of clarity,
the BSP will be omitted from further diagrams.

3.3 FSP Stacks

When modules are layered atop one another, an FSP stack is formed. The stacking process is
performed by matching what one module provides with what another module requires. For example,
the SPI module (Serial Peripheral Interface (r_spi)) requires a module that provides the transfer
interface (Transfer Interface) to send or receive data without a CPU interrupt. The transfer interface
requirement can be fulfilled by the DTC driver module (Data Transfer Controller (r_dtc)).

Through this methodology the same code can be shared by several modules simultaneously. The
example below illustrates how the same DTC module can be used with SPI (Serial Peripheral
Interface (r_spi)), UART (Serial Communications Interface (SCI) UART (r_sci_uart)) and SDHI (SD/MMC
Host Interface (r_sdhi)).

Application

Provides: SPI Provides: UART Provides: SD/MMC

UART Driver SD Card Driver

Requires: Transfer Requires: Transfer Requires: Transfer

Provides:|Transfer

Figure 134: Stacks -- Shared DTC Module

The ability to stack modules ensures the flexibility of the architecture as a whole. If multiple
modules include the same functionality issues arise when application features must work across
different user designs. To ensure that modules are reusable, any dependent modules must be
capable of being swapped out for other modules that provide the same features. The FSP
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architecture provides this flexibility to swap modules in and out through the use of FSP interfaces.

3.4 FSP Interfaces

At the architecture level, interfaces are the way that modules provide common features. This
commonality allows modules that adhere to the same interface to be used interchangeably.
Interfaces can be thought of as a contract between two modules - the modules agree to work
together using the information that was established in the contract.

On RA hardware there is occasionally an overlap of features between different peripherals. For
example, 12C communications can be achieved through use of the IIC peripheral or the SCI
peripheral. However, there is a difference in the level of features provided by both peripherals; in 12C
mode the SCI peripheral will only support a subset of the capabilities of the fully-featured IIC.

Interfaces aim to provide support for the common features that most users would expect. This
means that some of the advanced features of a peripheral (such as 1IC) might not be available in the
interface. In most cases these features are still available through interface extensions.

In FSP design, interfaces are defined in header files. All interface header files are located in the folder
ra/fsp/inc/api and end with *_api.h. Interface extensions are defined in header files in the folder
ra/fsp/inc/instances. The following sections detail what makes up an interface.

3.4.1 FSP Interface Enumerations

Whenever possible, interfaces use typed enumerations for function parameters and structure
members.

typedef enum e_i 2c_nmst er _addr _node

{
| 2C_ MASTER ADDR MODE 7BIT = 1, /1/< Use 7-bit addressing node

| 2C_MASTER ADDR MODE 10BI T = 2, /1/< Use 10-bit addressi ng node

} i2c_naster_addr_node t;

Enumerations remove uncertainty when deciding what values are available for a parameter. FSP
enumeration options follow a strict naming convention where the name of the type is prefixed on the
available options. Combining the naming convention with the autocomplete feature available in e2
studio (Ctrl + Space) provides the benefits of rapid coding while maintaining high readability.

3.4.2 FSP Interface Callback Functions

Callback functions allow modules to asynchronously alert the user application when an event has
occurred, such as when a byte has been received over a UART channel or an IRQ pin is toggled. FSP
driver modules define and handle the interrupt service routines for RA MCU peripherals to ensure
any required hardware procedures are implemented. The interrupt service routines in FSP modules
then call the user-defined callbacks to allow the application to respond.

Callback functions must be defined in the user application. They always return void and take a
structure for their one parameter. The structure is defined in the interface for the module and is
named <interface>_callback_args_t. The contents of the structure may vary depending on the
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interface, but two members are common: event and p_context.

The event member is an enumeration defined in the interface used by the application to determine
why the callback was called. Using the UART example, the callback could be triggered for many
different reasons, including when a byte is received, all bytes have been transmitted, or a framing
error has occurred. The event member allows the application to determine which of these three
events has occurred and handle it appropriately.

The p_context member is used for providing user-specified data to the callback function. In many
cases a callback function is shared between multiple channels or module instances; when the
callback occurs, the code handling the callback needs context information so that it can determine
which module instance the callback is for. For example, if the callback wanted to make an FSP API
call in the callback, then at a minimum the callback will need a reference to the relevant control
structure. To make this easy, the user can provide a pointer to the control structure as the
p_context. When the callback occurs, the control structure is passed in the p_context element of the
callback structure.

Callback functions are called from within an interrupt service routine. For this reason callback
functions should be kept as short as possible so they do not affect the real time performance of the
user's system. An example skeleton function for the flash interface callback is shown below.

void flash _cal |l back (flash _callback _args_t * p_args)

{

/* See what event caused this call back. */

switch (p_args->event)

{
case FLASH EVENT ERASE COVPLETE:
{
/* Handl e event. */
br eak;
}
case FLASH EVENT WRI TE COVPLETE:
{
/* Handl e event. */
br eak;
}
case FLASH EVENT BLANK:
{
/* Handl e event. */
br eak;
}

case FLASH EVENT_NOT_BLANK:
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When a module is not directly used in the user application (that is, it is not the top layer of the
stack), its callback function will be handled by the module above. For example, if a module requires
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a UART interface module the upper layer module will control and use the UART's callback function. In
this case the user would not need to create a callback function for the UART module in their
application code.

3.4.3 FSP Interface Data Structures

At a minimum, all FSP interfaces include three data structures: a configuration structure, an API
structure, and an instance structure.

3.4.3.1 FSP Interface Configuration Structure

The configuration structure is used for the initial configuration of a module during the
<MODULE>_Open() call. The structure consists of members such as channel number, bitrate, and
operating mode.

The configuration structure is used purely as an input into the module. It may be stored and
referenced by the module, so the configuration structure and anything it references must persist as
long as the module is open.

The configuration structure is allocated for each module instance in files generated by the RA
Configuration editor.

When FSP stacks are used, it is also important to understand that configuration structures only have
members that apply to the current interface. If multiple layers in the same stack define the same
configuration parameters then it becomes difficult to know where to modify the option. For example,
the baud rate for a UART is only defined in the UART module instance. Any modules that use the
UART interface rely on the baud rate being provided in the UART module instance and do not offer it
in their own configuration structures.

3.4.3.2 FSP Interface API Structure

All interfaces include an API structure which contains function pointers for all the supported interface
functions. An example structure for the Digital to Analog Converter (r_dac) is shown below.
typedef struct st _dac_api
{

/[** Initial configuration.

* @ar |nplenmented as

* - @ef R DAC Open()

* - @ef R_DACB_Open()

.

* @aranfin] p_ctrl Pointer to control block. Mist be declared by user. Elenents
set here.

* @araniin] p_cfg Pointer to configuration structure. Al elenents of this
structure nust be set by user.

*/

fsp err t (* open)(dac _ctrl _t * const p ctrl, dac _cfg t const * const p_cfqQ);
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timer.
*/
fsp_err_t (* stop)(dac_ctrl_t * const p_ctrl);

} dac_api t;

The API structure is what allows for modules to easily be swapped in and out for other modules that
are instances of the same interface. Let's look at an example application using the DAC interface
above.

RA MCUs have an internal DAC peripheral. If the DAC API structure in the DAC interface is not used
the application can make calls directly into the module. In the example below the application is
making calls to the R_DAC_Write() function which is provided in the r_dac module.

Application

r_dac
R_DAC_Write()

Figure 135: DAC Write example

Now let's assume that the user needs more DAC channels than are available on the MCU and
decides to add an external DAC module named dac_external using I12C for communications. The
application must now distinguish between the two modules, adding complexity and further
dependencies to the application.

Application

Is External?

r_dac dac_external
R_DAC_Write() DAC_EXTERNAL_Write()

Figure 136: DAC Write with two write modules
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The use of interfaces and the API structure allows for the use of an abstracted DAC. This means that
no extra logic is needed if the user's dac_external module implements the FSP DAC interface, so the
application no longer depends upon hard-coded module function names. Instead the application now
depends on the DAC interface APl which can be implemented by any number of modules.

Application

DAC Interface

e

Internal DAC External DAC 1 External DAC 2

Figure 137: DAC Interface

3.4.3.3 FSP Interface Instance Structure

Every FSP interface also has an instance structure. The instance structure encapsulates everything
required to use the module:

¢ A pointer to the instance API structure (FSP Instance API)
¢ A pointer to the configuration structure
¢ A pointer to the control structure

The instance structure is not required at the application layer. It is used to connect modules to their
dependencies (other than the BSP).

Instance structures have a standardized name of <interface>_instance_t. An example from the
Transfer Interface is shown below.

typedef struct st_transfer_instance

{
transfer_ctrl t * pctrl; ///< Pointer to the control structure for this
i nstance
transfer_cfg_t const * p_cfg; ///< Pointer to the configuration structure

for this instance
transfer_api _t const * p_api; /[l < Pointer to the APl structure for this
i nstance

} transfer_instance t;

Note that when an instance structure variable is declared, the API is the only thing that is instance
specific, not module instance specific. This is because all module instances of the same module
share the same underlying module source code. If SPI is being used on SCI channels 0 and 2 then
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both module instances use the same API while the configuration and control structures are typically
different.

3.5 FSP Instances

While interfaces dictate the features that are provided, instances actually implement those features.
Each instance is tied to a specific interface. Instances use the enumerations, data structures, and API
prototypes from the interface. This allows an application that uses an interface to swap out the
instance when needed.

On RA MCUs some peripherals are used to implement multiple interfaces. In the example below the
IIC and SPI peripherals map to only one interface each while the SCI peripheral implements three
interfaces.

Interface: 12C Interface: UART Interface: SPI
r_i2c_api.h r_uart_api.h r_spi_api.h

Peripheral: IIC Peripheral: SCI Peripheral: SCI Peripheral: SCI Peripheral: SPI
Module: r_riic Module: r sci i2c Module: r_sci_uart Module: r_sci spi Module: r_rspi

Figure 138: Instances

In FSP design, instances consist of the interface extension and API defined in the instance header
file located in the folder ra/fsp/inc/instances and the module source ra/fsp/src/<module>.

3.5.1 FSP Instance Control Structure

The control structure is used as a unique identifier for the module instance and contains memory
required by the module. Elements in the control structure are owned by the module and must not be
modified by the application. The user allocates storage for a control structure, often as a global
variable, then sends a pointer to it into the <MODULE>_Open() call for a module. At this point, the
module initializes the structure as needed. The user must then send in a pointer to the control
structure for all subsequent module calls.

3.5.2 FSP Interface Extensions

In some cases, instances require more information than is provided in the interface. This situation
can occur in the following cases:

¢ An instance offers extra features that are not common to most instances of the interface.
An example of this is the start source selection of the GPT (General PWM Timer (r_gpt)). The
GPT can be configured to start based on hardware events such as a falling edge on a trigger
pin. This feature is not common to all timers, so it is included in the GPT instance.

* An interface must be very generic out of necessity. As an interface becomes more generic,
the number of possible instances increases. An example of an interface that must be
generic is a block media interface that abstracts functions required by a file system.
Possible instances include SD card, SPI Flash, SDRAM, USB, and many more.

The p_extend member provides this extension function.

Use of interface extensions is not always necessary. Some instances do not offer an extension since
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all functionality is provided in the interface. In these cases the p_extend member can be set to NULL.
The documentation for each instance indicates whether an interface extension is available and
whether it is mandatory or optional.

3.5.2.1 FSP Extended Configuration Structure

When extended configuration is required it can be supplied through the p_extend parameter of the
interface configuration structure.

The extended configuration structure is part of the instance, but it is also still considered to be part
of the configuration structure. All usage notes about the configuration structure described in FSP
Interface Configuration Structure apply to the extended configuration structure as well.

The extended configuration structure and all typed structures and enumerations required to define it
make up the interface extension.

3.5.3 FSP Instance API

Each instance includes a constant global variable tying the interface API functions to the functions
provided by the module. The name of this structure is standardized as
g_<interface>_on_<instance>. Examples include g_spi_on_spi, g_transfer_on_dtc, and
g_adc_on_adc. This structure is available to be used through an extern in the instance header file
(r_spi.h, r_dtc.h, and r_adc.h respectively).

3.6 FSP API Standards

3.6.1 FSP Function Names

FSP functions start with the uppercase module name (<MODULE>). All modules have
<MODULE>_Open() and <MODULE>_Close() functions. The <MODULE>_Open() function must be
called before any of the other functions.

Other functions that will commonly be found are <MODULE>_ Read(), <MODULE>_Write(),
<MODULE>_InfoGet(), and <MODULE>_StatusGet(). The <MODULE>_StatusGet() function provides
a status that could change asynchronously, while <MODULE>_InfoGet() provides information that
cannot change after open or can only be updated by API calls. Example function names include:

R_SPI_Read(), R_SPI_Write(), R_SPI_WriteRead()

R_SDHI_StatusGet()

R _RTC _CalendarAlarmSet(), R_RTC_CalendarAlarmGet()

R_FLASH HP_AccessWindowSet(), R_ FLASH HP AccessWindowClear()

3.6.2 Use of const in APl parameters

The const qualifier is used with APl parameters whenever possible. An example case is shown below.

fsp err t R FLASH HP Open(flash ctrl t * const p_api_ctrl, flash cfg t const * const
p_cfg);

In this example, flash_cfg tis a structure of configuration parameters for the r_flash_hp module. The
parameter p_cfg is a pointer to this structure. The first const qualifier on p_cfg ensures the
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flash_cfg_t structure cannot be modified by R_FLASH_HP_Open(). This allows the structure to be
allocated as a const variable and stored in ROM instead of RAM.

The const qualifier after the pointer star for both p_ctrl and p_cfg ensures the FSP function does not
modify the input pointer addresses. While not fool-proof by any means this does provide some extra
checking inside the FSP code to ensure that arguments that should not be altered are treated as
such.

3.6.3 FSP Version Information

The BSP provides a function R_FSP_VersionGet() which fills in a structure of type fsp_pack version _t.
This can be used to determine the FSP version at runtime.

There are also FSP_VERSION_* macros in fsp_version.h that can be used to determine the FSP
version at build time.

3.7 FSP Build Time Configurations

All modules have a build-time configuration header file. Most configuration options are supplied at
run time, though options that are rarely used or apply to all instances of a module may be moved to
build time. The advantage of using a build-time configuration option is to potentially reduce code
size reduction by removing an unused feature.

All modules have a build time option to enable or disable parameter checking for the module. FSP
modules check function arguments for validity when possible, though this feature is disabled by
default to reduce code size. Enabling it can help catch parameter errors during development and
debugging. By default, each module's parameter checking configuration inherits the BSP parameter
checking setting (set on the BSP tab of the RA Configuration editor). Leaving each module's
parameter checking configuration set to Default (BSP) allows parameter checking to be enabled or
disabled globally in all FSP code through the parameter checking setting on the BSP tab.

If an error condition can reasonably be avoided it is only checked in a section of code that can be
disabled by disabling parameter checking. Most FSP APIs can only return FSP_SUCCESS if parameter
checking is disabled. An example of an error that cannot be reasonably avoided is the "bus busy"
error that occurs when another master is using an 12C bus. This type of error can be returned even if
parameter checking is disabled.

3.8 FSP File Structure

The high-level file structure of an FSP project is shown below.

ra_gen
ra
+---fsp
+---inc
| +---api
| \---instances
\---src
+---bsp
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\---r_nodul e

ra cfg

+---fsp_cfg
+- - - bsp
+---driver

Directly underneath the base ra folder the folders are split into the source and include folders.
Include folders are kept separate from the source for easy browsing and easy setup of include paths.

The ra_gen folder contains code generated by the RA Configuration editor. This includes global
variables for the control structure and configuration structure for each module.

The ra_cfg folder is where configuration header files are stored for each module. See FSP Build Time
Configurations for information on what is provided in these header files.

3.9 FSP TrustZone Support

TrustZone support for FSP is primarily handled in the RA Configuration Tool.

3.9.1 FSP TrustZone Projects

During development of a TrustZone project, users create an RA TrustZone Secure Project first,
followed by an RA TrustZone Non-secure Project that is linked to the RA TrustZone Secure Project.
Allocation of secure memory is handled automatically within the tooling. The non-secure project
starts at the required alignment boundary beyond the memory taken by the secure project.

3.9.2 Non-Secure Callable Guard Functions

The tooling generates guard functions for any module marked as Non-secure Callable. These guard
functions are owned by the application once generated, so they can be modified as necessary by the
secure application developer.

The default non-secure callable guard functions limit the configuration and control structure to the

structures generated in the secure project. They also check any input pointers to ensure the caller
does not overwrite secure memory.

3.9.3 Callbacks in Non-Secure from Non-Secure Callable Modules

If the non-secure project needs a callback function from a non-secure callable module, the callback
can be registered after the module is opened using the callback set() guard function.

3.9.4 Additional TrustZone Information

The following resources provide technical background, application notes and example projects that
demonstrate key TrustZone concepts and implementation procedures.

e The Benefits of Using Arm® TrustZone® in Your Design (Brochure)
e RA Arm® TrustZone® Tooling Primer (Application Note)
e Renesas RA Family Security Design with Arm® TrustZone® - IP Protection (Application
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Note)
e Renesas RA Family Securing Data at Rest Using the Arm® TrustZone® (Application Note)

3.10 FSP Architecture in Practice

3.10.1 FSP Connecting Layers

FSP modules are meant to be both reusable and stackable. It is important to remember that modules
are not dependent upon other modules, but upon other interfaces. The user is then free to fulfill the
interface using the instance that best fits their needs.

Interface: X
FSP Module 1
Dependency: /

Interface:
FSP Module 2

Dependency: /

Interface: *
FSP Module 3
Dependency: None

Figure 139: Connecting layers

In the image above interface Y is a dependency of interface X and has its own dependency on
interface Z. Interface X only has a dependency on interface Y. Interface X has no knowledge of
interface Z. This is a requirement for ensuring that layers can easily be swapped out.

3.10.2 Using FSP Modules in an Application

The typical use of an FSP module involves generating required module data then using the API in the
application.

3.10.2.1 Create a Module Instance in the RA Configuration Editor

The RA Configuration editor (available both in the Renesas e2 studio IDE as well as through the
standalone RA Smart Configurator) provides a graphical user interface for setting the parameters of
the interface and instance configuration structures. It also automatically includes those structures
(once they are configured in the GUI) in application-specific header files that can be included in
application code.

The RA Configuration editor allocates storage for the control structures, all required configuration
structures, and the instance structure in generated files in the ra_gen folder. Use the Properties
window to set the values for the members of the configuration structures as needed. Refer to the
Configuration section of the module usage notes for documentation about the configuration options.

If the interface has a callback function option then the application must declare and define the
function. The return value is always of type void and the parameter to the function is a typed
structure of name <interface>_callback_args_t. Once the function has been defined, assign its name
to the p_callback member of the configuration structure. Callback function names can be assigned
through the Properties window for the selected module.
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3.10.2.2 Use the Instance API in the Application

Call the module's <MODULE>_Open() function. Pass pointers to the generated control structure and
configuration structure. The names of these structures are based on the 'Name' field provided in the
configuration editor. The control structure is <Name>_ctrl and the configuration structure is
<Name>_cfg. An example <MODULE>_Open() call for an r_rtc module instance named g_clock is:

R RTC Open(&g _clock ctrl, &g _clock cfg);

Note
Each layer in the FSP Sack is responsible for calling the API functions of its dependencies. This means that users
areonly responsible for calling the API functions at the layer at which they are interfacing. Using the example
above of a SPI module with a DTC dependency, the application uses only SPI APIs. The application starts by
calling R_SPI_Open(). Internally, the SPI module opensthe DTC. It locates R DTC_Open() by accessing the
dependent transfer interface function pointers from the pointers DTC instances (spi_cfg_t::p_transfer_tx and
spi_cfg t::p_transfer_rx) to openthe DTC.

Refer to the module usage notes for example code to help get started with any particular module.
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Chapter 4 APl Reference

This section includes the FSP APl Reference for the Module and Interface level functions.

»BSP Common code shared by FSP drivers

»Modules Modules are the smallest unit of software
available in the FSP. Each module implements
one interface

»Interfaces The FSP interfaces provide APIs for common
functionality. They can be implemented by one
or more modules. Modules can use other
modules as dependencies using this interface
layer

4.1 BSP

Detailed Description
Common code shared by FSP drivers.

Modules

Common Error Codes

MCU Board Support Package

The BSP is responsible for getting the MCU from reset to the user's
application. Before reaching the user's application, the BSP sets up
the stacks, heap, clocks, interrupts, C runtime environment, and
stack monitor.

BSP 1/O access

This module provides basic read/write access to port pins.

Data Structures

union fsp_pack_version_t
struct fsp_pack version_t. _unnamed__

Macros
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#define FSP_VERSION_MAJOR
#define FSP_VERSION_MINOR
#define FSP_VERSION_PATCH
#define  FSP_VERSION_BUILD
#define FSP_VERSION_STRING

#define FSP_VERSION_BUILD_STRING

Data Structure Documentation

¢ fsp_pack_version_t

union fsp_pack_version_t

FSP Pack version structure

Data Fields
uint32 t version_id Version id
struct fsp_pack_version_t __unnamed__ Code version parameters, little
endian order.

¢ fsp_pack_version_t. _unnamed__

struct fsp_pack version_t. _unnamed__

Code version parameters, little endian order.

Data Fields
uint8_t build Build version of FSP Pack.
uint8 t patch Patch version of FSP Pack.
uint8 t minor Minor version of FSP Pack.
uint8 t major Major version of FSP Pack.
Macro Definition Documentation
¢ FSP_VERSION_MAJOR
#define FSP_VERSION_MAJOR
FSP pack major version.
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¢ FSP_VERSION_MINOR
#define FSP_VERSION_MINOR

FSP pack minor version.

¢ FSP_VERSION_PATCH
#define FSP_VERSION_PATCH

FSP pack patch version.

¢ FSP_VERSION_BUILD
#define FSP_VERSION_ BUILD

FSP pack version build number (currently unused).

¢ FSP_VERSION_STRING
#define FSP_VERSION_STRING

Public FSP version name.

¢ FSP_VERSION_BUILD STRING
#define FSP_VERSION_BUILD_STRING

Unique FSP version ID.

4.1.1 Common Error Codes
BSP

Detailed Description

All FSP modules share these common error codes.

Macros
#define FSP_PARAMETER _NOT_USED(p)
#define FSP_CPP_HEADER
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#define FSP_HEADER
#define FSP_SECURE_ARGUMENT

Enumerations

enum fsp_err_t

Macro Definition Documentation

¢ FSP_PARAMETER_NOT_USED

#define FSP_PARAMETER_NOT_USED ( p)

This macro is used to suppress compiler messages about a parameter not being used in a function.
The nice thing about using this implementation is that it does not take any extra RAM or ROM.

¢ FSP_CPP_HEADER

#define FSP_CPP_HEADER

Determine if a C++ compiler is being used. If so, ensure that standard C is used to process the API
information.

¢ FSP_HEADER

#define FSP_HEADER

FSP Header and Footer definitions

& FSP_SECURE_ARGUMENT

#define FSP_SECURE_ARGUMENT

Macro to be used when argument to function is ignored since function call is NSC and the
parameter is statically defined on the Secure side.

Enumeration Type Documentation
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& fsp_err_t

enum fsp_err_t

Common error codes

Enumerator

FSP_ERR_ASSERTION

A critical assertion has failed.

FSP_ERR_INVALID_POINTER

Pointer points to invalid memory location.

FSP_ERR_INVALID_ARGUMENT

Invalid input parameter.

FSP_ERR_INVALID_CHANNEL

Selected channel does not exist.

FSP_ERR_INVALID_MODE

Unsupported or incorrect mode.

FSP_ERR_UNSUPPORTED

Selected mode not supported by this API.

FSP_ERR_NOT_OPEN

Requested channel is not configured or API not
open.

FSP_ERR_IN_USE

Channel/peripheral is running/busy.

FSP_ERR_OUT OF MEMORY

Allocate more memory in the driver's cfg.h.

FSP_ERR_HW_LOCKED

Hardware is locked.

FSP_ERR_IRQ_BSP_DISABLED

IRQ not enabled in BSP.

FSP_ERR_OVERFLOW

Hardware overflow.

FSP_ERR_UNDERFLOW

Hardware underflow.

FSP_ERR_ALREADY_OPEN

Requested channel is already open in a
different configuration.

FSP_ERR_APPROXIMATION

Could not set value to exact result.

FSP_ERR_CLAMPED

Value had to be limited for some reason.

FSP_ERR_INVALID_RATE

Selected rate could not be met.

FSP_ERR_ABORTED

An operation was aborted.

FSP_ERR_NOT_ENABLED

Requested operation is not enabled.

FSP_ERR_TIMEOUT

Timeout error.
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FSP_ERR_INVALID_BLOCKS Invalid number of blocks supplied.

FSP_ERR_INVALID_ADDRESS Invalid address supplied.

FSP_ERR_INVALID_SIZE Invalid size/length supplied for operation.

FSP_ERR_WRITE_FAILED Write operation failed.

FSP_ERR_ERASE_FAILED Erase operation failed.

FSP_ERR_INVALID_CALL Invalid function call is made.

FSP_ERR_INVALID_HW_CONDITION Detected hardware is in invalid condition.

FSP_ERR_INVALID_FACTORY_FLASH Factory flash is not available on this MCU.

FSP_ERR_INVALID_STATE APl or command not valid in the current state.

FSP_ERR_NOT_ERASED Erase verification failed.

FSP_ERR_SECTOR_RELEASE_FAILED Sector release failed.

FSP_ERR_NOT_INITIALIZED Required initialization not complete.

FSP_ERR_NOT_FOUND The requested item could not be found.

FSP_ERR_NO_CALLBACK_MEMORY Non-secure callback memory not provided for

non-secure callback.

FSP_ERR_BUFFER_EMPTY No data available in buffer.

FSP_ERR_INTERNAL Internal error.

FSP_ERR_WAIT_ABORTED Wait aborted.

FSP_ERR_FRAMING Framing error occurs.

FSP_ERR_BREAK_DETECT Break signal detects.

FSP_ERR_PARITY Parity error occurs.

FSP_ERR_RXBUF_OVERFLOW Receive queue overflow.

FSP_ERR_QUEUE_UNAVAILABLE Can't open s/w queue.

FSP_ERR_INSUFFICIENT_SPACE Not enough space in transmission circular

buffer.

R11UMO0155EU0230 Revision 2.30 .IENESAS Page 133/2,794
Sep.10.2021



Flexible Software Package User’s Manual

API Reference > BSP > Common Error Codes

FSP_ERR_INSUFFICIENT_DATA Not enough data in receive circular buffer.

FSP_ERR_TRANSFER_ABORTED The data transfer was aborted.

FSP_ERR_MODE_FAULT Mode fault error.

FSP_ERR_READ_OVERFLOW Read overflow.

FSP_ERR_SPI_PARITY Parity error.

FSP_ERR_OVERRUN Overrun error.

FSP_ERR_CLOCK_INACTIVE Inactive clock specified as system clock.

FSP_ERR_CLOCK_ACTIVE Active clock source cannot be modified without
stopping first.

FSP_ERR_NOT_STABILIZED Clock has not stabilized after its been turned
on/off.

FSP_ERR_PLL_SRC_INACTIVE PLL initialization attempted when PLL source is

turned off.
FSP_ERR_OSC_STOP_DET_ENABLED lllegal attempt to stop LOCO when Oscillation
stop is enabled.
FSP_ERR_OSC_STOP_DETECTED The Oscillation stop detection status flag is
set.
FSP_ERR_OSC_STOP_CLOCK_ACTIVE Attempt to clear Oscillation Stop Detect Status
with PLL/MAIN_OSC active.
FSP_ERR_CLKOUT_EXCEEDED Output on target output clock pin exceeds
maximum supported limit.
FSP_ERR_USB_MODULE_ENABLED USB clock configure request with USB Module
enabled.

FSP_ERR_HARDWARE_TIMEOUT A register read or write timed out.

FSP_ERR_LOW_VOLTAGE_MODE Invalid clock setting attempted in low voltage
mode.

FSP_ERR_PE_FAILURE Unable to enter Programming mode.

FSP_ERR_CMD_LOCKED Peripheral in command locked state.

FSP_ERR_FCLK FCLK must be >= 4 MHz.
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FSP_ERR_INVALID_LINKED_ADDRESS

Function or data are linked at an invalid region
of memory.

FSP_ERR_BLANK_CHECK_FAILED

Blank check operation failed.

FSP_ERR_INVALID_CAC_REF_CLOCK

Measured clock rate < reference clock rate.

FSP_ERR_CLOCK_GENERATION

Clock cannot be specified as system clock.

FSP_ERR_INVALID_TIMING_SETTING

Invalid timing parameter.

FSP_ERR_INVALID_LAYER SETTING

Invalid layer parameter.

FSP_ERR_INVALID_ALIGNMENT

Invalid memory alignment found.

FSP_ERR_INVALID_GAMMA_SETTING

Invalid gamma correction parameter.

FSP_ERR_INVALID_LAYER_FORMAT

Invalid color format in layer.

FSP_ERR_INVALID_UPDATE_TIMING

Invalid timing for register update.

FSP_ERR_INVALID_CLUT ACCESS

Invalid access to CLUT entry.

FSP_ERR_INVALID_FADE_SETTING

Invalid fade-in/fade-out setting.

FSP_ERR_INVALID_BRIGHTNESS_SETTING

Invalid gamma correction parameter.

FSP_ERR_JPEG_ERR

JPEG error.

FSP_ERR _JPEG_SOI_NOT_DETECTED

SOl not detected until EOl detected.

FSP_ERR_JPEG_SOF1_TO_SOFF _DETECTED

SOF1 to SOFF detected.

FSP_ERR_JPEG_UNSUPPORTED_PIXEL_FORMAT

Unprovided pixel format detected.

FSP_ERR_JPEG_SOF _ACCURACY_ERROR

SOF accuracy error: other than 8 detected.

FSP_ERR_JPEG_DQT_ACCURACY_ERROR

DQT accuracy error: other than 0 detected.

FSP_ERR JPEG_COMPONENT_ERROR1

Component error 1: the number of SOF0
header components detected is other than 1,
3, or4.

FSP_ERR_JPEG_COMPONENT ERROR?2

Component error 2: the number of components
differs between SOFO0 header and SOS.

FSP_ERR_JPEG_SOF0_DQT DHT NOT DETECTED

SOFO0, DQT, and DHT not detected when SOS
detected.
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FSP_ERR_JPEG_SOS NOT DETECTED

SOS not detected: SOS not detected until EOI
detected.

FSP_ERR JPEG_EOI_NOT DETECTED

EOI not detected (default)

FSP_ERR_JPEG_RESTART INTERVAL DATA_NUMB
ER_ERROR

Restart interval data number error detected.

FSP_ERR _JPEG_IMAGE_SIZE_ERROR

Image size error detected.

FSP_ERR JPEG_LAST MCU_DATA NUMBER_ERRO
R

Last MCU data number error detected.

FSP_ERR _JPEG_BLOCK_DATA_NUMBER_ERROR

Block data number error detected.

FSP_ERR JPEG_BUFFERSIZE_NOT_ENOUGH

User provided buffer size not enough.

FSP_ERR_JPEG_UNSUPPORTED_IMAGE_SIZE

JPEG Image size is not aligned with MCU.

FSP_ERR_CALIBRATE_FAILED

Calibration failed.

FSP_ERR_IP_HARDWARE_NOT PRESENT

Requested IP does not exist on this device.

FSP_ERR_IP_UNIT_NOT_PRESENT

Requested unit does not exist on this device.

FSP_ERR_IP_CHANNEL_NOT PRESENT

Requested channel does not exist on this
device.

FSP_ERR_NO_MORE_BUFFER

No more buffer found in the memory block
pool.

FSP_ERR_ILLEGAL BUFFER_ADDRESS

Buffer address is out of block memory pool.

FSP_ERR_INVALID_WORKBUFFER_SIZE

Work buffer size is invalid.

FSP_ERR_INVALID_MSG_BUFFER_SIZE

Message buffer size is invalid.

FSP_ERR TOO_MANY_BUFFERS

Number of buffer is too many.

FSP_ERR_NO_SUBSCRIBER_FOUND

No message subscriber found.

FSP_ERR_MESSAGE_QUEUE_EMPTY

No message found in the message queue.

FSP_ERR_MESSAGE_QUEUE_FULL

No room for new message in the message
gueue.

FSP_ERR_ILLEGAL_SUBSCRIBER_LISTS

Message subscriber lists is illegal.

FSP_ERR_BUFFER_RELEASED

Buffer has been released.
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FSP_ERR_D2D_ERROR_INIT

D/AVE 2D has an error in the initialization.

FSP_ERR_D2D_ERROR_DEINIT

D/AVE 2D has an error in the initialization.

FSP_ERR_D2D_ERROR_RENDERING

D/AVE 2D has an error in the rendering.

FSP_ERR_D2D_ERROR_SIZE

D/AVE 2D has an error in the rendering.

FSP_ERR_ETHER_ERROR_NO_DATA

No Data in Receive buffer.

FSP_ERR_ETHER_ERROR_LINK

ETHERC/EDMAC has an error in the Auto-
negotiation.

FSP_ERR_ETHER ERROR_MAGIC_PACKET MODE

As a Magic Packet is being detected, and
transmission/reception is not enabled.

FSP_ERR_ETHER_ERROR_TRANSMIT BUFFER FUL
L

Transmit buffer is not empty.

FSP_ERR_ETHER_ERROR_FILTERING

Detect multicast frame when multicast frame
filtering enable.

FSP_ERR_ETHER_ERROR_PHY_COMMUNICATION

ETHERC/EDMAC has an error in the phy
communication.

FSP_ERR_ETHER _RECEIVE_BUFFER_ACTIVE

Receive buffer is active.

FSP_ERR_ETHER_PHY_ERROR_LINK

PHY is not link up.

FSP_ERR_ETHER_PHY_NOT_READY

PHY has an error in the Auto-negotiation.

FSP_ERR_QUEUE_FULL

Queue is full, cannot queue another data.

FSP_ERR_QUEUE_EMPTY

Queue is empty, no data to dequeue.

FSP_ERR_CTSU_SCANNING

Scanning.

FSP_ERR_CTSU_NOT_GET_DATA

Not processed previous scan data.

FSP_ERR_CTSU_INCOMPLETE_TUNING

Incomplete initial offset tuning.

FSP_ERR_CTSU_DIAG_NOT YET

Diagnosis of data collected no yet.

FSP_ERR_CTSU_DIAG_LDO_OVER_VOLTAGE

Diagnosis of LDO over voltage failed.

FSP_ERR_CTSU DIAG _CCO_HIGH

Diagnosis of CCO into 19.2uA failed.

FSP_ERR_CTSU_DIAG_CCO_LOW

Diagnosis of CCO into 2.4uA failed.
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FSP_ERR_CTSU_DIAG_SSCG Diagnosis of SSCG frequency failed.

FSP_ERR_CTSU_DIAG_DAC Diagnosis of non-touch count value failed.

FSP_ERR_CTSU_DIAG_OUTPUT_VOLTAGE Diagnosis of LDO output voltage failed.

FSP_ERR_CTSU_DIAG_OVER_VOLTAGE Diagnosis of over voltage detection circuit

failed.

FSP_ERR_CTSU_DIAG_OVER_CURRENT Diagnosis of over current detection circuit

failed.

FSP_ERR_CTSU_DIAG_LOAD_RESISTANCE Diagnosis of LDO internal resistance value

failed.

FSP_ERR_CTSU_DIAG_CURRENT_SOURCE Diagnosis of Current source value failed.

FSP_ERR_CTSU_DIAG_SENSCLK_GAIN Diagnosis of SENSCLK frequency gain failed.

FSP_ERR_CTSU_DIAG_SUCLK_GAIN Diagnosis of SUCLK frequency gain failed.

FSP_ERR_CTSU_DIAG_CLOCK_RECOVERY Diagnosis of SUCLK clock recovery function

failed.

FSP_ERR_CTSU_DIAG_CFC_GAIN Diagnosis of CFC oscillator gain failed.

FSP_ERR_CARD_INIT_FAILED SD card or eMMC device failed to initialize.

FSP_ERR_CARD_NOT_INSERTED SD card not installed.

FSP_ERR_DEVICE_BUSY Device is holding DATO low or another

operation is ongoing.

FSP_ERR_CARD_NOT_INITIALIZED SD card was removed.

FSP_ERR_CARD_WRITE_PROTECTED Media is write protected.

FSP_ERR_TRANSFER_BUSY Transfer in progress.

FSP_ERR_RESPONSE Card did not respond or responded with an

error.

FSP_ERR_MEDIA_FORMAT_FAILED Media format failed.

FSP_ERR_MEDIA_OPEN_FAILED Media open failed.

FSP_ERR_CAN_DATA_UNAVAILABLE No data available.

FSP_ERR_CAN_MODE_SWITCH_FAILED Switching operation modes failed.
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FSP_ERR_CAN_INIT_FAILED

Hardware initialization failed.

FSP_ERR_CAN_TRANSMIT NOT _READY

Transmit in progress.

FSP_ERR_CAN_RECEIVE_MAILBOX

Mailbox is setup as a receive mailbox.

FSP_ERR_CAN_TRANSMIT_MAILBOX

Mailbox is setup as a transmit mailbox.

FSP_ERR_CAN_MESSAGE_LOST

Receive message has been overwritten or
overrun.

FSP_ERR_CAN_TRANSMIT FIFO_FULL

Transmit FIFO is full.

FSP_ERR_WIFI_CONFIG_FAILED

WiFi module Configuration failed.

FSP_ERR_WIFI_INIT_FAILED

WiFi module initialization failed.

FSP_ERR_WIFI_TRANSMIT FAILED

Transmission failed.

FSP_ERR_WIFI_INVALID_MODE

API called when provisioned in client mode.

FSP_ERR_WIF|_FAILED

WiFi Failed.

FSP_ERR_WIFI_SCAN_COMPLETE

Wifi scan has completed.

FSP_ERR_CELLULAR_CONFIG_FAILED

Cellular module Configuration failed.

FSP_ERR_CELLULAR_INIT_FAILED

Cellular module initialization failed.

FSP_ERR_CELLULAR_TRANSMIT_FAILED

Transmission failed.

FSP_ERR_CELLULAR_FW_UPTODATE

Firmware is uptodate.

FSP_ERR_CELLULAR_FW_UPGRADE_FAILED

Firmware upgrade failed.

FSP_ERR_CELLULAR_FAILED

Cellular Failed.

FSP_ERR_CELLULAR_INVALID_STATE

API Called in invalid state.

FSP_ERR_CELLULAR_REGISTRATION_FAILED

Cellular Network registration failed.

FSP_ERR_BLE_FAILED

BLE operation failed.

FSP_ERR_BLE_INIT_FAILED

BLE device initialization failed.

FSP_ERR_BLE_CONFIG_FAILED

BLE device configuration failed.

FSP_ERR_BLE_PRF_ALREADY_ENABLED

BLE device Profile already enabled.
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FSP_ERR_BLE_PRF_NOT_ENABLED

BLE device not enabled.

FSP_ERR_BLE_ABS_INVALID_OPERATION

Invalid operation is executed.

FSP_ERR_BLE_ABS_NOT_FOUND

Valid data or free space is not found.

FSP_ERR_CRYPTO_CONTINUE

Continue executing function.

FSP_ERR_CRYPTO_SCE_RESOURCE_CONFLICT

Hardware resource busy.

FSP_ERR_CRYPTO_SCE_FAIL

Internal 1/O buffer is not empty.

FSP_ERR_CRYPTO_SCE_HRK_INVALID_INDEX

Invalid index.

FSP_ERR_CRYPTO_SCE_RETRY

Retry.

FSP_ERR_CRYPTO_SCE_VERIFY_FAIL

Verify is failed.

FSP_ERR_CRYPTO_SCE_ALREADY_OPEN

HW SCE module is already opened.

FSP_ERR_CRYPTO_NOT_OPEN

Hardware module is not initialized.

FSP_ERR_CRYPTO_UNKNOWN

Some unknown error occurred.

FSP_ERR_CRYPTO_NULL_POINTER

Null pointer input as a parameter.

FSP_ERR_CRYPTO_NOT_IMPLEMENTED

Algorithm/size not implemented.

FSP_ERR_CRYPTO RNG_INVALID_PARAM

An invalid parameter is specified.

FSP_ERR_CRYPTO_RNG_FATAL_ERROR

A fatal error occurred.

FSP_ERR_CRYPTO_INVALID_SIZE

Size specified is invalid.

FSP_ERR_CRYPTO_INVALID_STATE

Function used in an valid state.

FSP_ERR_CRYPTO_ALREADY_ OPEN

control block is already opened

FSP_ERR_CRYPTO_INSTALL_KEY_FAILED

Specified input key is invalid.

FSP_ERR_CRYPTO_AUTHENTICATION_FAILED

Authentication failed.

FSP_ERR_CRYPTO_SCE_KEY SET FAIL

Failure to Init Cipher.

FSP_ERR_CRYPTO_SCE_AUTHENTICATION

Authentication failed.

FSP_ERR_CRYPTO_SCE_PARAMETER

Input date is illegal.
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FSP_ERR_CRYPTO_SCE_PROHIBIT_FUNCTION An invalid function call occurred.

FSP_ERR_CRYPTO_COMMON_NOT_OPENED Crypto Framework Common is not opened.

FSP_ERR_CRYPTO_HAL_ERROR Cryoto HAL module returned an error.

FSP_ERR_CRYPTO_KEY_BUF_NOT_ENOUGH Key buffer size is not enough to generate a

key.

FSP_ERR_CRYPTO_BUF_OVERFLOW Attempt to write data larger than what the

buffer can hold.

FSP_ERR_CRYPTO_INVALID_OPERATION_MODE Invalid operation mode.

FSP_ERR_MESSAGE_TOO_LONG Message for RSA encryption is too long.

FSP_ERR_RSA_DECRYPTION_ERROR RSA Decryption error.

FSP_ERR_SENSOR_INVALID_DATA Data is invalid.

Note
S=_CRYPTO APIs may return an error code
starting from 0x10000 which is of Crypto module.
Refer to sf_cryoto_err.h for Crypto error codes.

FSP_ERR_SENSOR_IN_STABILIZATION Sensor is stabilizing.

FSP_ERR_SENSOR_MEASUREMENT_NOT_FINISHE
D

Measurement is not finished.

FSP_ERR_COMMS_BUS_NOT_OPEN Bus is not open.

4.1.2 MCU Board Support Package

BSP
Functions
fsp_err t R_FSP_VersionGet (fsp_pack version_t *const p_version)
void Reset Handler (void)
void Default Handler (void)
void NMI_Handler (void)
void Systemlnit (void)
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void
__STATIC_INLINE IRQn_Type
__STATIC_INLINE uint32_t

__ STATIC_INLINE
bsp_unique_id_t const *

__STATIC_INLINE void
__STATIC_INLINE void
void

fsp_err t

void

void

Detailed Description

R_BSP_WarmStart (bsp_warm_start_event_t event)
R_FSP_CurrentlrgGet (void)
R _FSP SystemClockHzGet (fsp_priv_clock t clock)

R_BSP_UniqueldGet ()

R_BSP_FlashCacheDisable ()
R _BSP_FlashCacheEnable ()
R_BSP_SoftwareDelay (uint32_t delay, bsp_delay units_t units)

R_BSP_GrouplrgWrite (bsp_grp_irqg_t irq,
void(*p_callback)(bsp_grp_irqg_tirqg))

R_BSP_RegisterProtectEnable (bsp _reg protect t regs to protect)

R_BSP_RegisterProtectDisable (bsp_reg protect t regs_to_unprotect)

The BSP is responsible for getting the MCU from reset to the user's application. Before reaching the
user's application, the BSP sets up the stacks, heap, clocks, interrupts, C runtime environment, and

stack monitor.

BSP Features

System Interrupts
Group Interrupts

Error Logging
BSP Weak Symbols

Register Protection
ID Codes
Software Delay

Configuration

Overview

BSP Features
BSP Clock Configuration

Warm Start Callbacks
C Runtime Initialization

BSP Clock Configuration

External and Peripheral Interrupts

Octal-SPI Clock Update
Board Specific Features
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All system clocks are set up during BSP initialization based on the settings in bsp_clock _cfg.h. These
settings are derived from clock configuration information provided from the RA Configuration editor
Clocks tab.

e Clock configuration is performed prior to initializing the C runtime environment to speed up
the startup process, as it is possible to start up on a relatively slow (that is, 32 kHz) clock.

e The BSP implements the required delays to allow the selected clock to stabilize.

e The BSP will configure the CMSIS SystemCoreClock variable after clock initialization with the
current system clock frequency.

System Interrupts

As RA MCUs are based on the Cortex-M ARM architecture, the NVIC Nested Vectored Interrupt
Controller (NVIC) handles exceptions and interrupt configuration, prioritization and interrupt
masking. In the ARM architecture, the NVIC handles exceptions. Some exceptions are known as
System Exceptions. System exceptions are statically located at the "top" of the vector table and
occupy vector numbers 1 to 15. Vector zero is reserved for the MSP Main Stack Pointer (MSP). The
remaining 15 system exceptions are shown below:

e Reset

e NMI

e Cortex-M4 Hard Fault Handler
e Cortex-M4 MPU Fault Handler
e Cortex-M4 Bus Fault Handler
e Cortex-M4 Usage Fault Handler
e Reserved

e Reserved

e Reserved

e Reserved

e Cortex-M4 SVCall Handler

Cortex-M4 Debug Monitor Handler
e Reserved

e Cortex-M4 PendSV Handler

e Cortex-M4 SysTick Handler

NMI and Hard Fault exceptions are enabled out of reset and have fixed priorities. Other exceptions
have configurable priorities and some can be disabled.

Group Interrupts

Group interrupt is the term used to describe the 12 sources that can trigger the Non-Maskable
Interrupt (NMI). When an NMI occurs the NMI Handler examines the NMISR (status register) to
determine the source of the interrupt. NMI interrupts take precedence over all interrupts, are usable
only as CPU interrupts, and cannot activate the RA peripherals Data Transfer Controller (DTC) or
Direct Memory Access Controller (DMAC).

Possible group interrupt sources include:

IWDT Underflow/Refresh Error
WDT Underflow/Refresh Error
Voltage-Monitoring 1 Interrupt
Voltage-Monitoring 2 Interrupt
VBATT monitor Interrupt
Oscillation Stop is detected
NMI pin
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RAM Parity Error

RAM ECC Error

MPU Bus Slave Error

MPU Bus Master Error

MPU Stack Error

TrustZone Filter Error A user may enable notification for one or more group interrupts by
registering a callback using the BSP API function R_BSP_GrouplrgWrite(). When an NMI
interrupt occurs, the NMI handler checks to see if there is a callback registered for the
cause of the interrupt and if so calls the registered callback function.

External and Peripheral Interrupts

User configurable interrupts begin with slot 16. These may be external, or peripheral generated
interrupts.

Although the number of available slots for the NVIC interrupt vector table may seem small, the BSP
defines up to 512 events that are capable of generating an interrupt. By using Event Mapping, the
BSP maps user-enabled events to NVIC interrupts. For an RA6M3 MCU, only 96 of these events may
be active at any one time, but the user has flexibility by choosing which events generate the active
event.

By allowing the user to select only the events they are interested in as interrupt sources, we are able
to provide an interrupt service routine that is fast and event specific.

For example, on other microcontrollers a standard NVIC interrupt vector table might contain a single
vector entry for the SCIO (Serial Communications Interface) peripheral. The interrupt service routine
for this would have to check a status register for the 'real' source of the interrupt. In the RA
implementation there is a vector entry for each of the SCI0O events that we are interested in.

BSP Weak Symbols

You might wonder how the BSP is able to place ISR addresses in the NVIC table without the user
having explicitly defined one. All that is required by the BSP is that the interrupt event be given a
priority.

This is accomplished through the use of the 'weak' attribute. The weak attribute causes the
declaration to be emitted as a weak symbol rather than a global. A weak symbol is one that can be
overridden by an accompanying strong reference with the same name. When the BSP declares a
function as weak, user code can define the same function and it will be used in place of the BSP
function. By defining all possible interrupt sources as weak, the vector table can be built at compile
time and any user declarations (strong references) will be used at runtime.

Weak symbols are supported for ELF targets and also for a.out targets when using the GNU
assembler and linker.

Note that in CMSIS system.c, there is also a weak definition (and a function body) for the Warm Start
callback function R_BSP_WarmStart(). Because this function is defined in the same file as the weak
declaration, it will be called as the 'default' implementation. The function may be overridden by the
user by copying the body into their user application and modifying it as necessary. The linker
identifies this as the 'strong' reference and uses it.

Warm Start Callbacks

As the BSP is in the process of bringing up the board out of reset, there are three points where the
user can request a callback. These are defined as the 'Pre Clock Init', 'Post Clock Init' and 'Post C'
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warm start callbacks.

As described above, this function is already weakly defined as R_BSP_WarmStart(), so it is a simple
matter of redefining the function or copying the existing body from CMSIS system.c into the
application code to get a callback. R_ BSP_WarmStart() takes an event parameter of type
bsp_warm_start _event t which describes the type of warm start callback being made.

This function is not enabled/disabled and is always called for both events as part of the BSP startup.
Therefore it needs a function body, which will not be called if the user is overriding it. The function
body is located in system.c. To use this function just copy this function into your own code and
modify it to meet your needs.

C Runtime Initialization

This BSP configuration allows the user to skip the FSP C runtime initialization code by setting the "C
Runtime Initialization" to "Disabled" on the BSP tab of the RA Configuration editor. Disabling this
option is useful in cases where a non-standard linker script is being used or other modifications to
the runtime initialization are desired. If this macro is disabled, the user must use the 'Post Clock Init'
event from the warm start (described above) to run their own runtime initialization code.

Heap Allocation

The relatively low amount of on-chip SRAM available and lack of memory protection in an MCU
means that heap use must be very carefully controlled to avoid memory leaks, overruns and
attempted overallocation. Further, many RTOSes provide their own dynamic memory allocation
system. For these reasons the default heap size is set at 0 bytes, effectively disabling dynamic
memory. If it is required for an application setting a positive value to the "Heap size (bytes)" option
in the RA Common configurations on the BSP tab will allocate a heap.

Note
When using printf/sprintf (and other variants) to output floating point numbers a heap is required. A minimum size
of 0x1000 (4096) bytes is recommended when starting development in this case.

Error Logging

When error logging is enabled, the error logging function can be redefined on the command line by
defining FSP_ERROR_LOG(err) to the desired function call. The default function implementation is
FSP_ERROR_LOG(err)=fsp_error_log(err, FILE, LINE). This implementation uses the predefined
macros FILE and LINE to help identify the location where the error occurred. Removing the line from
the function call can reduce code size when error logging is enabled. Some compilers may support
other predefined macros like FUNCTION, which could be helpful for customizing the error logger.
Register Protection

The BSP register protection functions utilize reference counters to ensure that an application which
has specified a certain register and subsequently calls another function doesn't have its register
protection settings inadvertently modified.

Each time R_BSP_RegisterProtectDisable() is called, the respective reference counter is incremented.

Each time R_BSP_RegisterProtectEnable() is called, the respective reference counter is decremented.

Both functions will only modify the protection state if their reference counter is zero.
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/* Enable witing to protected CGC registers */

R BSP_Regi st er Pr ot ect Di sabl e( BSP_REG PROTECT CCC) ;
/* Insert code to nodify protected CGC registers. */
/* Disable witing to protected CGC registers */

R BSP_Regi st er Pr ot ect Enabl e( BSP_REG PROTECT CGC) ;

ID Codes

The ID code is a 16-byte value that can be used to protect the MCU from being connected to a
debugger or from connecting in Serial Boot Mode. There are different settings that can be set for the
ID code; please refer to the hardware manual for your device for available options.

Software Delay

Implements a blocking software delay. A delay can be specified in microseconds, milliseconds or
seconds. The delay is implemented based on the system clock rate.
/* Delay at |least 1 second. Depending on the nunber of wait states required for the
regi on of nenory
* that the software_delay | oop has been linked in this could take | onger. The
default is 4 cycles per |oop.
* This can be nodified by redefining DELAY LOOP_CYCLES. BSP_DELAY UN TS SECONDS,
BSP_DELAY _UNI TS M LLI SECONDS,
* and BSP_DELAY UNI TS M CROSECONDS can all be used with R BSP_Sof t wareDel ay. */
R BSP_Sof t war eDel ay(1, BSP_DELAY UNI TS SECONDS) ;

Critical Section Macros

Implements a critical section. Some MCUs (MCUs with the BASEPRI register) support allowing high
priority interrupts to execute during critical sections. On these MCUs, interrupts with priority less
than or equal to BSP_CFG_IRQ_MASK LEVEL FOR_CRITICAL_SECTION are not serviced in critical
sections. Interrupts with higher priority than BSP_CFG_IRQ_MASK LEVEL_FOR_CRITICAL_SECTION still
execute in critical sections.
FSP_CRI Tl CAL_SECTI ON_DEFI NE;

/* Store the current interrupt posture. */

FSP_CRI TI CAL_SECTI ON_ENTER;

/* Interrupts cannot run in this section unless their priority is less than

BSP_CFG | RQ MASK_LEVEL_FOR CRI TI CAL_SECTI ON. */

/* Restore saved interrupt posture. */
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FSP_CRI Tl CAL_SECTI ON_EXI T:

OctaClock Update

Supports changing the Octal-SPI Clock (OCTACLK) during runtime if supported by the MCU. The
OCTACLK source and clock divisor can be updated. It is user's responsibility to ensure the selected
clock source is running before attempting to update OCTACLK.

Sealing the Main Stack (TrustZone Secure Projects)

In TrustZone secure projects, the BSP seals the main stack by placing the value OXFEF5EDA5S above

the stack top. For more information, refer to section 3.5 "Sealing a Stack" in "Secure software
guidelines for ARMv8-M": https://developer.arm.com/documentation/100720/0300.

Board Specific Features

The BSP will call the board's initialization function (bsp_init) which can initialize board specific
features. Possible board features are listed below.

Board Feature Description
SDRAM Support The BSP will initialize SDRAM if the board
supports it
QSPI Support The BSP will initialize QSPI if the board supports

it and put it into ROM mode. Use the R_QSPI
module to write and erase the QSPI chip.

Configuration

The BSP is heavily data driven with most features and functionality being configured based on the
content from configuration files. Configuration files represent the settings specified by the user and
are generated when the project is built and/or when the Generate Project Content button is clicked in
the RA Configuration editor.

Build Time Configurations for fsp_common

The following build time configurations are defined in fsp_cfg/bsp/bsp_cfg.h:

Configuration Options Default Description
Main stack size (bytes) Value must be an 0x400 Set the size of the main
integer multiple of 8 program stack.
and between 8 and
OxFFFFFFFF NOTE: This entry is for

the main stack. When
using an RTOS, thread
stacks can be
configured in the
properties for each

R11UMO0155EU0230 Revision 2.30 .IENESAS Page 147 /2,794
Sep.10.2021


https://developer.arm.com/documentation/100720/0300

Flexible Software Package

API| Reference > BSP > MCU Board Support Package

User’s Manual

Heap size (bytes)

MCU Vcc (mV)

Parameter checking

Assert Failures

Value must be 0 or an 0
integer multiple of 8
between 8 and
OxFFFFFFFF.

Value must between 0 3300
and 5500 (5.5V)
e Enabled Disabled
e Disabled

e Return FSP_ERR Return
_ASSERTION FSP_ERR_ASSERTION
e Call
fsp_error_log
then Return FSP
_ERR_ASSERTIO
N
e Use assert() to
Halt Execution
e Disable checks
that would
return FSP_ERR
_ASSERTION

thread.

The main heap is
disabled by default. Set
the heap size to a
positive integer
divisible by 8 to enable
it.

A minimum of 4K
(0x1000) is
recommended if
standard library
functions are to be
used.

Some peripherals
require different
settings based on the
supplied voltage.
Entering Vcc here (in
mV) allows the relevant
driver modules to
configure the
associated peripherals
accordingly.

When enabled,
parameter checking for
the BSP is turned on. In
addition, any modules
whose parameter
checking configuration
is set to 'Default (BSP)'
will perform parameter
checking as well.

Define the behavior of
the FSP_ASSERTY()
macro.

Error Log e No Error Log No Error Log Specify error logging
e Errors Logged behavior.
via
fsp_error_log
Soft Reset ¢ Disabled Disabled Support for soft reset.
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Main Oscillator
Populated

PFS Protect

C Runtime Initialization

Main Oscillator Clock
Source

Subclock Populated

Subclock Drive (Drive

e Enabled

e Populated
¢ Not Populated

e Disabled
e Enabled

e Enabled
e Disabled

e External
Oscillator

e Crystal or
Resonator

Populated
¢ Not Populated

e Standard/Norm

Populated

Enabled

Enabled

Crystal or Resonator

Populated

Standard/Normal mode

If disabled, registers
are assumed to be set
to their default value
during startup.

Select whether or not
there is a main
oscillator (XTAL) on the
board. This setting can
be overridden in
board_cfg.h.

Keep the PFS registers
locked when they are
not being modified. If
disabled they will be
unlocked during
startup.

Select if the C runtime
initialization in the BSP
is to be used. If
disabled, use the BSP_
WARM_START POST CL
OCK event to run user
defined equivalent.

Select the main
oscillator clock source.
This setting can be
overridden in

board cfg.h

Select whether or not
there is a subclock
crystal on the board.
This setting can be
overridden in
board_cfg.h.

Select the subclock

Sep.10.2021

capacitance availability al mode oscillator drive
varies by MCU) e Low/Low power capacitance. This
mode 1 setting can be
e Low power overridden in
mode 2 board _cfg.h
e Low power
mode 3
Subclock Stabilization ~ Value must between 0 1000 Select the subclock
Time (ms) and 10000 oscillator stabilization
time. This is only used
in the startup code if
the subclock is
selected as the system
clock on the Clocks tab
or if the HOCO FLL
function is enabled.
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Modules

Macros

#define

#define

#define

#define

#define

#define

RA2A1

RA2E1

RA2L1

RA4E1

RA4M1

RA4M2

RA4AM3

RA4W1

RAGE1

RA6M1

RA6M2

RA6M3

RA6M4

RA6M5

RA6T1

BSP_IRQ_DISABLED

FSP_LOG_PRINT(X)

FSP_RETURN(err)

FSP_ERROR_LOG(err)

FSP_ASSERT(a)

FSP_ERROR_RETURN(a, err)

This setting

can be

overridden in

board cfg.h
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#define FSP_CRITICAL SECTION_ENTER

#define FSP_CRITICAL SECTION_EXIT

#define FSP_INVALID VECTOR

#define BSP_CFG_HANDLE_UNRECOVERABLE_ERROR(x)
#define BSP_STACK ALIGNMENT

#define R_BSP_MODULE_START(ip, channel)

#define R_BSP_MODULE_STOP(ip, channel)

Enumerations

enum fsp_ ip_t

enum fsp_signal t

enum bsp warm_start_event t
enum bsp_delay_units_t
enum bsp grp_irg_t

enum bsp reg_protect t

Variables

uint32_ t SystemCoreClock

Macro Definition Documentation

¢ BSP_IRQ_DISABLED

#define BSP_IRQ_DISABLED

Used to signify that an ELC event is not able to be used as an interrupt.

¢ FSP_LOG_PRINT

#define FSP_LOG_PRINT ( X)

Macro that can be defined in order to enable logging in FSP modules.
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¢ FSP_RETURN

#define FSP_RETURN ( err)

Macro to log and return error without an assertion.

o FSP_ERROR_LOG

#define FSP_ERROR_LOG ( err)

This function is called before returning an error code. To stop on a runtime error, define
fsp_error_log in user code and do required debugging (breakpoints, stack dump, etc) in this
function.

o FSP_ASSERT

#define FSP_ASSERT ( a)

Default assertion calls FSP_ERROR_RETURN if condition "a" is false. Used to identify incorrect use of
API's in FSP functions.

¢ FSP_ERROR_RETURN

#define FSP_ERROR_RETURN ( a, err )

All FSP error codes are returned using this macro. Calls FSP_ERROR_LOG function if condition "a" is
false. Used to identify runtime errors in FSP functions.

¢ FSP_CRITICAL_SECTION_ENTER

#define FSP_CRITICAL_SECTION_ENTER

This macro temporarily saves the current interrupt state and disables interrupts.

¢ FSP_CRITICAL_SECTION_EXIT

#define FSP_CRITICAL_SECTION_EXIT

This macro restores the previously saved interrupt state, reenabling interrupts.

& FSP_INVALID_VECTOR

#define FSP_INVALID_VECTOR

Used to signify that the requested IRQ vector is not defined in this system.
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¢ BSP_CFG_HANDLE_UNRECOVERABLE_ERROR

#define BSP_CFG_HANDLE_UNRECOVERABLE_ERROR ( x)

In the event of an unrecoverable error the BSP will by default call the _ BKPT() intrinsic function
which will alert the user of the error. The user can override this default behavior by defining their
own BSP_CFG_HANDLE_UNRECOVERABLE_ERROR macro.

¢ BSP_STACK_ALIGNMENT

#define BSP_STACK_ALIGNMENT

Stacks (and heap) must be sized and aligned to an integer multiple of this number.

¢ R_BSP_MODULE_START

#define R_BSP_MODULE_START ( ip, channel )

Cancels the module stop state.

Parameters
ip fsp_ip_t enum value for the module to be
stopped
channel The channel. Use channel 0 for modules
without channels.

¢ R_BSP_MODULE_STOP

#define R_BSP_MODULE_STOP ( ip, channel )

Enables the module stop state.

Parameters
ip fsp_ip_t enum value for the module to be
stopped
channel The channel. Use channel 0 for modules
without channels.

Enumeration Type Documentation
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¢ fsp_ip_t

enum fsp_ip t

Available modules.

Enumerator

FSP_IP_CFLASH Code Flash.

FSP_IP_DFLASH Data Flash.

FSP_IP_RAM RAM.

FSP_IP_LVD Low Voltage Detection.

FSP_IP_CGC Clock Generation Circuit.

FSP_IP_LPM Low Power Modes.

FSP_IP_FCU Flash Control Unit.

FSP_IP_ICU Interrupt Control Unit.

FSP_IP_DMAC DMA Controller.

FSP_IP_DTC Data Transfer Controller.
FSP_IP_IOPORT I/O Ports.

FSP_IP_PFS Pin Function Select.

FSP_IP_ELC Event Link Controller.

FSP_IP_MPU Memory Protection Unit.
FSP_IP_MSTP Module Stop.

FSP_IP_MMF Memory Mirror Function.

FSP_IP_KEY Key Interrupt Function.

FSP_IP_CAC Clock Frequency Accuracy Measurement

Circuit.

FSP_IP_DOC Data Operation Circuit.

FSP_IP_CRC Cyclic Redundancy Check Calculator.
FSP_IP_SCI Serial Communications Interface.
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FSP_IP_IIC I2C Bus Interface.

FSP_IP_SPI Serial Peripheral Interface.
FSP_IP_CTSU Capacitive Touch Sensing Unit.
FSP_IP_SCE Secure Cryptographic Engine.
FSP_IP_SLCDC Segment LCD Controller.
FSP_IP_AES Advanced Encryption Standard.
FSP_IP_TRNG True Random Number Generator.
FSP_IP_FCACHE Flash Cache.

FSP_IP_SRAM SRAM.

FSP_IP_ADC A/D Converter.

FSP_IP_DAC 12-Bit D/A Converter
FSP_IP_TSN Temperature Sensor.
FSP_IP_DAAD

D/A A/D Synchronous Unit.

FSP_IP_ACMPHS

High Speed Analog Comparator.

FSP_IP_ACMPLP

Low Power Analog Comparator.

FSP_IP_OPAMP Operational Amplifier.

FSP_IP_SDADC Sigma Delta A/D Converter.

FSP_IP_RTC Real Time Clock.

FSP_IP_WDT Watch Dog Timer.

FSP_IP_IWDT Independent Watch Dog Timer.

FSP_IP_GPT General PWM Timer.

FSP_IP_POEG Port Output Enable for GPT.

FSP_IP_OPS Output Phase Switch.

FSP_IP_AGT Asynchronous General-Purpose Timer.
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FSP_IP_CAN Controller Area Network.
FSP_IP_IRDA Infrared Data Association.
FSP_IP_QSPI Quad Serial Peripheral Interface.
FSP_IP_USBFS USB Full Speed.
FSP_IP_SDHI SD/MMC Host Interface.
FSP_IP_SRC Sampling Rate Converter.
FSP_IP_SSI Serial Sound Interface.
FSP_IP_DALI Digital Addressable Lighting Interface.
FSP_IP_ETHER Ethernet MAC Controller.
FSP_IP_EDMAC Ethernet DMA Controller.
FSP_IP_EPTPC Ethernet PTP Controller.
FSP_IP_PDC Parallel Data Capture Unit.
FSP_IP_GLCDC Graphics LCD Controller.
FSP_IP_DRW 2D Drawing Engine
FSP_IP_JPEG JPEG.
FSP_IP_DACS8 8-Bit D/A Converter
FSP_IP_USBHS USB High Speed.
FSP_IP_OSPI Octa Serial Peripheral Interface.
FSP_IP_CEC HDMI CEC.
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¢ fsp_signal_t

enum fsp_signal_t

Signals that can be mapped to an interrupt.

Enumerator

FSP_SIGNAL_ADC_COMPARE_MATCH

ADC COMPARE MATCH.

FSP_SIGNAL_ADC_COMPARE_MISMATCH

ADC COMPARE MISMATCH.

FSP_SIGNAL_ADC_SCAN_END

ADC SCAN END.

FSP_SIGNAL_ADC_SCAN_END B

ADC SCAN END B.

FSP_SIGNAL_ADC_WINDOW A

ADC WINDOW A.

FSP_SIGNAL_ADC_WINDOW B

ADC WINDOW B.

FSP_SIGNAL_AES_RDREQ

AES RDREQ.

FSP_SIGNAL_AES_WRREQ

AES WRREQ.

FSP_SIGNAL_AGT_COMPARE_A

AGT COMPARE A.

FSP_SIGNAL_AGT_COMPARE_B

AGT COMPARE B.

FSP_SIGNAL_AGT_INT

AGT INT.

FSP_SIGNAL_CAC_FREQUENCY_ERROR

CAC FREQUENCY ERROR.

FSP_SIGNAL_CAC_MEASUREMENT _END

CAC MEASUREMENT END.

FSP_SIGNAL_CAC_OVERFLOW

CAC OVERFLOW.

FSP_SIGNAL_CAN_ERROR

CAN ERROR,
FSP_SIGNAL_CAN_FIFO_RX CAN FIFO RX.
FSP_SIGNAL_CAN_FIFO_TX CAN FIFO TX.

FSP_SIGNAL_CAN_MAILBOX_RX

CAN MAILBOX RX.

FSP_SIGNAL_CAN_MAILBOX_TX

CAN MAILBOX TX.

FSP_SIGNAL_CGC_MOSC_STOP

CGC MOSC STOP.

FSP_SIGNAL_LPM_SNOOZE_REQUEST

LPM SNOOZE REQUEST.
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FSP_SIGNAL_LVD LVD1

LVD LVD1.
FSP_SIGNAL_LVD_LVD2 LVD LVD2.
FSP_SIGNAL_VBATT_LVD VBATT LVD.
FSP_SIGNAL_LVD_VBATT LVD VBATT.
FSP_SIGNAL_ACMPHS_INT ACMPHS INT.
FSP_SIGNAL_ACMPLP_INT ACMPLP INT.
FSP_SIGNAL_CTSU_END CTSU END.
FSP_SIGNAL_CTSU_READ CTSU READ.
FSP_SIGNAL_CTSU_WRITE CTSU WRITE.
FSP_SIGNAL_DALI_DEI DALI DEI.
FSP_SIGNAL_DALI_CLI DALI CLI.
FSP_SIGNAL_DALI_SDI DALI SDI.
FSP_SIGNAL_DALI_BPI DALI BPI.
FSP_SIGNAL_DALI_FEI DALI FEI.

FSP_SIGNAL_DALI_SDI_OR_BPI

DALI SDI OR BPI.

FSP_SIGNAL_DMAC_INT

DMAC INT.
FSP_SIGNAL_DOC_INT DOC INT.
FSP_SIGNAL_DRW_INT DRW INT.

FSP_SIGNAL_DTC_COMPLETE

DTC COMPLETE.

FSP_SIGNAL_DTC_END

DTC END.

FSP_SIGNAL_EDMAC_EINT

EDMAC EINT.

FSP_SIGNAL_ELC_SOFTWARE_EVENT_0 ELC SOFTWARE EVENT 0.

FSP_SIGNAL_ELC_SOFTWARE_EVENT_1 ELC SOFTWARE EVENT 1.

FSP_SIGNAL_EPTPC_IPLS EPTPC IPLS.
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FSP_SIGNAL_EPTPC_MINT

EPTPC MINT.

FSP_SIGNAL_EPTPC_PINT

EPTPC PINT.

FSP_SIGNAL_EPTPC_TIMERO_FALL

EPTPC TIMERO FALL.

FSP_SIGNAL_EPTPC_TIMERO_RISE

EPTPC TIMERO RISE.

FSP_SIGNAL_EPTPC_TIMER1_FALL

EPTPC TIMER1 FALL.

FSP_SIGNAL_EPTPC_TIMER1_RISE

EPTPC TIMERL1 RISE.

FSP_SIGNAL_EPTPC_TIMER2_FALL

EPTPC TIMER2 FALL.

FSP_SIGNAL_EPTPC_TIMER2_RISE

EPTPC TIMER2 RISE.

FSP_SIGNAL_EPTPC_TIMER3_FALL

EPTPC TIMER3 FALL.

FSP_SIGNAL_EPTPC_TIMER3_RISE

EPTPC TIMER3 RISE.

FSP_SIGNAL_EPTPC_TIMER4 FALL

EPTPC TIMER4 FALL.

FSP_SIGNAL_EPTPC_TIMER4_RISE

EPTPC TIMER4 RISE.

FSP_SIGNAL_EPTPC_TIMER5_FALL

EPTPC TIMERS5 FALL.

FSP_SIGNAL_EPTPC_TIMER5_RISE

EPTPC TIMERS5 RISE.

FSP_SIGNAL_FCU_FIFERR

FCU FIFERR.

FSP_SIGNAL_FCU_FRDYI

FCU FRDYI.

FSP_SIGNAL_GLCDC_LINE_DETECT

GLCDC LINE DETECT.

FSP_SIGNAL_GLCDC_UNDERFLOW 1

GLCDC UNDERFLOW 1.

FSP_SIGNAL_GLCDC_UNDERFLOW 2

GLCDC UNDERFLOW 2.

FSP_SIGNAL_GPT_CAPTURE_COMPARE_A

GPT CAPTURE COMPARE A.

FSP_SIGNAL_GPT_CAPTURE_COMPARE_B

GPT CAPTURE COMPARE B.

FSP_SIGNAL_GPT_COMPARE_C

GPT COMPARE C.

FSP_SIGNAL_GPT_COMPARE_D

GPT COMPARE D.

FSP_SIGNAL_GPT_COMPARE_E

GPT COMPARE E.
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FSP_SIGNAL_GPT_COMPARE_F GPT COMPARE F.
FSP_SIGNAL_GPT_COUNTER_OVERFLOW GPT COUNTER OVERFLOW.
FSP_SIGNAL_GPT_COUNTER_UNDERFLOW GPT COUNTER UNDERFLOW.
FSP_SIGNAL GPT _AD TRIG_A GPT AD TRIG A.
FSP_SIGNAL GPT _AD TRIG B GPT AD TRIG B.
FSP_SIGNAL_OPS_UVW_EDGE OPS UVW EDGE.
FSP_SIGNAL ICU_IRQO ICU IRQO.
FSP_SIGNAL ICU_IRQ1 ICU IRQ1.
FSP_SIGNAL_ICU_IRQ2 ICU IRQ2.
FSP_SIGNAL_ICU_IRQ3 ICU IRQ3.
FSP_SIGNAL ICU_IRQ4 ICU IRQA4.
FSP_SIGNAL_ICU_IRQ5 ICU IRQ5.
FSP_SIGNAL ICU IRQ6 ICU IRQS6.
FSP_SIGNAL_ICU_IRQ7 ICU IRQ7.
FSP_SIGNAL ICU_IRQ8 ICU IRQS.
FSP_SIGNAL _ICU_IRQ9 ICU IRQO9.
FSP_SIGNAL ICU _IRQ10 ICU IRQ10.
FSP_SIGNAL_ICU_IRQ11 ICU IRQ11.
FSP_SIGNAL ICU IRQ12 ICU IRQ12.
FSP_SIGNAL ICU_IRQ13 ICU IRQ13.
FSP_SIGNAL ICU IRQ14 ICU IRQ14.
FSP_SIGNAL_ICU_IRQ15 ICU IRQ15.
FSP_SIGNAL ICU SNOOZE_CANCEL ICU SNOOZE CANCEL.
FSP_SIGNAL IIC_ERI [IC ERI.
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FSP_SIGNAL_IIC_RXI

[IC RXI.
FSP_SIGNAL_IIC_TEI [IC TEI.
FSP_SIGNAL_IIC_TXI [IC TXI.
FSP_SIGNAL_IIC_WUI [IC WUI.

FSP_SIGNAL_IOPORT EVENT_1

IOPORT EVENT 1.

FSP_SIGNAL_IOPORT_EVENT 2

IOPORT EVENT 2.

FSP_SIGNAL_IOPORT _EVENT 3

IOPORT EVENT 3.

FSP_SIGNAL_IOPORT_EVENT 4

IOPORT EVENT 4.

FSP_SIGNAL_IWDT_UNDERFLOW

IWDT UNDERFLOW.

FSP_SIGNAL_JPEG_JDTI JPEG JDTI.
FSP_SIGNAL_JPEG_JEDI JPEG JEDI.
FSP_SIGNAL_KEY_INT KEY INT.

FSP_SIGNAL_PDC_FRAME_END

PDC FRAME END.

FSP_SIGNAL_PDC_INT

PDC INT.

FSP_SIGNAL_PDC_RECEIVE_DATA READY

PDC RECEIVE DATA READY.

FSP_SIGNAL_POEG_EVENT

POEG EVENT.
FSP_SIGNAL_QSPIL_INT QSPI INT.
FSP_SIGNAL_RTC_ALARM RTC ALARM.
FSP_SIGNAL_RTC_PERIOD RTC PERIOD.
FSP_SIGNAL_RTC_CARRY RTC CARRY.

FSP_SIGNAL_SCE_INTEGRATE_RDRDY

SCE INTEGRATE RDRDY.

FSP_SIGNAL_SCE_INTEGRATE_WRRDY

SCE INTEGRATE WRRDY.

FSP_SIGNAL_SCE_LONG_PLG

SCE LONG PLG.

FSP_SIGNAL_SCE_PROC_BUSY

SCE PROC BUSY.
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FSP_SIGNAL_SCE_RDRDY_0

SCE RDRDY 0.
FSP_SIGNAL_SCE_RDRDY_1 SCE RDRDY 1.
FSP_SIGNAL_SCE_ROMOK SCE ROMOK.

FSP_SIGNAL_SCE_TEST_BUSY

SCE TEST BUSY.

FSP_SIGNAL_SCE_WRRDY_0

SCE WRRDY 0.
FSP_SIGNAL_SCE_WRRDY_1 SCE WRRDY 1.
FSP_SIGNAL_SCE_WRRDY_4 SCE WRRDY 4.
FSP_SIGNAL_SCI_AM SCI AM.
FSP_SIGNAL_SCI_ERI SCI ERI.
FSP_SIGNAL_SCI_RXI SCI RXI.
FSP_SIGNAL_SCI_RXI_OR_ERI SCI RXI OR ERI.
FSP_SIGNAL_SCI_TEI SCI TEI.
FSP_SIGNAL_SCI_TXI SCI TXI.
FSP_SIGNAL_SDADC_ADI SDADC ADI.

FSP_SIGNAL_SDADC_SCANEND

SDADC SCANEND.

FSP_SIGNAL_SDADC_CALIEND

SDADC CALIEND.

FSP_SIGNAL_SDHIMMC_ACCS

SDHIMMC ACCS.

FSP_SIGNAL_SDHIMMC_CARD

SDHIMMC CARD.

FSP_SIGNAL_SDHIMMC_DMA_REQ

SDHIMMC DMA REQ.

FSP_SIGNAL_SDHIMMC_SDIO

SDHIMMC SDIO.

FSP_SIGNAL_SPI_ERI

SPI ERI.
FSP_SIGNAL_SPI_IDLE SPI IDLE.
FSP_SIGNAL SPI _RXI SPI RXI.
FSP_SIGNAL _SPI TEI SPI TEI.
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FSP_SIGNAL_SPI_TXI

SPI TXI.

FSP_SIGNAL_SRC_CONVERSION_END

SRC CONVERSION END.

FSP_SIGNAL_SRC_INPUT FIFO_EMPTY

SRC INPUT FIFO EMPTY.

FSP_SIGNAL_SRC_OUTPUT_FIFO_FULL

SRC OUTPUT FIFO FULL.

FSP_SIGNAL_SRC_OUTPUT_FIFO_OVERFLOW

SRC OUTPUT FIFO OVERFLOW.

FSP_SIGNAL_SRC_OUTPUT_FIFO_UNDERFLOW

SRC OUTPUT FIFO UNDERFLOW.

FSP_SIGNAL_SSI_INT

SSIINT.
FSP_SIGNAL_SSI_RXI SSI RXI.
FSP_SIGNAL_SSI_TXI SSI TXI.
FSP_SIGNAL_SSI_TXI_RXI SSI TXI RXI.
FSP_SIGNAL_TRNG_RDREQ TRNG RDREQ.
FSP_SIGNAL_USB_FIFO_O USB FIFO 0.
FSP_SIGNAL_USB_FIFO_1 USB FIFO 1.
FSP_SIGNAL_USB_INT USB INT.
FSP_SIGNAL_USB_RESUME USB RESUME.

FSP_SIGNAL_USB_USB_INT RESUME

USB USB INT RESUME.

FSP_SIGNAL_WDT_UNDERFLOW

WDT UNDERFLOW.
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¢ bsp_warm_start_event_t

enum bsp_warm_start_event _t

Different warm start entry locations in the BSP.

Enumerator

BSP_WARM_START RESET

Called almost immediately after reset. No C
runtime environment, clocks, or IRQs.

BSP_WARM_START_POST CLOCK

Called after clock initialization. No C runtime
environment or IRQs.

BSP_WARM_START _POST C

Called after clocks and C runtime environment
have been set up.

¢ bsp_delay_units_t

enum bsp_delay_units_t

microseconds

Available delay units for R_ BSP_SoftwareDelay(). These are ultimately used to calculate a total # of

Enumerator

BSP_DELAY_UNITS_SECONDS

Requested delay amount is in seconds.

BSP_DELAY_UNITS_MILLISECONDS

Requested delay amount is in milliseconds.

BSP_DELAY_UNITS_MICROSECONDS

Requested delay amount is in microseconds.
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¢ bsp _grp_irq_t

enum bsp_grp_irg_t

Which interrupts can have callbacks registered.

Enumerator

BSP_GRP_IRQ_IWDT_ERROR IWDT underflow/refresh error has occurred.

BSP_GRP_IRQ_WDT_ERROR WDT underflow/refresh error has occurred.

BSP_GRP_IRQ_LVD1 Voltage monitoring 1 interrupt.

BSP_GRP_IRQ_LVD2 Voltage monitoring 2 interrupt.

BSP_GRP_IRQ_VBATT VBATT monitor interrupt.

BSP_GRP_IRQ_OSC_STOP_DETECT Oscillation stop is detected.

BSP_GRP_IRQ_NMI_PIN NMI Pin interrupt.

BSP_GRP_IRQ_RAM_PARITY RAM Parity Error.
BSP_GRP_IRQ_RAM_ECC RAM ECC Error.
BSP_GRP_IRQ_MPU_BUS_SLAVE MPU Bus Slave Error.
BSP_GRP_IRQ_MPU_BUS_MASTER MPU Bus Master Error.
BSP_GRP_IRQ_MPU_STACK MPU Stack Error.
BSP_GRP_IRQ_TRUSTZONE MPU Stack Error.
BSP_GRP_IRQ_CACHE_PARITY MPU Stack Error.
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¢ bsp_reg_protect_t

enum bsp_reg_protect t

The different types of registers that can be protected.

Enumerator

BSP_REG_PROTECT_CGC Enables writing to the registers related to the
clock generation circuit.

BSP_REG_PROTECT_OM_LPC_BATT Enables writing to the registers related to
operating modes, low power consumption, and
battery backup function.

BSP_REG_PROTECT_LVD Enables writing to the registers related to the
LVD: LVCMPCR, LVDLVLR, LVD1CRO, LVD1CR1,
LVD1SR, LVD2CRO, LVD2CR1, LVD2SR.

BSP_REG_PROTECT_SAR Enables writing to the registers related to the
security function.

Function Documentation

4 R_FSP_VersionGet()

fsp_err t R_FSP_VersionGet ( fsp_pack version_t *const p version)

Get the FSP version based on compile time macros.

Parameters

[out] p_version Memory address to return
version information to.

Return values
FSP_SUCCESS Version information stored.

FSP_ERR_ASSERTION The parameter p_version is NULL.

¢ Reset_Handler()

void Reset Handler ( void )

MCU starts executing here out of reset. Main stack pointer is set up already.
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¢ Default_Handler()

void Default Handler ( void )

Default exception handler.

4 NMI_Handler()

void NMI_Handler ( void )

Non-maskable interrupt handler. This exception is defined by the BSP, unlike other system
exceptions, because there are many sources that map to the NMI exception.

¢ Systeminit()

void Systemilnit ( void )

Initialize the MCU and the runtime environment.

4 R_BSP_WarmsStart()

void R_BSP_WarmStart ( bsp_warm_start_event t event)

This function is called at various points during the startup process. This function is declared as a
weak symbol higher up in this file because it is meant to be overridden by a user implemented
version. One of the main uses for this function is to call functional safety code during the startup
process. To use this function just copy this function into your own code and modify it to meet your
needs.

Parameters

[in] event Where the code currently is
in the start up process

¢ R_FSP_CurrentirqGet()

__STATIC_INLINE IRQn_Type R_FSP_CurrentlrgGet ( void )

Return active interrupt vector number value

Returns
Active interrupt vector number value
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¢ R_FSP_SystemClockHzGet()

__STATIC_INLINE uint32_t R_FSP_SystemClockHzGet ( fsp_priv_clock_t clock)

Gets the frequency of a system clock.

Returns
Frequency of requested clock in Hertz.

4 R_BSP_UniqueldGet()

__STATIC_INLINE bsp_unique_id_t const* R_BSP_UniqueldGet ()

Get unique ID for this device.

Returns
A pointer to the unique identifier structure

4 R_BSP_FlashCacheDisable()

__STATIC_INLINE void R_BSP_FlashCacheDisable ( )

Disables the flash cache.

4 R_BSP_FlashCacheEnable()

__STATIC_INLINE void R_BSP_FlashCacheEnable ()

Enables the flash cache.
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¢ R_BSP_SoftwareDelay()

void R_BSP_SoftwareDelay ( uint32_t delay, bsp_delay_units _t units )

Delay for at least the specified duration in units and return.

Parameters
[in] delay The number of 'units' to
delay.
[in] units The 'base’

(bsp_delay_units_t) for the
units specified. Valid values
are:

BSP_DELAY _UNITS_SECONDS
, BSP_DELAY_UNITS_MILLISE
CONDS, BSP_DELAY_UNITS _
MICROSECONDS.

For example:

At 1 MHz one cycle takes 1
microsecond (.000001
seconds).

At 12 MHz one cycle takes
1/12 microsecond or 83
nanoseconds.

Therefore one run through b
sp_prv_software_delay_loop(
) takes: ~ (83 *

BSP_DELAY LOOP_CYCLES)
or 332 ns. A delay of 2 us
therefore requires
2000ns/332ns or 6 loops.

The 'theoretical' maximum delay that may be obtained is determined by a full 32 bit loop count
and the system clock rate. @120MHz: ((OxFFFFFFFF loops * 4 cycles /loop) / 120000000) = 143
seconds. @32MHz: ((OxFFFFFFFF loops * 4 cycles /loop) / 32000000) = 536 seconds

Note that requests for very large delays will be affected by rounding in the calculations and the
actual delay achieved may be slightly longer. @32 MHz, for example, a request for 532 seconds will
be closer to 536 seconds.

Note also that if the calculations result in a loop_cnt of zero, the bsp_prv_software_delay _loop()
function is not called at all. In this case the requested delay is too small (nanoseconds) to be
carried out by the loop itself, and the overhead associated with executing the code to just get to
this point has certainly satisfied the requested delay.

Note
Thisfunction callsbsp_cpu_clock get() which ultimately callsR_ CGC_SystemClockFreqGet() and therefore
requires that the BSP has already initialized the CGC (which it does as part of the Sysinit). Care should be taken to
ensure this remains the case if in the future this function were to be called as part of the BSP initialization.
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4 R_BSP_GrouplrqWrite()

fsp_err_t R_BSP_GrouplrgWrite ( bsp _grp_irg_t irq, void(*)(bsp_grp_irq_t irq) p_callback )

Register a callback function for supported interrupts. If NULL is passed for the callback argument
then any previously registered callbacks are unregistered.

Parameters
[in] irq Interrupt for which to
register a callback.
[in] p_callback Pointer to function to call
when interrupt occurs.

Return values
FSP_SUCCESS Callback registered

FSP_ERR_ASSERTION Callback pointer is NULL

& R_BSP_RegisterProtectEnable()

void R_BSP_RegisterProtectEnable ( bsp reg protect t regs to protect)

Enable register protection. Registers that are protected cannot be written to. Register protection is
enabled by using the Protect Register (PRCR) and the MPC's Write-Protect Register (PWPR).

Parameters

[in] regs_to_protect Registers which have write
protection enabled.

& R_BSP_RegisterProtectDisable()

void R_BSP_RegisterProtectDisable ( bsp _reg protect t regs to unprotect)

Disable register protection. Registers that are protected cannot be written to. Register protection is
disabled by using the Protect Register (PRCR) and the MPC's Write-Protect Register (PWPR).

Parameters

[in] regs _to _unprotect Registers which have write
protection disabled.

Variable Documentation
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¢ SystemCoreClock

uint32_t SystemCoreClock

System Clock Frequency (Core Clock)

4.1.2.1 RA2A1

BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra2al_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO0 register settings e [WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

OFSO register settings
> Independent WDT >
Timeout Period

OFSO0 register settings
> Independent WDT >
Dedicated Clock
Frequency Divisor

OFSO0 register settings
> Independent WDT >
Window End Position

OFSO register settings
> Independent WDT >
Window Start Position

OFSO register settings

automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled
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> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO register settings e Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO0 register settings
> WDT > Start Mode
Select

Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%
¢ 0% (no window

end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
* 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset ¢ Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

Stop counting
when entering
Sleep mode
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OFS1 register settings
> Voltage Detection 0
Circuit Start

OFS1 register settings
> Voltage Detection 0
Level

OFS1 register settings
> HOCO Oscillation
Enable

MPU > Enable or
disable PC Region 0

MPU > PCO Start

MPU > PCO End

MPU > Enable or
disable PC Region 1

MPU > PC1 Start

MPU > PC1 End

MPU > Enable or
disable Memory Region
0

e Voltage monitor Voltage monitor 0 reset

O reset is
enabled after
reset

¢ Voltage monitor
0 reset is
disabled after
reset

3.84V
2.82V
251V
190V
1.70Vv

HOCO oscillation is
enabled after reset

e Enabled
e Disabled

Value must be an
integer between 0 and
Ox000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxOO0O0FFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
Ox000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO00OFFFFF (ROM) or
between 0x1FF00003
and 0x200FFFFF (RAM)

e Enabled
¢ Disabled

is disabled after reset

190V

HOCO oscillation is
enabled after reset

HOCO must be enabled
out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.

Disabled

O0xO000FFFFC

Ox000FFFFF

Disabled

0x000FFFFC

Ox000FFFFF

Disabled
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MPU > Memory Region Value must be an Ox000FFFFC
0 Start integer between 0 and

0x000FFFFC
MPU > Memory Region Value must be an 0x000FFFFF
0 End integer between

0x00000003 and

Ox000FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an 0x200FFFFC
1 Start integer between

O0x1FF00000 and

0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between

0x1FF00003 and

Ox200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
2 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and Ox407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between

0x400C0003 and

Ox400DFFFF or

between 0x40100003

and 0x407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
3
MPU > Memory Region Value must be an O0x400DFFFC
3 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and 0x407FFFFC
MPU > Memory Region Value must be an 0x400DFFFF
3 End integer between

0x400C0003 and

0x400DFFFF or

between 0x40100003

and 0x407FFFFF
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Use Low Voltage Mode ¢ Enabled
* Disabled

Main Oscillator Wait
Time

2 cycles

1024 cycles
2048 cycles
4096 cycles
8192 cycles
16384 cycles
32768 cycles
e 65536 cycles
131072 cycles
e 262144 cycles

ID Code Mode e Unlocked

(Ignore ID)

e Locked with All
Erase support

e Locked

ID Code (32 Hex
Characters)

Value must be a 32
character long hex
string

Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

Disabled

262144 cycles

Unlocked (Ignore ID)

FFFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFF

Use the low voltage
mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

Number of cycles to
wait for the main
oscillator clock to
stabilize.

When set to 'Locked
with All Erase support',
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

enum elc_event_t

Note
Thislist may change based on based on the device.

Sources of event signals to be linked to other peripherals or the CPU
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4.1.2.2 RA2E1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra2el_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO0 register settings e [WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

automatically
activated after

a reset
(Autostart
mode)
OFSO register settings e 128 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1
> Independent WDT > * 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO register settings e 75%
> Independent WDT > e 50%
Window End Position e 25%
e 0% (no window

end position)

OFSO register settings e 25%
> Independent WDT > e 50%
Window Start Position e 75%

e 100% (no
window start
position)

OFSO0 register settings ¢ NMI request or
> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled

e Resetis
enabled

OFSO register settings ¢ Counting

2048 cycles

128

0% (no window end
position)

100% (no window start

position)

Reset is enabled

Stop counting when in
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> Independent WDT > continues Sleep, Snooze mode, or
Stop Control ¢ Stop counting Software Standby
when in Sleep,
Snooze mode,
or Software

Standby
OFSO register settings e Automatically Stop WDT after a reset
> WDT > Start Mode activate WDT (register-start mode)
Select after a reset

(auto-start

mode)

e Stop WDT after
a reset (register-
start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO0 register settings e 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%

¢ 0% (no window
end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
* 100% (no

window start

position)
OFSO register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO0 register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings e Type B Type A
> Internal Clock Supply e Type A
Architecture Type
OFS1 register settings e Voltage monitor Voltage monitor 0 reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
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reset

¢ Voltage monitor
O reset is
disabled after
reset

3.84V 190V
282V
251V
190V
1.70V

OFS1 register settings
> Voltage Detection 0
Level

OFS1 register settings e HOCO HOCO oscillation is HOCO must be enabled
> HOCO Oscillation oscillation is enabled after reset out of reset because
Enable enabled after the MCU starts up in
reset low voltage mode and
e HOCO the HOCO must be
oscillation is operating in low
disabled after voltage mode.
reset

MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled

MPU > PCO Start Value must be an OxO000FFFFC
integer between 0 and
OxO000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

MPU > PCO End Value must be an OxO00FFFFF
integer between
0x00000003 and
0x000FFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

MPU > Enable or e Enabled Disabled
disable PC Region 1 e Disabled

MPU > PC1 Start Value must be an OxO000FFFFC
integer between 0 and
Ox000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

MPU > PC1 End Value must be an OxO00FFFFF
integer between
0x00000003 and
OxO0O0OFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0

MPU > Memory Region Value must be an OxO00O0FFFFC
0 Start integer between 0 and
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Ox000FFFFC
MPU > Memory Region Value must be an OxO00FFFFF
0 End integer between

0x00000003 and

Ox000FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an 0x200FFFFC
1 Start integer between

Ox1FF00000 and

0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between

0x1FF00003 and

0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
2 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and Ox407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between

0x400C0003 and

Ox400DFFFF or

between 0x40100003

and Ox407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
3
MPU > Memory Region Value must be an 0x400DFFFC
3 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and 0x407FFFFC
MPU > Memory Region Value must be an 0x400DFFFF

3 End

Use Low Voltage Mode

integer between
0x400C0003 and
Ox400DFFFF or

between 0x40100003

and 0x407FFFFF
Not Supported

config.bsp.low_voltage_

mode.disabled

Use the low voltage
mode. This limits the

R11UMO0155EU0230 Revision 2.30
Sep.10.2021

RLENESAS

Page 179/2,794



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package > RA2E1

ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

Main Oscillator Wait e 2 cycles 262144 cycles Number of cycles to
Time e 1024 cycles wait for the main
e 2048 cycles oscillator clock to
¢ 4096 cycles stabilize.
e 8192 cycles
e 16384 cycles
e 32768 cycles
* 65536 cycles
e 131072 cycles
e 262144 cycles
ID Code Mode ¢ Unlocked Unlocked (Ignore ID) When set to 'Locked
(lgnore ID) with All Erase support',
e Locked with All the ID Code must be
Erase support set in the debugger to
e Locked read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.
ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
string This setting is only
used when the ID Code
Mode is not set to
Unlocked.
Enumerations
enum elc_event_t
enum icu_event t
Enumeration Type Documentation
¢ elc_event_t
enum elc_event t
Sources of event signals to be linked to other peripherals or the CPU
Note
Thislist may change based on based on the device.
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¢ icu_event_t

enum icu_event t

Events to be used with the IELSR register to link interrupt events to the NVIC

Note

Thislist is device specific.

4.1.2.3 RA2L1
BSP » MCU Board Support Package

Functions

bsp_power mode t R _BSP PowerModeSet (bsp_power mode_t mode)

Detailed Description

Build Time Configurations for ra2ll_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

automatically
activated after

a reset
(Autostart
mode)
OFSO0 register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor e 64
e 128
e 256
OFSO register settings e 75% 0% (no window end
> Independent WDT > * 50% position)
Window End Position * 25%
* 0% (no window

end position)
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OFSO register settings e 25% 100% (no window start
> Independent WDT > * 50% position)
Window Start Position e 75%
* 100% (no
window start
position)

OFSO0 register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Reset is
enabled
OFSO register settings e Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO0 register settings
> WDT > Start Mode
Select

Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
* 100% (no
window start
position)
OFSO0 register settings e NMI Reset
> WDT > Reset e Reset
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Interrupt Request

OFSO register settings
> WDT > Stop Control

OFS1 register settings
> Internal Clock Supply
Architecture Type

OFS1 register settings
> Voltage Detection 0
Circuit Start

OFS1 register settings
> Voltage Detection 0
Level

OFS1 register settings
> HOCO Oscillation
Enable

MPU > Enable or
disable PC Region 0

MPU > PCO Start

MPU > PCO End

MPU > Enable or
disable PC Region 1

MPU > PC1 Start

Counting
continues
Stop counting
when entering
Sleep mode

Type B
Type A

Voltage monitor
0 reset is
enabled after
reset

Voltage monitor
O reset is
disabled after
reset

3.84V
282V
251V
190V
1.70V

HOCO
oscillation is
enabled after
reset

HOCO
oscillation is
disabled after
reset

Enabled
Disabled

Value must be an
integer between 0 and
OxO000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
0x000FFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

Enabled
Disabled

Value must be an
integer between 0 and
OxO000FFFFC (ROM) or
between 0x1FF00000

Stop counting when
entering Sleep mode

Type A

Voltage monitor 0 reset
is disabled after reset

190V

HOCO oscillation is HOCO must be enabled

enabled after reset out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.

Disabled

Ox000FFFFC

OxO000FFFFF

Disabled

Ox000FFFFC
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MPU > PC1 End Value must be an OxOOOFFFFF

integer between

0x00000003 and

Ox000FFFFF (ROM) or

between 0x1FFO0003

and Ox200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
0
MPU > Memory Region Value must be an 0x000FFFFC
0 Start integer between 0 and

Ox000FFFFC
MPU > Memory Region Value must be an OxO00FFFFF
0 End integer between

0x00000003 and

Ox000FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an 0x200FFFFC
1 Start integer between

0x1FF00000 and

0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between

0x1FF00003 and

0x200FFFFF
MPU > Enable or ¢ Enabled Disabled
disable Memory Region ¢ Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
2 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and Ox407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between

0x400C0003 and

0Ox400DFFFF or

between 0x40100003

and Ox407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
3
MPU > Memory Region Value must be an 0x400DFFFC
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3 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

MPU > Memory Region Value must be an 0x400DFFFF
3 End integer between

0x400C0003 and

Ox400DFFFF or

between 0x40100003

and 0x407FFFFF

Power > DC-DC e Disabled Disabled To use the DCDC
Regulator e Enabled regulator an external
e Enabled at inductor and capacitor
startup must be connected as

specified in chapter 40
of the RA2L1 manual.
In addition the supply
voltage must be above
2.4V and ICLK must be
2 MHz or higher.

When set to 'Enabled
at startup' the BSP will
switch to the DCDC
regulator during
startup using the
voltage range specified

below.
Power > DC-DC Supply e 2.4V to 2.7V 2.7V to 3.6V Set this to the
Range e 2.7V to 3.6V expected MCU supply
e 3.6V to 4.5V voltage (Vcc) at startup
e 45V to 5.5V when using the DCDC
regulator.
Use Low Voltage Mode Not Supported config.bsp.low_voltage_ Use the low voltage
mode.disabled mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.
Main Oscillator Wait e 2 cycles 262144 cycles Number of cycles to
Time e 1024 cycles wait for the main
e 2048 cycles oscillator clock to
e 4096 cycles stabilize.
e 8192 cycles
e 16384 cycles
e 32768 cycles
e 65536 cycles
e 131072 cycles
e 262144 cycles
R11UMO0155EU0230 Revision 2.30 RLENESAS Page 185/ 2,794

Sep.10.2021



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package > RA2L1

ID Code Mode ¢ Unlocked Unlocked (Ignore ID) When set to 'Locked
(lgnore ID) with All Erase support',

e Locked with All the ID Code must be
Erase support set in the debugger to

e Locked read or write data to

the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is

provided.
ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
string This setting is only

used when the ID Code
Mode is not set to
Unlocked.

Common macro for FSP header files. There is also a corresponding FSP_FOOTER macro at the end of
this file.

Enumerations

enum elc_event t
enum icu_event_t

enum bsp _power_mode_t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist may change based on based on the device.

¢ icu_event_t

enum icu_event t

Events to be used with the IELSR register to link interrupt events to the NVIC

Note

Thislist is device specific.
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¢ bsp_power_mode_t

enum bsp_power_mode_t
Voltage regulator mode

Enumerator
BSP_POWER _MODE_DCDC 2V4 TO 2V7 DCDC mode; 2.4V to 2.7V supply.
BSP_POWER_MODE_DCDC 2V7 _TO _3V6 DCDC mode; 2.7V to 3.6V supply.
BSP_POWER_MODE _DCDC 3V6 _TO 4V5 DCDC mode; 3.6V to 4.5V supply.
BSP_POWER_MODE_DCDC _4V5 TO 5V5 DCDC mode; 4.5V to 5.5V supply.
BSP_POWER_MODE_LDO LDO mode.

Function Documentation

¢ R_BSP_PowerModeSet()

bsp_power mode t R_BSP_PowerModeSet ( bsp_power mode t mode)

Select either the LDO or DCDC regulator and/or update the MCU supply voltage range. Returns the
previously selected mode.

Note
DCDC mode has the following limitations:
o Supply voltage must be 2.4V or greater
o Low- and Subosc-speed modes are not available
o Software Sandby is not available Ensure these limitations are respected before entering DCDC mode.
If supply voltage may drop below 2.4V during operation, configure a LVD channel to interrupt or reset
the MCU near this threshold to switch back to the LDO.
Switching to DCDC mode temporarily disables all interrupts and blocks for 22 microseconds; switching to LDO
from DCDC temporarily disables all peripherals and interrupts and blocks for 60 microseconds.
If the supply voltage falls outside the range originally specified when starting the DCDC regulator, call this
function again with the updated supply voltage.
Returns
The previously selected power mode.

4.1.2.4 RA4E1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radel_fsp
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The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
Security > Exceptions ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
> Exception Response Interrupt a TrustZone Filter

¢ Reset exception. This

exception is generated
when a the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions ¢ Non-Secure Secure State Value for SCB->AIRCR
> BusFault, HardFault, State register bit
and NMI Target e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions ¢ Enabled Disabled Value for SCB->AIRCR
> Prioritize Secure * Disabled register bit PRIS. When
Exceptions enabled, all Non-secure

interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with

TrustZone.
Security > SRAM ¢ Both Secure Both Secure and Non-  Defines whether
Accessibility > SRAM and Non-Secure Secure State SRAMPRCR is write
Protection State accessible for the Non-
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Security > SRAM
Accessibility > SRAM
ECC

Security > SRAM
Accessibility > Standby
RAM

Security > BUS
Accessibility > Bus
Security Attribution
Register A

Secure State

Both Secure
and Non-Secure
State

Secure State

Regions 7-0 are
all Secure.
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.
Regions 7-0 are
all Non-secure.

Both Secure
and Non-Secure
State

Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

Both Secure and Non-
Secure State

secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.
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Security > BUS
Accessibility > Bus
Security Attribution
Register B

Security > System
Reset Request
Accessibility

Security > System
Reset Status
Accessibility

Security > Battery
Backup Accessibility

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure and Non-
Secure State

Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
reset status registers
(RSTSRN) can be
cleared from the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRN
registers which are
both read and write
protected.

This setting is only
valid when building
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projects with

TrustZone.
OFSO0 register settings e |[WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

automatically
activated after
a reset

(Autostart
mode)
OFSO0 register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO register settings e 75% 0% (no window end
> Independent WDT > * 50% position)
Window End Position * 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> Independent WDT > e 50% position)
Window Start Position e 75%
¢ 100% (no
window start
position)

OFSO0 register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO register settings ¢ Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software

Software Standby
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OFSO0 register settings e Automatically Stop WDT after a reset
> WDT > Start Mode activate WDT (register-start mode)
Select after a reset

(auto-start

mode)

e Stop WDT after
a reset (register-
start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings e 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End e 50% position)
Position * 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
* 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset ¢ Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

¢ Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor 0 reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after

reset

¢ Voltage monitor

0 reset is

disabled after

reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
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OFS1 register settings ¢ HOCO HOCO oscillation is

> HOCO Oscillation
Enable

oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after

enabled after reset

reset
Block Protection Refer to the RA ou Configure Block
Settings (BPS) > BPS Configuration tool for Protection Register
available options.
Permanent Block Refer to the RA ou Configure Permanent
Protection Settings Configuration tool for Block Protection
(PBPS) > PBPS available options. Register
Clocks > HOCO FLL ¢ Enabled Disabled Setting this option to
Function ¢ Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.
The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.
When FLL is enabled
Software Standby and
Deep Software Standby
modes are not
available.
Main Oscillator Wait e 3 cycles 8163 cycles Number of cycles to
Time e 35 cycles wait for the main
* 67 cycles oscillator clock to
e 131 cycles stabilize.
e 259 cycles
e 547 cycles
e 1059 cycles
e 2147 cycles
e 4291 cycles
e 8163 cycles
Enumerations
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enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Note

Thislist may change based on based on the device.

Sources of event signals to be linked to other peripherals or the CPU

4.1.2.5 RAAM1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radm1l_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO0 register settings e I[WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

automatically
activated after
a reset
(Autostart
mode)
OFSO0 register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor e 64
e 128
e 256
OFSO register settings e 75% 0% (no window end
> Independent WDT > * 50% position)
Window End Position e 25%
* 0% (no window

end position)

OFSO0 register settings e 25%

100% (no window start
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> Independent WDT > * 50% position)
Window Start Position e 75%
e 100% (no
window start
position)

OFSO0 register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO register settings e Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO0 register settings
> WDT > Start Mode
Select

Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position * 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
¢ 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset ¢ Reset
Interrupt Request
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OFSO0 register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode
¢ Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
¢ Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 3.84V 1.90V
> Voltage Detection 0 e 282V
Level e 251V
e 190V
e 1.70V
OFS1 register settings  HOCO oscillation is HOCO oscillation is HOCO must be enabled
> HOCO Oscillation enabled after reset enabled after reset out of reset because
Enable the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.
MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled
MPU > PCO Start Value must be an OXOO0FFFFFC
integer between 0 and
OX00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)
MPU > PCO End Value must be an OXxOOFFFFFF
integer between
0x00000003 and
OxOOFFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)
MPU > Enable or e Enabled Disabled
disable PC Region 1 e Disabled
MPU > PC1 Start Value must be an OXO0O0FFFFFC
integer between 0 and
Ox00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)
MPU > PC1 End Value must be an OxOOFFFFFF
integer between
0x00000003 and
OxOOFFFFFF (ROM) or
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between 0x1FF00003
and 0x200FFFFF (RAM)
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MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0
MPU > Memory Region Value must be an OXO0O0FFFFFC
0 Start integer between 0 and

OxO00FFFFFC
MPU > Memory Region Value must be an OXxOOFFFFFF
0 End integer between

0x00000003 and

OxOOFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between

0x1FF00000 and

0x200FFFFC
MPU > Memory Region Value must be an 0x200FFFFF
1 End integer between

0x1FF00003 and

0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
2 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and 0x407FFFFC
MPU > Memory Region Value must be an 0x407FFFFF
2 End integer between

0x400C0003 and

Ox400DFFFF or

between 0x40100003

and Ox407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
3
MPU > Memory Region Value must be an Ox400DFFFC
3 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and 0x407FFFFC
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Value must be an
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

MPU > Memory Region
3 End

Use Low Voltage Mode e Enabled
¢ Disabled

Main Oscillator Wait
Time

2 cycles

1024 cycles
2048 cycles
4096 cycles
8192 cycles
16384 cycles
32768 cycles
65536 cycles
131072 cycles
262144 cycles

ID Code Mode

Unlocked

(Ilgnore ID)

e Locked with All
Erase support

e Locked

ID Code (32 Hex Value must be a 32

Characters) character long hex
string
Enumerations
enum elc_event_t

Enumeration Type Documentation

O0x400DFFFF

Disabled

262144 cycles

Unlocked (Ignore ID)

FFFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFF

Use the low voltage
mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least
4,

Number of cycles to
wait for the main
oscillator clock to
stabilize.

When set to 'Locked
with All Erase support',
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.
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¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist may change based on based on the device.

4.1.2.6 RAAM2
BSP » MCU Board Support Package

Build Time Configurations for radm2_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options Default Description
Security > Exceptions ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
> Exception Response Interrupt a TrustZone Filter

¢ Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions ¢ Non-Secure Secure State Value for SCB->AIRCR
> BusFault, HardFault, State register bit
and NMI Target e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions ¢ Enabled Disabled Value for SCB->AIRCR
> Prioritize Secure ¢ Disabled register bit PRIS. When
Exceptions enabled, all Non-secure

interrupt priorities are
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Security > SRAM
Accessibility > SRAM
Protection

Security > SRAM
Accessibility > SRAM
ECC

Security > SRAM

Accessibility > Standby

RAM

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Regions 7-0 are
all Secure.
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.
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Security > BUS
Accessibility > Bus
Security Attribution
Register A

Security > BUS
Accessibility > Bus
Security Attribution
Register B

Security > System
Reset Request
Accessibility

Security > Cache
Accessibility

Regions 2-0 are
Secure.
Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.
Regions 7-0 are
all Non-secure.

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Secure State
and Non-Secure
State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
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valid when building
protjects with

TrustZone.
Security > System e Both Secure Both Secure and Non-  Defines whether the
Reset Status and Non-Secure Secure State reset status registers
Accessibility State (RSTSRN) can be
e Secure State cleared from the Non-

secure application.

This setting is only
valid when building
projects with

TrustZone.
Security > Battery e Both Secure Both Secure and Non-  Defines whether the
Backup Accessibility and Non-Secure Secure State battery backup
State registers are accessible
e Secure State for the Non-secure

application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRn
registers which are
both read and write
protected.

This setting is only
valid when building
projects with

TrustZone.
OFSO0 register settings e [WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is
automatically
activated after
a reset
(Autostart
mode)
OFSO0 register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO register settings e 75% 0% (no window end
> Independent WDT > * 50% position)
Window End Position * 25%
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0% (no window
end position)

OFSO register settings * 25% 100% (no window start
> Independent WDT > e 50% position)
Window Start Position e 75%
e 100% (no
window start
position)

OFSO register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO register settings ¢ Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO0 register settings
> WDT > Start Mode
Select

(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%
¢ 0% (no window
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end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
e 100% (no

window start

position)
OFSO register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
* Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings ¢ HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after
reset
e HOCO

oscillation is
disabled after
reset

Block Protection Refer to the RA ou Configure Block

Settings (BPS) > BPSO

Configuration tool for
available options.

Protection Register 0

Sep.10.2021

Permanent Block Refer to the RA ou Configure Permanent

Protection Settings Configuration tool for Block Protection

(PBPS) > PBPSO available options. Register 0

Clocks > HOCO FLL ¢ Enabled Disabled Setting this option to

Function e Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.
The FLL function
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requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Startup C-Cache Line e 32 Bytes 32 Bytes Set the C-Cache line
Size * 64 Bytes size configured during
startup.
Main Oscillator Wait e 3 cycles 8163 cycles Number of cycles to
Time e 35 cycles wait for the main
e 67 cycles oscillator clock to
e 131 cycles stabilize.
e 259 cycles
e 547 cycles
e 1059 cycles
e 2147 cycles
e 4291 cycles
e 8163 cycles

4.1.2.7 RAAM3
BSP » MCU Board Support Package

Build Time Configurations for radm3_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
Security > Exceptions * Non-Maskable Non-Maskable Interrupt Configure the result of
> Exception Response Interrupt a TrustZone Filter

¢ Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.
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Security > Exceptions
> BusFault, HardFault,
and NMI Target

Security > Exceptions
> Prioritize Secure
Exceptions

Security > SRAM
Accessibility > SRAM
Protection

Security > SRAM
Accessibility > SRAM
ECC

* Non-Secure
State
e Secure State

e Enabled
e Disabled

e Both Secure
and Non-Secure
State

e Secure State

e Both Secure
and Non-Secure
State

e Secure State

Secure State

Disabled

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit

BFHFNMINS. Defines
whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit PRIS. When
enabled, all Non-secure
interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.
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Security > SRAM

Accessibility > Standby

RAM

Security > BUS
Accessibility > Bus
Security Attribution
Register A

Security > BUS
Accessibility > Bus
Security Attribution
Register B

Regions 7-0 are config.bsp.fsp.tz.stbra
all Secure. msar.both
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.
Regions 7-0 are
all Non-secure.

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.
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Security > System
Reset Request
Accessibility

Security > Cache
Accessibility

Security > System
Reset Status
Accessibility

Security > Battery
Backup Accessibility

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
TrustZone.

Defines whether the
reset status registers
(RSTSRN) can be
cleared from the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRn
registers which are
both read and write
protected.

This setting is only
valid when building
projects with
TrustZone.
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OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

automatically
activated after
a reset

(Autostart
mode)
OFSO register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO0 register settings e 1 128
> Independent WDT > * 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO register settings e 75% 0% (no window end
> Independent WDT > e 50% position)
Window End Position e 25%
¢ 0% (no window

end position)

OFSO register settings e 25% 100% (no window start
> Independent WDT > * 50% position)
Window Start Position e 75%
e 100% (no
window start
position)

OFSO register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO0 register settings e Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO0 register settings

(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically

Software Standby

Stop WDT after a reset
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> WDT > Start Mode activate WDT (register-start mode)
Select after a reset

(auto-start

mode)

e Stop WDT after
a reset (register-
start mode)

OFSO register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO0 register settings e 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%

¢ 0% (no window
end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
e 100% (no

window start

position)
OFSO register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings ¢ Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after

reset

e Voltage monitor

0 reset is

disabled after

reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
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Enable

enabled after
reset

e HOCO
oscillation is
disabled after

reset
Block Protection Refer to the RA ou Configure Block
Settings (BPS) > BPSO  Configuration tool for Protection Register O
available options.
Block Protection e Flash Block 32 0U Configure Block
Settings (BPS) > BPS1 e Flash Block 33 Protection Register 1
e Flash Block 34
e Flash Block 35
e Flash Block 36
e Flash Block 37
Permanent Block Refer to the RA ou Configure Permanent
Protection Settings Configuration tool for Block Protection
(PBPS) > PBPSO available options. Register 0
Permanent Block e Flash Block 32 0OU Configure Permanent
Protection Settings ¢ Flash Block 33 Block Protection
(PBPS) > PBPS1 e Flash Block 34 Register 1
e Flash Block 35
e Flash Block 36
e Flash Block 37
Clocks > HOCO FLL e Enabled Disabled Setting this option to
Function e Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.
The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.
When FLL is enabled
Software Standby and
Deep Software Standby
modes are not
available.
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Startup C-Cache Line e 32 Bytes 32 Bytes Set the C-Cache line
Size e 64 Bytes size configured during
startup.

Main Oscillator Wait e 3 cycles 8163 cycles Number of cycles to
Time e 35 cycles wait for the main

e 67 cycles oscillator clock to

e 131 cycles stabilize.

e 259 cycles

e 547 cycles

e 1059 cycles

e 2147 cycles

e 4291 cycles

e 8163 cycles

4.1.2.8 RA4AW1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radwl_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

automatically
activated after

a reset
(Autostart
mode)
OFSO register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO0 register settings e 1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO0 register settings e 75% 0% (no window end
> Independent WDT > * 50% position)
Window End Position e 25%
e 0% (no window

end position)
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OFSO register settings e 25% 100% (no window start
> Independent WDT > * 50% position)
Window Start Position e 75%
* 100% (no
window start
position)

OFSO0 register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Reset is
enabled
OFSO register settings e Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO0 register settings
> WDT > Start Mode
Select

Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position e 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
* 100% (no
window start
position)
OFSO0 register settings e NMI Reset
> WDT > Reset e Reset
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Interrupt Request

OFSO register settings
> WDT > Stop Control

OFS1 register settings
> Voltage Detection 0
Circuit Start

OFS1 register settings
> Voltage Detection 0
Level

OFS1 register settings
> HOCO Oscillation
Enable

MPU > Enable or
disable PC Region 0

MPU > PCO Start

MPU > PCO End

MPU > Enable or
disable PC Region 1

MPU > PC1 Start

MPU > PC1 End

MPU > Enable or
disable Memory Region

¢ Counting
continues

e Stop counting
when entering
Sleep mode

¢ Voltage monitor
O reset is
enabled after
reset

¢ Voltage monitor
0 reset is
disabled after
reset

2.82V
251V
190V

HOCO oscillation is
enabled after reset

e Enabled
e Disabled

Value must be an
integer between 0 and
OxOO0FFFFFC (ROM) or
between 0x1FF00000
and Ox200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO0FFFFFF (ROM) or
between 0x1FF00003
and 0x200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
OxO00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO0FFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
e Disabled

Stop counting when
entering Sleep mode

Voltage monitor 0 reset
is disabled after reset

190V

config.bsp.fsp.OFS1.ho
co_osc.disabled

Disabled

OxO0OFFFFFC

OXOOFFFFFF

Disabled

OxO0OFFFFFC

OXOOFFFFFF

Disabled
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0
MPU > Memory Region Value must be an OxO0FFFFFC
0 Start integer between 0 and

OxXO00FFFFFC
MPU > Memory Region Value must be an OXOOFFFFFF
0 End integer between

0x00000003 and

OxOOFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between

0x1FF00000 and

0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between

0x1FF00003 and

0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
2
MPU > Memory Region Value must be an Ox407FFFFC
2 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and Ox407FFFFC
MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between

0x400C0003 and

0x400DFFFF or

between 0x40100003

and 0x407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
3
MPU > Memory Region Value must be an 0x400DFFFC
3 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and Ox407FFFFC
MPU > Memory Region Value must be an Ox400DFFFF
3 End integer between

0x400C0003 and

0x400DFFFF or

between 0x40100003
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and Ox407FFFFF

Use Low Voltage Mode e Enabled
e Disabled

Main Oscillator Wait
Time .

2 cycles

1024 cycles
2048 cycles

e 4096 cycles
8192 cycles
16384 cycles
32768 cycles
65536 cycles
131072 cycles
262144 cycles

Unlocked

(Ignore ID)

e Locked with All
Erase support

e Locked

ID Code Mode o

ID Code (32 Hex
Characters)

Value must be a 32
character long hex
string

Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

Disabled

262144 cycles

Unlocked (Ignore ID)

FFFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFF

Use the low voltage
mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least
4.

Number of cycles to
wait for the main
oscillator clock to
stabilize.

When set to 'Locked
with All Erase support’,
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked',
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

enum elc_event t

Note

Sources of event signals to be linked to other peripherals or the CPU1

Thislist may change based on device. Thislist isfor RAAWL.
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4.1.2.9 RAGE1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra6el_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
Security > Exceptions * Non-Maskable Non-Maskable Interrupt Configure the result of
> Exception Response Interrupt a TrustZone Filter

¢ Reset exception. This

exception is generated
when a the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions ¢ Non-Secure Secure State Value for SCB->AIRCR
> BusFault, HardFault, State register bit
and NMI Target e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions e Enabled Disabled Value for SCB->AIRCR
> Prioritize Secure e Disabled register bit PRIS. When
Exceptions enabled, all Non-secure

interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
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Security > SRAM
Accessibility > SRAM
Protection

Security > SRAM
Accessibility > SRAM
ECC

Security > SRAM
Accessibility > Standby
RAM

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Regions 7-0 are
all Secure.
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.
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Security > BUS
Accessibility > Bus
Security Attribution
Register A

Security > BUS
Accessibility > Bus
Security Attribution
Register B

Security > System
Reset Request
Accessibility

Security > Cache
Accessibility

Security > System
Reset Status
Accessibility

Region 0 is
Secure,
Regions 7-0 are
all Non-secure.

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
TrustZone.

Defines whether the
reset status registers
(RSTSRnN) can be
cleared from the Non-
secure application.
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Security > Battery
Backup Accessibility

Both Secure
and Non-Secure
State

Secure State

Both Secure and Non-
Secure State

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRn
registers which are
both read and write
protected.

This setting is only
valid when building
projects with

TrustZone.
OFSO0 register settings e |[WDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e I[WDT is

automatically
activated after
a reset

(Autostart
mode)
OFSO0 register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO register settings e 75% 0% (no window end
> Independent WDT > * 50% position)
Window End Position * 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> Independent WDT > e 50% position)
Window Start Position e 75%
* 100% (no
window start
position)
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OFSO register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO register settings e Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO register settings
> WDT > Start Mode
Select

(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings e 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End e 50% position)
Position * 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
* 100% (no
window start
position)
OFSO0 register settings e NMI Reset
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> WDT > Reset e Reset

Interrupt Request

OFSO0 register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

OFS1 register settings

> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after

reset

e Voltage monitor

0 reset is

disabled after

reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is

> HOCO Oscillation
Enable

e Stop counting
when entering
Sleep mode

¢ Voltage monitor

oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after

Voltage monitor 0 reset

enabled after reset

reset
Block Protection Refer to the RA ou Configure Block
Settings (BPS) > BPSO  Configuration tool for Protection Register 0
available options.

Block Protection e Flash Block 32 0U Configure Block
Settings (BPS) > BPS1 e Flash Block 33 Protection Register 1

e Flash Block 34

e Flash Block 35

e Flash Block 36

e Flash Block 37
Block Protection Refer to the RA ou Configure Block
Settings (BPS) > BPS2  Configuration tool for Protection Register 2

available options.

Permanent Block Refer to the RA ou Configure Permanent
Protection Settings Configuration tool for Block Protection
(PBPS) > PBPSO available options. Register 0
Permanent Block e Flash Block 32 0U Configure Permanent
Protection Settings e Flash Block 33 Block Protection
(PBPS) > PBPS1 e Flash Block 34 Register 1

e Flash Block 35

e Flash Block 36

e Flash Block 37
Permanent Block Refer to the RA ou Configure Permanent
Protection Settings Configuration tool for Block Protection
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(PBPS) > PBPS2 available options. Register 2
Clocks > HOCO FLL e Enabled Disabled Setting this option to
Function e Disabled Enabled improves

HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Startup C-Cache Line e 32 Bytes 32 Bytes Set the C-Cache line
Size e 64 Bytes size configured during
startup.
Dual Bank Mode e Enabled Disabled Enabling dual bank
e Disabled mode splits the flash

into two banks that can
be swapped by
programming the
BANKSEL non-volatile
register. When
enabled, one bank will
start at address 0x0
and the other will start
at 0x200000. Each
bank contains exactly
half the capacity of the
entire code flash. When
Dual Bank mode is
enabled, Startup
Program Protection and
Block Swap functions
cannot be used.

Main Oscillator Wait e 3 cycles 8163 cycles Number of cycles to
Time e 35 cycles wait for the main
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67 cycles
131 cycles
259 cycles
547 cycles
1059 cycles
2147 cycles
4291 cycles
e 8163 cycles

Enumerations

enum elc event t

Enumeration Type Documentation

¢ elc_event_t

oscillator clock to
stabilize.

enum elc_event t

Note

Thislist may change based on based on the device.

Sources of event signals to be linked to other peripherals or the CPU

4.1.2.10 RA6M1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for rabm1_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e |WDT is

automatically
activated after

a reset

(Autostart

mode)
OFSO register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles

e 2048 cycles
OFSO0 register settings o1 128
> Independent WDT > * 16
Dedicated Clock e 32
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Frequency Divisor * 64
e 128
e 256
OFSO0 register settings e 75% 0% (no window end
> Independent WDT > e 50% position)
Window End Position e 25%

0% (no window
end position)

OFSO register settings e 25% 100% (no window start
> Independent WDT > e 50% position)
Window Start Position e 75%
e 100% (no
window start
position)

OFSO register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO0 register settings e Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO0 register settings
> WDT > Start Mode
Select

(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
R11UMO0155EU0230 Revision 2.30 RLENESAS Page 225/ 2,794

Sep.10.2021



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package > RA6M1

e 2048

e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End e 50% position)
Position * 25%

¢ 0% (no window

end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
e 100% (no

window start

position)
OFSO register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings e Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings ¢ Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
* Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings ¢ HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after
reset
e HOCO

oscillation is
disabled after

reset
MPU > Enable or e Enabled Disabled
disable PC Region 0 ¢ Disabled
MPU > PCO Start Value must be an OxFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PCO End Value must be an OXFFFFFFFF

integer between
0x00000003 and
OxXFFFFFFFF
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MPU > Enable or e Enabled Disabled
disable PC Region 1 e Disabled
MPU > PC1 Start Value must be an OXFFFFFFFC
integer between 0 and
OxXFFFFFFFC
MPU > PC1 End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxFFFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0
MPU > Memory Region Value must be an OXO0O0FFFFFC
0 Start integer between 0 and
OxO00FFFFFC
MPU > Memory Region Value must be an OXOOFFFFFF
0 End integer between
0x00000003 and
OXxOOFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an 0x200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between
0x1FF00003 and
Ox200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region * Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
2 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC
MPU > Memory Region Value must be an 0x407FFFFF
2 End integer between
0x400C0003 and
0Ox400DFFFF or
between 0x40100003
and 0x407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
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3
MPU > Memory Region Value must be an 0x400DFFFC
3 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC
MPU > Memory Region Value must be an Ox400DFFFF
3 End integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF
Clocks > HOCO FLL ¢ Enabled Disabled Setting this option to
Function ¢ Disabled Enabled improves

HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Main Oscillator Wait e 35 cycles 8163 cycles Number of cycles to
Time e 67 cycles wait for the main
e 131 cycles oscillator clock to
e 259 cycles stabilize. Drive
e 547 cycles capability automatic
¢ 1059 cycles switching function is by
e 2147 cycles default disabled.
e 4291 cycles
e 8163 cycles
ID Code Mode e Unlocked Unlocked (Ignore ID) When set to 'Locked
(lgnore ID) with All Erase support’,
¢ Locked with All the ID Code must be
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Erase support set in the debugger to

e Locked read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked',
all
erase/download/debug
access is disabled
unless the ID Code is

provided.
ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
string This setting is only

used when the ID Code
Mode is not set to
Unlocked.

Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist may change based on based on the device.

4.1.2.11 RA6M2
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for rabm2_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

automatically
activated after
a reset
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OFSO0 register settings
> Independent WDT >
Timeout Period

OFSO register settings
> Independent WDT >
Dedicated Clock
Frequency Divisor

OFSO register settings
> Independent WDT >
Window End Position

OFSO0 register settings
> Independent WDT >
Window Start Position

OFSO0 register settings
> Independent WDT >
Reset Interrupt
Request Select

OFSO register settings
> Independent WDT >
Stop Control

OFSO register settings
> WDT > Start Mode
Select

(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

e Stop WDT after
a reset (register-
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start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings e 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO register settings e 75% 0% (no window end
> WDT > Window End e 50% position)
Position * 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
* 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

¢ Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor 0 reset
> Voltage Detection 0 O reset is is disabled after reset
Circuit Start enabled after
reset
¢ Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 294V 2.80V
> Voltage Detection O e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after
reset
e HOCO

oscillation is
disabled after
reset
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MPU > Enable or ¢ Enabled Disabled
disable PC Region 0 ¢ Disabled
MPU > PCO Start Value must be an OXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PCO End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable PC Region 1 e Disabled
MPU > PC1 Start Value must be an OXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PC1 End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0
MPU > Memory Region Value must be an OXO0O0FFFFFC
0 Start integer between 0 and
OxO00FFFFFC
MPU > Memory Region Value must be an OXxOOFFFFFF
0 End integer between
0x00000003 and
OXxOOFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an 0x200FFFFF
1 End integer between
0x1FF00003 and
Ox200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
2 Start integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
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MPU > Memory Region Value must be an Ox407FFFFF
2 End integer between
0x400C0003 and
Ox400DFFFF or
between 0x40100003
and 0x407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
3
MPU > Memory Region Value must be an 0x400DFFFC
3 Start integer between
0x400C0000 and
O0x400DFFFC or
between 0x40100000
and 0x407FFFFC
MPU > Memory Region Value must be an 0x400DFFFF
3 End integer between
0x400C0003 and
Ox400DFFFF or
between 0x40100003
and Ox407FFFFF
Clocks > HOCO FLL e Enabled Disabled Setting this option to
Function e Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.
The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.
When FLL is enabled
Software Standby and
Deep Software Standby
modes are not
available.
Main Oscillator Wait e 35 cycles 8163 cycles Number of cycles to
Time e 67 cycles wait for the main
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e 131 cycles oscillator clock to

e 259 cycles stabilize. Drive

e 547 cycles capability automatic

e 1059 cycles switching function is by

e 2147 cycles default disabled.

e 4291 cycles

e 8163 cycles

ID Code Mode ¢ Unlocked Unlocked (Ignore ID) When set to 'Locked

(Ilgnore ID) with All Erase support’,

e Locked with All the ID Code must be
Erase support set in the debugger to

e Locked read or write data to

the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is

provided.
ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
string This setting is only

used when the ID Code
Mode is not set to
Unlocked.

Enumerations

enum elc_event_t

Enumeration Type Documentation

¢ elc_event_t

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note

This list may change based on based on the device.

4.1.2.12 RA6M3
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for rabm3_fsp
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The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

automatically
activated after
a reset

(Autostart
mode)
OFSO register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO register settings o1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor e 64
e 128
e 256
OFSO0 register settings e 75% 0% (no window end
> Independent WDT > e 50% position)
Window End Position e 25%
¢ 0% (no window

end position)

OFSO register settings * 25% 100% (no window start
> Independent WDT > e 50% position)
Window Start Position e 75%
e 100% (no
window start
position)
OFSO register settings e NMI request or Reset is enabled
> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Resetis
enabled
OFSO register settings ¢ Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,

Software Standby
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Snooze mode,
or Software

Standby
OFSO register settings e Automatically Stop WDT after a reset
> WDT > Start Mode activate WDT (register-start mode)
Select after a reset

(auto-start

mode)

e Stop WDT after
a reset (register-
start mode)

OFSO0 register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings o 4 128
> WDT > Clock e 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO0 register settings e 75% 0% (no window end
> WDT > Window End * 50% position)
Position * 25%
* 0% (no window

end position)

OFSO0 register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
Position e 75%
* 100% (no

window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor 0 reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after

reset

¢ Voltage monitor

0 reset is

disabled after

reset
OFS1 register settings e 294V 2.80V
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> Voltage Detection 0
Level

OFS1 register settings
> HOCO Oscillation
Enable

287V
2.80V

¢ HOCO
oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after

HOCO oscillation is

disabled after reset

Sep.10.2021

reset
MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled
MPU > PCO Start Value must be an OXFFFFFFFC
integer between 0 and
OxXFFFFFFFC
MPU > PCO End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable PC Region 1 ¢ Disabled
MPU > PC1 Start Value must be an OXFFFFFFFC
integer between 0 and
OxXFFFFFFFC
MPU > PC1 End Value must be an OxXFFFFFFFF
integer between
0x00000003 and
OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
0
MPU > Memory Region Value must be an OxO00OFFFFFC
0 Start integer between 0 and
OxO00FFFFFC
MPU > Memory Region Value must be an OxOOFFFFFF
0 End integer between
0x00000003 and
OxOO0FFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between
0x1FF00000 and
0x200FFFFC
MPU > Memory Region Value must be an Ox200FFFFF
1 End integer between
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MPU > Enable or
disable Memory Region
2

MPU > Memory Region
2 Start

MPU > Memory Region
2 End

MPU > Enable or
disable Memory Region
3

MPU > Memory Region
3 Start

MPU > Memory Region
3 End

Clocks > HOCO FLL
Function

0x1FFO0003 and
O0x200FFFFF

e Enabled
e Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
Ox400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled
¢ Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled
e Disabled

Disabled

0x407FFFFC

0x407FFFFF

Disabled

0x400DFFFC

0x400DFFFF

Disabled

Setting this option to
Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
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when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Main Oscillator Wait e 35 cycles 8163 cycles Number of cycles to
Time e 67 cycles wait for the main
e 131 cycles oscillator clock to
e 259 cycles stabilize. Drive
e 547 cycles capability automatic
e 1059 cycles switching function is by
e 2147 cycles default disabled.
e 4291 cycles
e 8163 cycles
ID Code Mode ¢ Unlocked Unlocked (Ignore ID) When set to 'Locked
(Ignore ID) with All Erase support',
e Locked with All the ID Code must be
Erase support set in the debugger to
e Locked read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.
ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
string This setting is only
used when the ID Code
Mode is not set to
Unlocked.
Enumerations
enum elc_event t
Enumeration Type Documentation
¢ elc_event_t
enum elc_event t
Sources of event signals to be linked to other peripherals or the CPU
Note
Thislist may change based on based on the device.
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4.1.2.13 RA6M4
BSP » MCU Board Support Package

Build Time Configurations for rabm4_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
Security > Exceptions ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
> Exception Response Interrupt a TrustZone Filter

¢ Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions ¢ Non-Secure Secure State Value for SCB->AIRCR
> BusFault, HardFault, State register bit
and NMI Target e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions ¢ Enabled Disabled Value for SCB->AIRCR
> Prioritize Secure * Disabled register bit PRIS. When
Exceptions enabled, all Non-secure

interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
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Security > SRAM
Accessibility > SRAM
Protection

Security > SRAM
Accessibility > SRAM
ECC

Security > SRAM
Accessibility > Standby
RAM

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Regions 7-0 are
all Secure.
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM regqisters
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.
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Security > BUS
Accessibility > Bus
Security Attribution
Register A

Security > BUS
Accessibility > Bus
Security Attribution
Register B

Security > System
Reset Request
Accessibility

Security > Cache
Accessibility

Security > System
Reset Status
Accessibility

Regions 7-0 are
all Non-secure.

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
TrustZone.

Defines whether the
reset status registers
(RSTSRnN) can be
cleared from the Non-
secure application.

This setting is only
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Security > Battery
Backup Accessibility

OFSO register settings
> Independent WDT >
Start Mode

OFSO register settings
> Independent WDT >
Timeout Period

OFSO0 register settings
> Independent WDT >
Dedicated Clock
Frequency Divisor

OFSO0 register settings
> Independent WDT >
Window End Position

Both Secure
and Non-Secure
State

Secure State

IWDT is
Disabled

IWDT is
automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

Both Secure and Non-
Secure State

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

valid when building
projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRN
registers which are
both read and write
protected.

This setting is only
valid when building
projects with
TrustZone.

OFSO0 register settings e 25% 100% (no window start
> Independent WDT > * 50% position)
Window Start Position e 75%
* 100% (no
window start
position)
OFSO register settings e NMI request or Reset is enabled
> Independent WDT > interrupt
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Reset Interrupt
Request Select

OFSO0 register settings
> Independent WDT >
Stop Control

OFSO register settings
> WDT > Start Mode
Select

OFSO register settings
> WDT > Timeout
Period

OFSO register settings
> WDT > Clock
Frequency Division
Ratio

OFSO0 register settings
> WDT > Window End
Position

request is
enabled
Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after
a reset (register-
start mode)

Stop WDT after a reset
(register-start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

4 128
64

128

512

2048

8192

16384 cycles

75%

50%

25%

0% (no window
end position)

0% (no window end
position)

OFSO register settings * 25% 100% (no window start
> WDT > Window Start e 50% position)
Position e 75%
e 100% (no

window start

position)
OFSO register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
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OFSO0 register settings e Counting
> WDT > Stop Control continues

Stop counting when
entering Sleep mode

OFS1 register settings

> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after

reset

e Voltage monitor

0 reset is

disabled after

reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings ¢ HOCO HOCO oscillation is

> HOCO Oscillation
Enable

e Stop counting
when entering
Sleep mode

¢ Voltage monitor

oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after

Voltage monitor 0 reset

disabled after reset

reset
Block Protection Refer to the RA ou Configure Block
Settings (BPS) > BPSO  Configuration tool for Protection Register 0
available options.

Block Protection e Flash Block 32 0U Configure Block
Settings (BPS) > BPS1 e Flash Block 33 Protection Register 1

e Flash Block 34

e Flash Block 35

e Flash Block 36

¢ Flash Block 37
Block Protection Refer to the RA ou Configure Block
Settings (BPS) > BPS2  Configuration tool for Protection Register 2

available options.

Permanent Block Refer to the RA ou Configure Permanent
Protection Settings Configuration tool for Block Protection
(PBPS) > PBPSO available options. Register 0
Permanent Block e Flash Block 32 0U Configure Permanent
Protection Settings e Flash Block 33 Block Protection
(PBPS) > PBPS1 e Flash Block 34 Register 1

e Flash Block 35

e Flash Block 36

¢ Flash Block 37
Permanent Block Refer to the RA ou Configure Permanent
Protection Settings Configuration tool for Block Protection
(PBPS) > PBPS2 available options. Register 2
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Clocks > HOCO FLL e Enabled Disabled Setting this option to

Function ¢ Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Startup C-Cache Line e 32 Bytes 32 Bytes Set the C-Cache line
Size * 64 Bytes size configured during
startup.
Dual Bank Mode ¢ Enabled Disabled Enabling dual bank
¢ Disabled mode splits the flash

into two banks that can
be swapped by
programming the
BANKSEL non-volatile
register. When
enabled, one bank will
start at address 0x0
and the other will start
at 0x200000. Each
bank contains exactly
half the capacity of the
entire code flash. When
Dual Bank mode is
enabled, Startup
Program Protection and
Block Swap functions
cannot be used.

Main Oscillator Wait e 3 cycles 8163 cycles Number of cycles to
Time e 35 cycles wait for the main
e 67 cycles oscillator clock to
e 131 cycles stabilize.
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259 cycles
547 cycles
1059 cycles
2147 cycles
4291 cycles
8163 cycles

4.1.2.14 RA6M5
BSP » MCU Board Support Package

Build Time Configurations for ra6m5_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
Security > Exceptions ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
> Exception Response Interrupt a TrustZone Filter

e Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions e Non-Secure Secure State Value for SCB->AIRCR
> BusFault, HardFault, State register bit
and NMI Target e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with

TrustZone.
Security > Exceptions ¢ Enabled Disabled Value for SCB->AIRCR
> Prioritize Secure ¢ Disabled register bit PRIS. When
Exceptions enabled, all Non-secure

interrupt priorities are
automatically demoted
by right shifting their
priority by one then
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Security > SRAM
Accessibility > SRAM
Protection

Security > SRAM
Accessibility > SRAM
ECC

Security > SRAM

Accessibility > Standby

RAM

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Regions 7-0 are
all Secure.
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

R11UMO0155EU0230 Revision 2.30
Sep.10.2021

RLENESAS

Page 248 /2,794



Flexible Software Package

API| Reference > BSP > MCU Board Support Package > RA6M5

User’s Manual

Security > BUS
Accessibility > Bus
Security Attribution
Register A

Security > BUS
Accessibility > Bus
Security Attribution
Register B

Security > System
Reset Request
Accessibility

Security > Cache
Accessibility

Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.
Regions 7-0 are
all Non-secure.

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Secure State
and Non-Secure
State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
TrustZone.
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Security > System
Reset Status
Accessibility

Security > Battery
Backup Accessibility

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Defines whether the
reset status registers
(RSTSRN) can be
cleared from the Non-
secure application.

Both Secure and Non-
Secure State

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRn
registers which are
both read and write
protected.

Both Secure and Non-
Secure State

This setting is only
valid when building
projects with

TrustZone.
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

automatically
activated after
a reset

(Autostart
mode)
OFSO register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO0 register settings o1 128
> Independent WDT > * 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO register settings e 75% 0% (no window end
> Independent WDT > e 50% position)
Window End Position e 25%

OFSO register settings

0% (no window
end position)

25%

100% (no window start
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> Independent WDT >
Window Start Position

OFSO0 register settings
> Independent WDT >
Reset Interrupt
Request Select

OFSO0 register settings
> Independent WDT >
Stop Control

OFSO0 register settings
> WDT > Start Mode
Select

OFSO register settings
> WDT > Timeout
Period

OFSO0 register settings
> WDT > Clock
Frequency Division
Ratio

OFSO0 register settings
> WDT > Window End
Position

50% position)
75%

100% (no

window start

position)

NMI request or Reset is enabled
interrupt

request is

enabled

Reset is

enabled

Counting Stop counting when in
continues Sleep, Snooze mode, or
(Note: Device Software Standby

will not enter

Deep Standby

Mode when

selected.

Device will

enter Software

Standby Mode)

Stop counting

when in Sleep,

Snooze mode,

or Software

Standby

Automatically Stop WDT after a reset
activate WDT (register-start mode)
after a reset

(auto-start

mode)

Stop WDT after

a reset (register-

start mode)

1024 cycles 16384 cycles
4096 cycles

8192 cycles

16384 cycles

4 128
64

128

512

2048

8192

75% 0% (no window end
50% position)

25%

0% (no window

end position)

OFSO register settings e 25% 100% (no window start
> WDT > Window Start * 50% position)
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Position e 75%
e 100% (no
window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings e Voltage monitor Voltage monitor 0 reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
¢ Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after
reset
e HOCO

oscillation is
disabled after
reset

Block Protection Refer to the RA ou
Settings (BPS) > BPSO  Configuration tool for
available options.

Configure Block
Protection Register 0

Flash Block 32 ou
Flash Block 33
Flash Block 34
Flash Block 35
Flash Block 36
e Flash Block 37

Block Protection
Settings (BPS) > BPS1

Configure Block
Protection Register 1

Block Protection Refer to the RA ou Configure Block

Settings (BPS) > BPS2

Configuration tool for
available options.

Protection Register 2

Permanent Block Refer to the RA ou Configure Permanent

Protection Settings Configuration tool for Block Protection

(PBPS) > PBPSO available options. Register 0

Permanent Block e Flash Block 32 0U Configure Permanent

Protection Settings ¢ Flash Block 33 Block Protection

(PBPS) > PBPS1 ¢ Flash Block 34 Register 1
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¢ Flash Block 35
e Flash Block 36
e Flash Block 37

Permanent Block Refer to the RA ou Configure Permanent
Protection Settings Configuration tool for Block Protection
(PBPS) > PBPS2 available options. Register 2

Clocks > HOCO FLL ¢ Enabled Disabled Setting this option to
Function ¢ Disabled Enabled improves

HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Startup C-Cache Line e 32 Bytes 32 Bytes Set the C-Cache line
Size e 64 Bytes size configured during
startup.
Dual Bank Mode ¢ Enabled Disabled Enabling dual bank
e Disabled mode splits the flash

into two banks that can
be swapped by
programming the
BANKSEL non-volatile
register. When
enabled, one bank will
start at address 0x0
and the other will start
at 0x200000. Each
bank contains exactly
half the capacity of the
entire code flash. When
Dual Bank mode is
enabled, Startup
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Program Protection and
Block Swap functions
cannot be used.

Main Oscillator Wait
Time

3 cycles 8163 cycles Number of cycles to
35 cycles wait for the main
67 cycles oscillator clock to
131 cycles stabilize.

259 cycles

547 cycles

1059 cycles

2147 cycles

4291 cycles

8163 cycles

4.1.2.15 RA6T1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra6tl_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO register settings e IWDT is IWDT is Disabled
> Independent WDT > Disabled
Start Mode e [WDT is

automatically
activated after

a reset
(Autostart
mode)
OFSO register settings e 128 cycles 2048 cycles
> Independent WDT > e 512 cycles
Timeout Period e 1024 cycles
e 2048 cycles
OFSO0 register settings e 1 128
> Independent WDT > e 16
Dedicated Clock e 32
Frequency Divisor * 64
e 128
e 256
OFSO0 register settings e 75% 0% (no window end
> Independent WDT > * 50% position)
Window End Position e 25%
e 0% (no window

end position)
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OFSO register settings e 25% 100% (no window start
> Independent WDT > * 50% position)
Window Start Position e 75%
* 100% (no
window start
position)

OFSO0 register settings

NMI request or

Reset is enabled

> Independent WDT > interrupt
Reset Interrupt request is
Request Select enabled
e Reset is
enabled
OFSO register settings e Counting Stop counting when in
> Independent WDT > continues Sleep, Snooze mode, or

Stop Control

OFSO register settings
> WDT > Start Mode
Select

(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

Software Standby

Stop WDT after a reset
(register-start mode)

OFSO register settings e 1024 cycles 16384 cycles
> WDT > Timeout e 4096 cycles
Period e 8192 cycles
e 16384 cycles
OFSO register settings e 4 128
> WDT > Clock * 64
Frequency Division e 128
Ratio e 512
e 2048
e 8192
OFSO0 register settings e 75% 0% (no window end
> WDT > Window End e 50% position)
Position e 25%
¢ 0% (no window

OFSO0 register settings

end position)

25%

100% (no window start
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> WDT > Window Start * 50% position)
Position e 75%
e 100% (no
window start

position)
OFSO0 register settings e NMI Reset
> WDT > Reset e Reset
Interrupt Request
OFSO register settings ¢ Counting Stop counting when
> WDT > Stop Control continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings ¢ Voltage monitor Voltage monitor O reset
> Voltage Detection 0 0 reset is is disabled after reset
Circuit Start enabled after
reset
¢ Voltage monitor
0 reset is
disabled after
reset
OFS1 register settings e 294V 2.80V
> Voltage Detection 0 e 287V
Level e 280V
OFS1 register settings e HOCO HOCO oscillation is
> HOCO Oscillation oscillation is disabled after reset
Enable enabled after
reset
e HOCO

oscillation is
disabled after

reset
MPU > Enable or e Enabled Disabled
disable PC Region 0 e Disabled
MPU > PCO Start Value must be an OxXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PCO End Value must be an OxXFFFFFFFF

integer between
0x00000003 and

OXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable PC Region 1 e Disabled
MPU > PC1 Start Value must be an OxXFFFFFFFC
integer between 0 and
OXFFFFFFFC
MPU > PC1 End Value must be an OxFFFFFFFF

integer between
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0x00000003 and
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OxXFFFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
0
MPU > Memory Region Value must be an OXO0O0FFFFFC
0 Start integer between 0 and

OxO00FFFFFC
MPU > Memory Region Value must be an OXxOOFFFFFF
0 End integer between

0x00000003 and

OxOOFFFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
1
MPU > Memory Region Value must be an Ox200FFFFC
1 Start integer between

0x1FF00000 and

0x200FFFFC
MPU > Memory Region Value must be an 0x200FFFFF
1 End integer between

0x1FF00003 and

0x200FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region ¢ Disabled
2
MPU > Memory Region Value must be an 0x407FFFFC
2 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and 0x407FFFFC
MPU > Memory Region Value must be an 0x407FFFFF
2 End integer between

0x400C0003 and

Ox400DFFFF or

between 0x40100003

and Ox407FFFFF
MPU > Enable or e Enabled Disabled
disable Memory Region e Disabled
3
MPU > Memory Region Value must be an Ox400DFFFC
3 Start integer between

0x400C0000 and

0x400DFFFC or

between 0x40100000

and 0x407FFFFC
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MPU > Memory Region Value must be an Ox400DFFFF
3 End integer between

0x400C0003 and

0x400DFFFF or

between 0x40100003

and 0x407FFFFF

Clocks > HOCO FLL e Enabled Disabled Setting this option to

Function ¢ Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Main Oscillator Wait e 35 cycles 8163 cycles Number of cycles to
Time e 67 cycles wait for the main
e 131 cycles oscillator clock to
e 259 cycles stabilize. Drive
e 547 cycles capability automatic
e 1059 cycles switching function is by
e 2147 cycles default disabled.
e 4291 cycles
e 8163 cycles
ID Code Mode e Unlocked Unlocked (Ignore ID) When set to 'Locked
(Ignore ID) with All Erase support’,
e Locked with All the ID Code must be
Erase support set in the debugger to
e Locked read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
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ID Code (32 Hex Value must be a 32
Characters) character long hex

string
Enumerations

enum elc_event t

Enumeration Type Documentation

¢ elc_event_t

FFFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFF

access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

enum elc_event_t

Note

Thislist may change based on based on the device.

Sources of event signals to be linked to other peripherals or the CPU

4.1.3 BSP 1/O access
BSP

Functions

__STATIC_INLINE uint32_t R_BSP_PinRead (bsp_io_port_pin_t pin)

__STATIC_INLINE void R _BSP_PinWrite (bsp_io_port_pin_t pin, bsp_io_level t level)

__STATIC_INLINE void R _BSP_PinCfg (bsp_io_port_pin_t pin, uint32_t cfg)

__STATIC_INLINE void R_BSP_PinAccessEnable (void)

__STATIC_INLINE void R_BSP_PinAccessDisable (void)

Detailed Description

This module provides basic read/write access to port pins.

Enumerations

enum bsp_io_level t
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enum bsp_io_direction_t

enum bsp_io _port t

enum bsp_io_port_pin_t
Enumeration Type Documentation

¢ bsp_io_level t

enum bsp_io_level_t

Levels that can be set and read for individual pins

Enumerator
BSP_I0_LEVEL LOW Low.
BSP_10_LEVEL HIGH High.
¢ bsp_io_direction_t
enum bsp_io_direction_t
Direction of individual pins
Enumerator
BSP_I0_DIRECTION_INPUT Input.
BSP_IO_DIRECTION_OUTPUT Output.
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¢ bsp_io_port_t

enum bsp_io_port t

Superset list of all possible 10 ports.

Sep.10.2021

Enumerator
BSP_I0_PORT_00 10 port 0.
BSP_10_PORT 01 10 port 1.
BSP_IO_PORT 02 10 port 2.
BSP_|O_PORT_03 10 port 3.
BSP_IO_PORT_04 10 port 4.
BSP_IO_PORT_05 10 port 5.
BSP_10_PORT_06 IO port 6.
BSP_I0_PORT_07 10 port 7.
BSP_I0_PORT_08 10 port 8.
BSP_10_PORT_09 IO port 9.
BSP_IO_PORT 10 10 port 10.
BSP_|0_PORT_11 10 port 11.
¢ bsp_io_port_pin_t
enum bsp_io_port _pin_t
Superset list of all possible 10 port pins.
Enumerator
BSP_I0_PORT_00_PIN_00 10 port 0 pin 0.
BSP_|O_PORT_00_PIN_01 |0 port 0 pin 1.
BSP_I0_PORT_00 PIN 02 10 port 0 pin 2.
BSP_I0_PORT 00 PIN_03 10 port 0 pin 3.
BSP_I0_PORT _00 PIN_04 10 port 0 pin 4.
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BSP_IO_PORT 00 _PIN_05

IO port 0 pin 5.
BSP_IO_PORT_00 _PIN_06 |0 port 0 pin 6.
BSP_IO_PORT_00_PIN_07 IO port 0 pin 7.
BSP_I0_PORT 00 PIN_08 10 port 0 pin 8.
BSP_I0_PORT 00 PIN_09 10 port 0 pin 9.

BSP_IO_PORT 00 _PIN_10

IO port 0 pin 10.

BSP_10_PORT 00 PIN_11

IO port 0 pin 11.

BSP_IO_PORT_00 PIN_12

IO port 0 pin 12.

BSP_|O_PORT 00 PIN 13

IO port 0 pin 13.

BSP_IO_PORT 00 PIN_14

IO port O pin 14.

BSP_I0_PORT 00 PIN_15

IO port 0 pin 15.

BSP_IO_PORT 01 _PIN_00

10 port 1 pin 0.
BSP_I0_PORT 01 PIN 01 10 port 1 pin 1.
BSP_IO_PORT_01_PIN_02 10 port 1 pin 2.
BSP_IO_PORT_01_PIN_03 10 port 1 pin 3.
BSP_I0_PORT 01 PIN_04 10 port 1 pin 4.
BSP_I0_PORT 01 PIN_05 10 port 1 pin 5.
BSP_IO_PORT_01_PIN_06 |0 port 1 pin 6.
BSP_IO_PORT_01_PIN_07 10 port 1 pin 7.
BSP_I0_PORT 01 PIN_08 10 port 1 pin 8.
BSP_10_PORT 01 PIN_09 10 port 1 pin 9.

BSP_IO_PORT 01 _PIN_10

IO port 1 pin 10.

BSP_10_PORT 01 PIN_11

IO port 1 pin 11.

BSP_IO_PORT_01_PIN_12

IO port 1 pin 12.
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BSP_IO_PORT 01 PIN 13

IO port 1 pin 13.

BSP_|O_PORT 01 PIN_14

IO port 1 pin 14.

BSP_I0_PORT 01 PIN_15

IO port 1 pin 15.

BSP_IO_PORT_02_PIN_00

10 port 2 pin 0.
BSP_I0_PORT 02 PIN 01 10 port 2 pin 1.
BSP_IO_PORT_02_PIN_02 |0 port 2 pin 2.
BSP_IO_PORT_02_PIN_03 |0 port 2 pin 3.
BSP_I0_PORT 02 PIN_04 10 port 2 pin 4.
BSP_I0_PORT 02 _PIN_05 10 port 2 pin 5.
BSP_IO_PORT_02_PIN_06 |0 port 2 pin 6.
BSP_IO_PORT_02_PIN_07 1O port 2 pin 7.
BSP_10_PORT 02 PIN_08 10 port 2 pin 8.
BSP_10_PORT 02 _PIN_09 10 port 2 pin 9.

BSP_IO_PORT 02_PIN_10

IO port 2 pin 10.

BSP_10_PORT 02 PIN_11

IO port 2 pin 11.

BSP_IO_PORT_02_PIN_12

IO port 2 pin 12.

BSP_IO_PORT_02_PIN 13

IO port 2 pin 13.

BSP_IO_PORT 02_PIN_14

IO port 2 pin 14.

BSP_I0_PORT 02_PIN_15

IO port 2 pin 15.

BSP_IO_PORT _03_PIN_00

Sep.10.2021

IO port 3 pin 0.

BSP_I0_PORT 03 PIN 01 10 port 3 pin 1.

BSP_IO_PORT_03_PIN_02 10 port 3 pin 2.

BSP_IO_PORT_03_PIN_03 |0 port 3 pin 3.

BSP_I0_PORT 03 PIN_04 10 port 3 pin 4.
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BSP_IO_PORT 03_PIN_05

IO port 3 pin 5.
BSP_IO_PORT_03_PIN_06 |0 port 3 pin 6.
BSP_IO_PORT_03_PIN_07 IO port 3 pin 7.
BSP_I0_PORT_03_PIN_08 10 port 3 pin 8.
BSP_10_PORT_03_PIN_09 10 port 3 pin 9.

BSP_IO_PORT 03_PIN_10

IO port 3 pin 10.

BSP_10_PORT 03_PIN_11

IO port 3 pin 11.

BSP_IO_PORT_03_PIN_12

IO port 3 pin 12.

BSP_|O_PORT 03 _PIN 13

IO port 3 pin 13.

BSP_IO_PORT 03_PIN_14

IO port 3 pin 14.

BSP_I0_PORT 03_PIN_15

IO port 3 pin 15.

BSP_IO_PORT 04 _PIN_00

10 port 4 pin 0.
BSP_I0_PORT 04 PIN 01 10 port 4 pin 1.
BSP_IO_PORT_04_PIN_02 |0 port 4 pin 2.
BSP_IO_PORT_04_PIN_03 |0 port 4 pin 3.
BSP_I0_PORT 04 PIN_04 10 port 4 pin 4.
BSP_I0_PORT 04 PIN_05 10 port 4 pin 5.
BSP_IO_PORT_04_PIN_06 |0 port 4 pin 6.
BSP_IO_PORT_04_PIN_07 1O port 4 pin 7.
BSP_I0_PORT 04 PIN_08 10 port 4 pin 8.
BSP_10_PORT 04 PIN_09 10 port 4 pin 9.

BSP_IO_PORT 04 _PIN_10

IO port 4 pin 10.

BSP_10_PORT 04 PIN_11

IO port 4 pin 11.

BSP_IO_PORT_04 PIN_12

IO port 4 pin 12.
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BSP_|O_PORT 04 PIN 13

IO port 4 pin 13.

BSP_IO_PORT 04 PIN_14

IO port 4 pin 14.

BSP_I0_PORT 04 PIN_15

IO port 4 pin 15.

BSP_IO_PORT_05_PIN_00

IO port 5 pin 0.
BSP_I0_PORT 05 PIN 01 10 port 5 pin 1.
BSP_IO_PORT_05_PIN_02 10 port 5 pin 2.
BSP_IO_PORT_05_PIN_03 |0 port 5 pin 3.
BSP_I0_PORT 05 PIN_04 10 port 5 pin 4.
BSP_IO_PORT_05_PIN_05 10 port 5 pin 5.
BSP_IO_PORT_05_PIN_06 |0 port 5 pin 6.
BSP_IO_PORT_05_PIN_07 10 port 5 pin 7.
BSP_IO_PORT_05_PIN_08 |0 port 5 pin 8.
BSP_IO_PORT_05_PIN_09 10 port 5 pin 9.

BSP_IO_PORT 05 _PIN_10

IO port 5 pin 10.

BSP_10_PORT 05 PIN_11

IO port 5 pin 11.

BSP_IO_PORT_05 PIN_12

IO port 5 pin 12.

BSP_|O_PORT 05 PIN 13

IO port 5 pin 13.

BSP_IO_PORT 05 PIN_14

IO port 5 pin 14.

BSP_I0_PORT 05 PIN_15

IO port 5 pin 15.

BSP_IO_PORT_06_PIN_00

Sep.10.2021

IO port 6 pin 0.

BSP_ 10 _PORT 06 PIN 01 10 port 6 pin 1.

BSP_IO_PORT_06_PIN_02 |0 port 6 pin 2.

BSP_IO_PORT_06_PIN_03 1O port 6 pin 3.

BSP_I0_PORT 06 _PIN_04 IO port 6 pin 4.
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BSP_IO_PORT _06_PIN_05

IO port 6 pin 5.
BSP_|O_PORT_06_PIN_06 |0 port 6 pin 6.
BSP_IO_PORT_06_PIN_07 IO port 6 pin 7.
BSP_I0_PORT 06 _PIN_08 10 port 6 pin 8.
BSP_10_PORT 06 _PIN_09 10 port 6 pin 9.

BSP_IO_PORT 06_PIN_10

IO port 6 pin 10.

BSP_10_PORT 06 PIN_11

IO port 6 pin 11.

BSP_IO_PORT_06_PIN_12

IO port 6 pin 12.

BSP_|O_PORT 06 PIN 13

IO port 6 pin 13.

BSP_IO_PORT 06_PIN_14

IO port 6 pin 14.

BSP_I0_PORT 06 _PIN_15

IO port 6 pin 15.

BSP_IO_PORT_07_PIN_00

10 port 7 pin 0.
BSP_I0_PORT 07 _PIN 01 10 port 7 pin 1.
BSP_IO_PORT_07_PIN_02 |0 port 7 pin 2.
BSP_IO_PORT_07_PIN_03 |0 port 7 pin 3.
BSP_I0_PORT 07 _PIN_04 10 port 7 pin 4.
BSP_10_PORT 07 _PIN_05 10 port 7 pin 5.
BSP_IO_PORT_07_PIN_06 |0 port 7 pin 6.
BSP_IO_PORT_07_PIN_07 10 port 7 pin 7.
BSP_I0_PORT 07 _PIN_08 10 port 7 pin 8.
BSP_10_PORT_07_PIN_09 10 port 7 pin 9.

BSP_IO_PORT 07_PIN_10

IO port 7 pin 10.

BSP_10_PORT 07 PIN_11

IO port 7 pin 11.

BSP_IO_PORT_07_PIN_12

IO port 7 pin 12.
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BSP_IO_PORT_07_PIN_13

IO port 7 pin 13.

BSP_IO_PORT 07_PIN_14

IO port 7 pin 14.

BSP_I0_PORT 07 _PIN_15

IO port 7 pin 15.

BSP_IO_PORT_08_PIN_00

IO port 8 pin 0.
BSP_I0_PORT 08 PIN 01 10 port 8 pin 1.
BSP_IO_PORT_08 PIN_02 |0 port 8 pin 2.
BSP_IO_PORT_08 PIN_03 |0 port 8 pin 3.
BSP_I0_PORT 08 PIN_04 10 port 8 pin 4.
BSP_IO_PORT_08_PIN_05 |0 port 8 pin 5.
BSP_IO_PORT_08 _PIN_06 |0 port 8 pin 6.
BSP_IO_PORT_08 PIN_07 |0 port 8 pin 7.
BSP_IO_PORT_08_PIN_08 |0 port 8 pin 8.
BSP_IO_PORT_08_PIN_09 10 port 8 pin 9.

BSP_IO_PORT 08_PIN_10

IO port 8 pin 10.

BSP_10_PORT 08_PIN_11

IO port 8 pin 11.

BSP_IO_PORT_08_PIN_12

IO port 8 pin 12.

BSP_|O_PORT 08 _PIN 13

IO port 8 pin 13.

BSP_IO_PORT 08_PIN_14

IO port 8 pin 14.

BSP_I0_PORT 08 _PIN_15

IO port 8 pin 15.

BSP_IO_PORT_09_PIN_00

Sep.10.2021

IO port 9 pin 0.

BSP_10_PORT 09 PIN 01 10 port 9 pin 1.

BSP_IO_PORT_09 PIN_02 10 port 9 pin 2.

BSP_IO_PORT_09 PIN_03 1O port 9 pin 3.

BSP_I0_PORT _09 PIN 04 IO port 9 pin 4.
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BSP_IO_PORT 09 PIN_05

IO port 9 pin 5.
BSP_IO_PORT_09 PIN_06 |0 port 9 pin 6.
BSP_IO_PORT_09 _PIN_07 IO port 9 pin 7.
BSP_I0_PORT 09 PIN_08 10 port 9 pin 8.
BSP_10_PORT_09 PIN_09 10 port 9 pin 9.

BSP_IO_PORT 09 PIN_10

IO port 9 pin 10.

BSP_10_PORT 09 PIN_11

IO port 9 pin 11.

BSP_IO_PORT_09 PIN_12

IO port 9 pin 12.

BSP_|O_PORT 09 PIN 13

IO port 9 pin 13.

BSP_IO_PORT 09 PIN_14

IO port 9 pin 14.

BSP_I0_PORT 09 PIN_15

IO port 9 pin 15.

BSP_IO_PORT_10_PIN_00

IO port 10 pin 0.

BSP_IO_PORT_10_PIN_01

IO port 10 pin 1.

BSP_|O_PORT _10_PIN_02

IO port 10 pin 2.

BSP_10_PORT 10 PIN_03

0 port 10 pin 3.

BSP_IO_PORT 10 _PIN_04

IO port 10 pin 4.

BSP_|O_PORT_10 PIN 05

IO port 10 pin 5.

BSP_IO_PORT_10_PIN_06

IO port 10 pin 6.

BSP_10_PORT 10 PIN_07

IO port 10 pin 7.

BSP_IO_PORT 10 PIN 08

IO port 10 pin 8.

BSP_|O_PORT_10 PIN_09

IO port 10 pin 9.

BSP_IO_PORT 10 _PIN_10

IO port 10 pin 10.

BSP_10_PORT 10 PIN_11

|0 port 10 pin 11.

BSP_IO_PORT_10 PIN_12

|0 port 10 pin 12.
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BSP_IO_PORT_10_PIN 13

IO port 10 pin 13.

BSP_|O_PORT 10 _PIN_14

IO port 10 pin 14.

BSP_10_PORT 10 PIN_15

|0 port 10 pin 15.

BSP_IO_PORT_11_PIN_00

IO port 11 pin O.

BSP_IO_PORT_11_PIN_01

IO port 11 pin 1.

BSP_|O_PORT 11_PIN_02

IO port 11 pin 2.

BSP_10_PORT 11 PIN_03

0 port 11 pin 3.

BSP_IO_PORT_11_PIN_04

0 port 11 pin 4.

BSP_IO_PORT_11_PIN_05

IO port 11 pin 5.

BSP_|O_PORT 11 _PIN_06

IO port 11 pin 6.

BSP_10_PORT 11 PIN_07

0 port 11 pin 7.

BSP_IO_PORT_11_PIN_08

IO port 11 pin 8.

BSP_IO_PORT_11_PIN_09

IO port 11 pin 9.

BSP_IO_PORT 11 PIN_10

IO port 11 pin 10.

BSP_10_PORT 11 PIN_11

0 port 11 pin 11.

BSP_IO_PORT_11_PIN_12

10 port 11 pin 12.

BSP_IO_PORT 11 PIN 13

IO port 11 pin 13.

BSP_|O_PORT 11 PIN_14

IO port 11 pin 14.

BSP_10_PORT 11 PIN_15

0 port 11 pin 15.

Function Documentation
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¢ R_BSP_PinRead()

__STATIC_INLINE uint32_t R_BSP_PinRead ( bsp_io_port_pin_t pin)

Read the current input level of the pin.

Parameters

[in] pin The pin

Return values

Current input level

4 R_BSP_PinWrite()

__STATIC_INLINE void R_BSP_PinWrite ( bsp_io_port pin_t pin, bsp_io_level t level )

Set a pin to output and set the output level to the level provided. If PFS protection is enabled,
disable PFS protection using R_BSP_PinAccessEnable() before calling this function.

Parameters
[in] pin The pin
[in] level The level

¢ R_BSP_PinCfg()

__STATIC_INLINE void R_BSP_PinCfg ( bsp_io_port_pin_t pin, uint32_t cfg )

Configure a pin. If PFS protection is enabled, disable PFS protection using R_BSP_PinAccessEnable()
before calling this function.

Parameters
[in] pin The pin
[in] cfg Configuration for the pin
(PmnPFS register setting)

¢ R_BSP_PinAccessEnable()

__STATIC_INLINE void R_BSP_PinAccessEnable ( void )

Enable access to the PFS registers. Uses a reference counter to protect against interrupts that
could occur via multiple threads or an ISR re-entering this code.
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¢ R_BSP_PinAccessDisable()

__STATIC_INLINE void R_BSP_PinAccessDisable ( void )

Disable access to the PFS registers. Uses a reference counter to protect against interrupts that
could occur via multiple threads or an ISR re-entering this code.

4.2 Modules

Detailed Description

Modules are the smallest unit of software available in the FSP. Each module implements one
interface.

For more information on FSP Modules and Interfaces review FSP Modules, FSP Stacks and FSP
Interfaces in the FSP Architecutre section of this manual.

Note
Not all modules are available for all MCUs. For more information, see the User's Manual for the specific MCU.

Organization of Module Sections

Each module within FSP has a detailed Users' Guide listed below. Each guide typically includes the
following content:

Functions: A list of all the API functions associated with the module

Detailed Description: A short description of the module and the peripherals used

Overview: An operational summary and a list of high level features provided by the module

Configuration: A description of module specific settings available in the configuration tool

including clock and pin configurations

e Usage Notes: Module specific documentation and limitations

e Examples: lllustrative code snippets that help the user better understand API use and
operation

e Data Structure and Enumeration: Definitions for data structures, enumerations and similar
elements used by the module API

e Function Documentation: Details on each API function, including the function prototype, a

function summary, a simple use example, list of return values and links to documentation

for any needed parameter definitions

Modules
High-Speed Analog Comparator (r_acmphs)

Driver for the ACMPHS peripheral on RA MCUs. This module
implements the Comparator Interface.

Low-Power Analog Comparator (r_acmplp)

Driver for the ACMPLP peripheral on RA MCUs. This module
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implements the Comparator Interface.

Analog to Digital Converter (r_adc)

Driver for the ADC12, ADC14, and ADC16 peripherals on RA MCUs.
This module implements the ADC Interface.

Asynchronous General Purpose Timer (r_agt)

Driver for the AGT peripheral on RA MCUs. This module implements
the Timer Interface.

Bluetooth Low Energy Library (r_ble)

Driver for the Radio peripheral on RA MCUs. This module implements
the BLE Interface.

Clock Frequency Accuracy Measurement Circuit (r_cac)

Driver for the CAC peripheral on RA MCUs. This module implements
the CAC Interface.

Controller Area Network (r_can)

Driver for the CAN peripheral on RA MCUs. This module implements
the CAN Interface.

Controller Area Network - Flexible Data (r_canfd)

Driver for the CANFD peripheral on RA MCUs. This module
implements the CAN Interface.

Consumer Electronics Control (r_cec)

Driver for the CEC peripheral on RA MCUs. This module implements
the CEC Interface.

Clock Generation Circuit (r_cgc)

Driver for the CGC peripheral on RA MCUs. This module implements
the CGC Interface.

Cyclic Redundancy Check (CRC) Calculator (r_crc)

Driver for the CRC peripheral on RA MCUs. This module implements
the CRC Interface.
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Capacitive Touch Sensing Unit (r_ctsu)

This HAL driver supports the Capacitive Touch Sensing Unit (CTSU). It
implements the CTSU Interface.

Digital to Analog Converter (r_dac)

Driver for the DAC12 peripheral on RA MCUs. This module
implements the DAC Interface.

Digital to Analog Converter (r_dac8)

Driver for the DACS8 peripheral on RA MCUs. This module implements
the DAC Interface.

Direct Memory Access Controller (r_dmac)

Driver for the DMAC peripheral on RA MCUs. This module implements
the Transfer Interface.

Data Operation Circuit (r_doc)

Driver for the DOC peripheral on RA MCUs. This module implements
the DOC Interface.

D/AVE 2D Port Interface (r_drw)

Driver for the DRW peripheral on RA MCUs. This module is a port of
D/AVE 2D.

Data Transfer Controller (r_dtc)

Driver for the DTC peripheral on RA MCUs. This module implements
the Transfer Interface.

Event Link Controller (r_elc)

Driver for the ELC peripheral on RA MCUs. This module implements
the ELC Interface.

Ethernet (r_ether)

Driver for the Ethernet peripheral on RA MCUs. This module
implements the Ethernet Interface.

Ethernet PHY (r_ether_phy)
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The Ethernet PHY module (r_ether phy) provides an API for standard
Ethernet PHY communications applications that use the ETHERC
peripheral. It implements the Ethernet PHY Interface.

High-Performance Flash Driver (r_flash_hp)

Driver for the flash memory on RA high-performance MCUs. This
module implements the Flash Interface.

Low-Power Flash Driver (r_flash_Ip)

Driver for the flash memory on RA low-power MCUs. This module
implements the Flash Interface.

Graphics LCD Controller (r_glcdc)

Driver for the GLCDC peripheral on RA MCUs. This module
implements the Display Interface.

General PWM Timer (r_gpt)

Driver for the GPT32 and GPT16 peripherals on RA MCUs. This
module implements the Timer Interface.

General PWM Timer Three-Phase Motor Control Driver
(r_gpt_three phase)

Driver for 3-phase motor control using the GPT peripheral on RA
MCUs. This module implements the Three-Phase Interface.

Interrupt Controller Unit (r_icu)

Driver for the ICU peripheral on RA MCUs. This module implements
the External IRQ Interface.

I2C Master on IIC (r_iic_master)

Driver for the IIC peripheral on RA MCUs. This module implements
the 12C Master Interface.

I12C Slave on IIC (r_iic_slave)

Driver for the IIC peripheral on RA MCUs. This module implements
the 12C Slave Interface.

I/O Ports (r_ioport)
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Driver for the 1/0O Ports peripheral on RA MCUs. This module
implements the 1/0O Port Interface.

Independent Watchdog Timer (r_iwdt)

Driver for the IWDT peripheral on RA MCUs. This module implements
the WDT Interface.

JPEG Codec (r_jpeg)

Driver for the JPEG peripheral on RA MCUs. This module implements
the JPEG Codec Interface.

Key Interrupt (r_kint)

Driver for the KINT peripheral on RA MCUs. This module implements
the Key Matrix Interface.

Low Power Modes (r_Ipm)

Driver for the LPM peripheral on RA MCUs. This module implements
the Low Power Modes Interface.

Low Voltage Detection (r_lvd)

Driver for the LVD peripheral on RA MCUs. This module implements
the Low Voltage Detection Interface.

Operational Amplifier (r_opamp)

Driver for the OPAMP peripheral on RA MCUs. This module
implements the OPAMP Interface.

Octa Serial Peripheral Interface Flash (r_ospi)

Driver for the OSPI peripheral on RA MCUs. This module implements
the SPI Flash Interface.

Parallel Data Capture (r_pdc)

Driver for the PDC peripheral on RA MCUs. This module implements
the PDC Interface.

Port Output Enable for GPT (r_poeg)
Driver for the POEG peripheral on RA MCUs. This module implements
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the POEG Interface.

Precision Time Protocol (r_ptp)

Driver for the PTP peripheral on RA MCUs. This module implements
the PTP Interface.

Quad Serial Peripheral Interface Flash (r_qgspi)

Driver for the QSPI peripheral on RA MCUs. This module implements
the SPI Flash Interface.

Realtime Clock (r_rtc)

Driver for the RTC peripheral on RA MCUs. This module implements
the RTC Interface.

Secure Crypto Engine (r_sce_protected)

Driver for the Secure Crypto Engine (SCE) on RA MCUs.

Serial Communications Interface (SCI) 12C (r_sci_i2c)

Driver for the SCI peripheral on RA MCUs. This module implements
the 12C Master Interface.

Serial Communications Interface (SCI) SPI (r_sci_spi)

Driver for the SCI peripheral on RA MCUs. This module implements
the SPI Interface.

Serial Communications Interface (SCI) UART (r_sci_uart)

Driver for the SCI peripheral on RA MCUs. This module implements
the UART Interface.

Sigma Delta Analog to Digital Converter (r_sdadc)

Driver for the SDADC24 peripheral on RA MCUs. This module
implements the ADC Interface.

SD/MMC Host Interface (r_sdhi)

Driver for the SD/MMC Host Interface (SDHI) peripheral on RA MCUs.
This module implements the SD/MMC Interface.
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Segment LCD Controller (r_slcdc)

Driver for the SLCDC peripheral on RA MCUs. This module
implements the SLCDC Interface.

Serial Peripheral Interface (r_spi)

Driver for the SPI peripheral on RA MCUs. This module implements
the SPI Interface.

Serial Sound Interface (r_ssi)

Driver for the SSIE peripheral on RA MCUs. This module implements
the 12S Interface.

USB (r_usb_basic)

Driver for the USB peripheral on RA MCUs. This module implements
the USB Interface.

USB Composite Class (r_usb_composite)

USB Host Communications Device Class Driver (r_usb_hcdc)

This module provides a USB Host Communications Device Class
(HCDC) driver. It implements the USB HCDC Interface.

USB Host Human Interface Device Class Driver (r_usb_hhid)

This module provides a USB Host Human Interface Device Class
Driver (HHID). It implements the USB HHID Interface.

USB Host Mass Storage Class Driver (r_usb_hmsc)

This module provides a USB Host Mass Storage Class (HMSC) driver.
It implements the USB HMSC Interface.

USB Host Vendor Class (r_usb_hvnd)

USB Peripheral Communications Device Class (r_usb_pcdc)

This module provides a USB Peripheral Communications Device Class
Driver (PCDC). It implements the USB PCDC Interface.

USB Peripheral Human Interface Device Class (r_usb_phid)

This module is USB Peripheral Human Interface Device Class Driver
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(PHID). It implements the USB PHID Interface.

USB Peripheral Mass Storage Class (r_usb_pmsc)

This module provides a USB Peripheral Mass Storage Class (PMSC)
driver. It implements the USB PMSC Interface.

USB Peripheral Vendor Class (r_usb_pvnd)

Watchdog Timer (r_wdt)

Driver for the WDT peripheral on RA MCUs. This module implements
the WDT Interface.

ADPCM Decoder (rm_adpcm_decoder)

Middleware to implement the ADPCM Audio Decoder. This module
implements the ADPCM Decoder Interface.

Audio Playback with PWM (rm_audio_playback pwm)

Driver for the Audio Playback middleware on RA MCUs. This module
implements the AUDIO PLAYBACK Interface.

AWS PKCS11 PAL (rm_aws_pkcs1ll pal)
PKCS#11 PAL layer implementation for use by FreeRTOS TLS.

AWS PKCS11 PAL LITTLEFS (rm_aws pkcsll pal littlefs)

PKCS#11 PAL LittleFS layer implementation for use by FreeRTOS
TLS.

Bluetooth Low Energy Abstraction (rm_ble abs)

Middleware for the Bluetooth peripheral on RA MCUs. This module
implements the BLE ABS Interface.

SD/MMC Block Media Implementation (rm_block_media_sdmmc)

Middleware to implement the block media interface on SD cards.
This module implements the Block Media Interface.

SPI Block Media Implementation (rm_block_media_spi)

Middleware to implement the block media interface on SPI flash
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memory. This module implements the Block Media Interface.

USB HMSC Block Media Implementation (rm_block_media_usb)

Middleware to implement the block media interface on USB mass
storage devices. This module implements the Block Media Interface.

User Block Media Implementation (rm_block_media_user)

Middleware that implements a block media interface on the media of
your cho